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Overview
Introduction
RingCentral is a cloud communications system that delivers uniﬁed team messaging, collaboration, and
video meetings, coupled with uniﬁed voice, fax, and text for businesses of all sizes.
This guide will help system administrators set up and access the following RingCentral features.

Accessing your account
To log in to your online account, follow these steps:
1.

Navigate to RingCentral Admin Portal.

2.

Enter your email or RingCentral phone number.

3.

Click Next.

4.

If you entered your phone number, select your country
from the dropdown menu and enter your extension
number (optional) and password.

5.

If you entered your email, enter your password.

6.

Click Sign in.

Uniﬁed Login
If you have both RingCentral and RingCentral app credentials which use the same email address, you will use
RingCentral credentials for logging in to all endpoints.
Email or Google as user ID
You may optionally conﬁgure users to log in with a unique corporate email address or Google (Gmail or G
Suite) account.
The Google login feature provides users native support for logging in using a Google email address and
password. This feature requires a unique Google email address (Gmail or G Suite email). The admin
conﬁgures a Google email address when assigning an extension, and veriﬁes the uniqueness of the email
address. By default, users can log in with their Google email address or other RingCentral credentials.
This feature applies to accessing your RingCentral online account through endpoints such as RingCentral
app, integration plug-ins for Chrome, and the Multiple Account Access portal. You can conﬁgure Google
Email addresses during the Express Setup of your RingCentral account.
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If not already conﬁgured, set a Google email address using the following steps:
1.

Navigate to RingCentral Admin Portal.

2.

Log in using your RingCentral credentials.

3.

Select Users > User List > Users with Extensions.

4.

Select a user from the list.

5.

On User Details > General tab, enter the Google email in the Email ﬁeld.

6.

Click Verify email uniqueness. Resolve duplicates.

7.

Click Save.

To log in using Google, follow these steps:
1.

Navigate to RingCentral Admin Portal.

2.

Click Google.

3.

If you have logged in before using your Google credentials, select your Google account from the
login page to log in automatically.
OR
If this is your ﬁrst time logging in, click Use another account on the Sign in with Google window.

4.

Enter your Google email address or phone number.

5.

Click Next.

6.

Enter your password.

7.

Click Next to navigate to a page requesting access to your Google account.

8.

Click Allow to ﬁnish logging in to your online account.
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Single sign-on
Single Sign-on allows employees in a company to access multiple applications with one set of credentials.
You can work with RingCentral Customer Support to set up Single Sign-on for your RingCentral services, or
you can set it up by yourself.
On Windows-based systems, Single-Sign-on supports the optional use of your company’s Kerberos network
authentication service to authenticate clients.
RingCentral also integrates with Google SSO, which allows G Suite customers to use the Google SSO service
(offered as part of G Suite IDaaS) to sign in to RingCentral. Google lists RingCentral as an approved SSO app
in their SAML apps catalog. As described here, you can conﬁgure RingCentral for SSO in the G Suite Admin
Console and conﬁgure the RingCentral SSO.
To log in using single sign-on, follow these steps:
1.

Click the More tab from the Admin Portal.

2.

On the left-hand side, click Security and Compliance.
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3.

Click Single Sign-on.

4.

Choose an option to set up SSO:
a.

Set up SSO by yourself: Use the self-service UI to conﬁgure the Service Provider (SP)
settings. Perform the steps in Set up Single Sign-On by Yourself.

b.

Contact Customer Support: Use RingCentral Customer Support to conﬁgure the Service
Provider (SP) settings. Click the View Detail link, and perform the steps in Contact Support
to Enable SSO.

Note: Available for RingCentral Premium and Ultimate users only.

Account Validation
Account Validation is a security feature that helps protect against fraudulent activity on your account, by
prompting for a security validation code when you log in from a new or unrecognized computer.
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Admin homepage
When you log in as an administrator, you can access the Admin Portal for admin-only tools and conﬁguration
of account-wide phone system settings. You can access your individual account overview and settings from
the My Extension page. At the top of the screen, hover over Admin Portal and click My Extension to switch to
your individual user homepage.

Admin Portal
From the Admin Portal, admins can see admin-only tools:
●

The Home tab contains shortcuts for commonly used functions. You can also access several tutorial
videos from this page. Additionally, you can click on a link to access the App Gallery and Developer
Portal, with quick links to integrate Google, Ofﬁce 365, and Salesforce.

●

The Users tab allows you to view and manage users, and edit user permissions.

●

The Phone System tab houses all of the main settings for the entire phone system. Here, you have
Company Info, Phone Numbers, Auto-Receptionist, Groups, Phones & Devices, and Emergency Calling.

●

The Meetings tab is where you can see information and conﬁgure settings related to your meetings.
Here, you have Recording Management, Rooms, Webinar Settings, Meetings Settings, H.323/SIP Room
Connector, Downloads, and Video Service.

●

The Reports tab contains the Call Log, Meetings Reports, and Analytics.

●

The Billing tab displays information about your account, including Service Plan, Licenses & Inventory,
Usage, Calling Rates, Purchase, Meetings, and Device Orders.

●

The More tab has more setup options, including Service Console, Account Settings, Security and
Compliance, and Apps and Resources.

●

In addition, you can see shortcuts to edit settings for Company, Users, Phone Numbers, Phones &
Devices, Groups, and Billing.
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My Extension
When you switch to the My Extension page, you can see the standard user settings view of Overview,
Messages, Call Log, Contacts, Settings, and More. Click on Settings to access your individual settings. The My
Extension tab houses the same settings as a regular user has.
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Enterprise Portal
Federated accounts management is done with Enterprise Portal, which allows administrators to provision,
manage, and search across multiple Ringcentral accounts conﬁgured with Federation. This feature makes
administration easier for very large accounts and companies with multiple accounts by consolidating
management into a single view.

Enabling Enterprise Portal
The Enterprise Portal is not enabled by default in an existing federation. One of the users in federation has
to become the ﬁrst Enterprise Super Admin, so that this user can go to the Enterprise Portal and share
access to other Enterprise admins.
To enable the Enterprise Portal and assign the ﬁrst admin:
1.

From the Admin Portal, click the Accounts tab at the top left.

2.

Click the Enable button next to Enterprise Portal.

3.

Browse or search, then select the user.

4.

Click Save.

Accessing Enterprise Portal
The Enterprise Portal is accessible via RingCentral Admin Portal. If you have access to Enterprise Portal, it
will be the default landing page after login. To access accounts quickly, click Enterprise Portal at the top
right and click the name of the account.

Searching for accounts
The Federation name is at the top left of the page. To search for an account:
1.

Select of the following categories:
●

Users

●

Numbers

●

Groups

●

IVRs

●

Sites

2.

Type in the name, phone number, extension number, email, etc., in the search ﬁeld.

3.

Click the search icon.

The search results appear at the bottom of the page and you can further reﬁne your search by choosing an
option from the dropdown menus.
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Adding admins to federated accounts
1.

Click the Admins tab at the top left.

2.

Click the + Add button. The Add Admin window appears.

3.

Browse or search, then select the user(s) you’d like to add as admin(s). Click Next.

4.

Under Copy Access From, select a user to copy their existing admin access.
OR
Select an option under Enterprise Portal Role to assign this role to the new admin/s.

5.

Assign the account you’d like them to have access to.

6.

Click Add

Managing Enterprise admins
You can modify an admin’s access to the Enterprise Portal or remove their access to it.

.

1.

Click the Admins tab at the top left.

2.

Click the three-dot More icon under Actions.

3.

Select Edit access or Remove.

RingCentral MVP | Admin Guide | Getting Started
20

Product help
The user interface provides in-product help about the most frequently used features to help you gain quick
understanding of the features. Help includes:
●

Tooltip: Icons that display in-product help text to help you successfully conﬁgure the feature.

●

Learn More: Links that navigate to relevant Knowledge Base articles on the RingCentral support
portal for more detailed feature information.
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Audio conference
RingCentral customers can set up, host, and join conference calls anytime, anywhere. Click the circles
Conference icon in the upper right-hand side of your online account to get started.
Each customer receives a conference bridge number, and each user on the phone system gets his or her own
host and participant access code so that you and your team can hold independent conferences at any time.
You can also add an international dial-in number to the invitation. Click the Select button, and then check
the countries to be included from the list.
Each conference call can include up to 1000 attendees, enabling you to hold large meetings and broadcasts.

Launching the conferencing app
To launch the conferencing app, click the circles Conference icon to view and set the following:
1.

Click the circles Conference icon within the App launcher.

2.

A window will appear with conference numbers and settings.
a.

View the Dial-in number

b.

View Host and Participant codes

c.

If you have international participants, click on Select under International Dial-In Numbers.
Select international dial-in numbers. Click Done

d.

Check the box next to Enable join before host to allow participants to start a conference
call without a host.

e.

Click View under Conference Commands to view the touch-tone dialpad keys you can use
during your conference call.

f.

Click Invite with Email to open an email with pre-populated conference details. Enter
participant details and send.
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Conference commands
For the Conferencing feature, the host and participants have the same conference bridge number to dial in
to, but their call control depends on the access codes that they will use.
●

The Host has full call control and can access the conference commands shown.

●

Participants have limited control of the conference commands.

The commands are displayed with the conferencing dial-in information.
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RingOut
RingOut enables one-touch calling from any phone or internet-enabled computer, allowing you to make calls
using your business caller ID from any location, such as a hotel room. The RingOut icon is located in the App
launcher in the upper right of every online account page.
1.

Click the App launcher next to your proﬁle icon in the upper right-hand side and select RingOut.

2.

The RingOut dialer window will appear.

3.

In the From ﬁeld, enter the phone number of your current location (for example, your mobile
number).

4.

In the To ﬁeld, enter the number you want to call. Click the Clock button to choose from among
your recent calls, or the Add button to choose from your contact list.

5.

Once you have entered From and To numbers, the Call button will turn green.

6.

Check the box next to Prompt me to press 1 before connecting the call if you’d like the system to
conﬁrm that you’d like to make the call before you are connected. When the system calls you, you
will hear "Hello. To connect this call, press one." This message protects you in case you mistyped your
own number, or if your voicemail picks up too quickly.

7.

Click the Call icon. The system ﬁrst calls you. When you answer (and press 1 as instructed if you’ve
selected this option), it then calls the other number and connects you.
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FaxOut
To quickly send a fax from your online account, click the FaxOut icon located in the upper right corner. Fill in
the form with the recipient's fax number and cover page information, and attach a document.
FaxOut recognizes a wide variety of standard document types, including word processing and spreadsheet
and PDF documents. Send ﬁles from Dropbox, Box, or Google Drive with just a few clicks.
1.
2.
3.
4.

Click the App launcher next to your proﬁle icon in the upper right-hand side and select the FaxOut
icon.
Enter up to 50 recipients.
a. Search and choose Contacts or Groups.
b. Click Insert.
Select your cover page and add a message.
Attach ﬁles from Dropbox, Box, Google Drive, or your computer and authorize RingCentral to
access your ﬁles (you have to do this only once).
a. Click Send Now.
OR
b. To enable scheduling, select Enable and select a time for Send on.
c. Click Schedule.
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Managing email-to-fax compliance
Customers who do not have the proper security parameters for their email service create the following
risk/concerns:
●
●
●

Email can easily be spoofed, allowing a malicious actor to impersonate customers and send faxes
from customers email-to-fax
E2F are pay per usage and result in large bills or sending to numbers that charge us
Risk of potential ﬁnes from regulatory bodies

Company-level administrators can enable security measures to protect admins and users from using
non-compliant email addresses.
1.

Go to More > Account Settings > General Settings.

2.

Toggle the switch on or off next to Allow this account to send faxes using Email-to-fax.

3.

Tick the box that conﬁrms your email domain meets required security settings.

4.

Click Turn on.

When an administrator or user attempts to add an email address under Faxes Sent via Email, they will see a
legal disclaimer.
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Setting up the Forward all calls feature
The Forward all calls feature allows you to easily forward all your incoming calls when you’re unable to
answer. You can forward incoming calls to a voicemail, coworker, external number, call queue,
announcement, IVR menu, or other locations. You can also schedule the time period when the incoming calls
should be forwarded.
1.

Go to the Admin Portal and sign in.

2.

Click your proﬁle at the top right.

3.

Turn on the toggle for Forward all calls.
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4.

Click the button next to one of the options under Where would you like to forward your calls?. Click
Show more options to see the complete list.

5.

Check the box for Specify start and end dates to set start and/or end dates or times (optional). This
feature is useful for forwarding calls around your break or vacation schedule.

6.

Click Save.

A banner will appear at the top of the RingCentral Admin Portal page to remind you when your calls are
forwarded. You can click Edit in the banner to modify your call forwarding settings or click Turn off to stop
forwarding your calls.

Where to forward your calls
●

Voicemail: Forward calls to your voicemail box. You can play and customize your voicemail greeting.

●

Coworker: Forward calls to a coworker. Type the coworker’s name or extension number in the
search box, then click on the desired coworker.

●

External number: Forward calls to an external number, such as an answering service.

●

Announcement: Play an announcement. You can play and customize the greeting.

●

Call queue: Forward calls to a call queue. Type the call queue name or extension number in the
search box, then click on the desired call queue.

●

Delegated line: Forward calls to a delegated line. Type the delegated line name or extension number
in the search box, then click on the desired delegated line.

●

Shared line: Forward calls to a shared line. Type the shared line name or extension number in the
search box, then click on the desired shared line.

●

Limited extension: Forward calls to a limited extension. Type the limited extension name or
extension number in the search box, then click on the desired limited extension.

●

IVR menu: Forward calls to an IVR menu. Type the IVR menu name or extension number in the
search box, then click on the IVR menu line.
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Note:
●

To use the Forward all calls features, the User Settings - Call handling permission is required. If the
user doesn’t have this required permission, the Forward all calls feature won’t be available to them.
For more information, go to List of User Permissions.

●

When Forward all calls and Do Not Disturb (DND) are both turned on, calls will be forwarded
according to your Forward all calls settings.
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Home tab
The Home tab contains shortcuts for quick access to commonly used functions. Here, you will ﬁnd links to
the following:
●
●
●
●
●
●

Company
Users
Phone Numbers
Phones & Devices
Groups
Billing

Click Support at the top right to access the RingCentral support site.
In the Tutorials section of the Home page, you can watch short helpful videos if you need help setting up
your phone system.
The Apps section on the upper right-hand side contains a link to the App Gallery, where you can view the
available apps you can integrate with your RingCentral phone system.
In the Resources section on the lower right-hand side, you can ﬁnd external links to the following sites
relevant to your RingCentral account:
●
●
●
●
●
●

Community
Blog
Open a Web Case
RingCentral University
Service Status
What’s New
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Managing users
This section describes user setting actions that can be performed by administrators such as viewing
extensions, adding users, and editing user information. Let's take a closer look at these admin functions

Viewing users with extensions
1.

From the Admin Portal, click the Users tab.

2.

Click Users with Extensions under User List.

3.

Select a user.

4.

View or edit the settings for the selected user.
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Customizing columns in Users with Extensions list
1.

From the Admin Portal, click the Users tab.

2.

On the Users with Extensions page, click the three-dot More menu at the far right, then click
Customize Columns.

3.

Check or uncheck the boxes for columns that you want to show or hide.

4.

Click Save.

The following columns are available:
●

Status: User status. This column is always shown by default.

●

Name: User name. This column is always shown by default.

●

Number: User phone numbers.

●

Ext.: User extension.

●

Roles: User role with role scope.

●

Department: Department where User belongs to.

●

Email: User email.

●

Msg.: Number of User messages.

You can use the search function to easily ﬁnd users. You can search by using ﬁrst and/or last name, phone
number, extension, or email address. Click the ﬁlter icon to ﬁnd users via their Status, Roles, or Department.
Note: If the Email column is hidden, you can still perform a search using your email address, or a partial A
email string. For example, if the email is user@ringcentral.com, you can search using user, user@, user@ring,
etc. However, searching for the email domain will not yield any results as you can’t perform a search based
on keywords belonging to the email address.

Viewing unassigned extensions
View unassigned extensions, assign an extension to a user, or delete an unused extension.
1.

From the Admin Portal, select the Users tab.

2.

Under User List, click Unassigned Extensions.

3.

To assign the extension:
a.

Select an extension.

b.

Select a Setup Option, which includes Send invite, Activate by assigning credentials, and
Activate later. Enter information about the user that the extension will be assigned to.

c.
4.

Click Save or Save and Enable to add the user to your phone system.

To delete an unassigned extension:
a.

Under Actions, click the three dot More icon at the far right of the extension.

b.

Click Delete to delete the extension.
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The user interface shown is for accounts with two or more users. Accounts with one user will see a different
interface.
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Adding users with devices
1.

From the Admin Portal, navigate to Users > User List > Users with Extensions.

2.

Click Add User. The Add Users window appears.

3.

Select a Location from the dropdown list in Ofﬁce User type, then click Select. By default, location is
based on the home country of the account.

4.

Fill in the basic information about the user. Require unique email IDs is checked by default. You can
uncheck it if you don’t want this option. Note that if this is unchecked, users cannot be invited by
email.

5.

If you’d like to add more users, enter the number on the ﬁeld provided, then click Add. You can add
up to 24 more users (25 users at a time). You may also click the duplicate icon at the far right to
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create a new row to add a user and retain the selection details, except for ﬁrst name, last name, and
email.
6.

Make a selection under Phone. Options include RingCentral app, Inventory phone, Purchase phone, and
Bring your own device. RingCentral app is selected automatically.
Note: For older RingCentral accounts, you will have the RingCentral Phone as your softphone
device type instead of RingCentral App.

7.

If you selected Inventory phone, choose the desk phone that you’d like to assign to the user. If you
selected Purchase phone, choose the device you’d like to purchase. Use the search bar or set ﬁlters to
narrow down devices based on your speciﬁc requirements.

8.

Click Select under Number. Select a number from the Number Inventory tab, which has the
numbers reserved for your account. Click Numbers to assign a new number. Select the State, Area
Code, and a number. Click Done. If you're an admin with purchasing permissions, you can add new
users and see the charges. If you don't have purchasing permissions, you'll be blocked and will need
to contact your billing admin for adding more licenses.

9.

Select, edit, or add shipping address if you’ve selected Purchase Phone under Phone. You can ship
purchased devices to a single or multiple addresses.

10. Click Next.
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Setting up users
After the ﬁnal step in Adding users with devices, you will see the following Setup options to onboard the
User:
●

Send invite: Set up a user by sending a welcome email with an activation link.

●

Activate by assigning credentials: Set up and activate a user by assigning credentials. No
welcome email will be sent.

●

Activate later: Set up a user now but activate at a later time. No welcome email or
notiﬁcations will be sent.

Sending invite to a user
1.

Select Send Invite under Setup options.

2.

Click on Edit Role under Assigned Role if you want to change the permissions of the user. By
default, a user is set to have Standard User (International).

3.

Click Next. The Add Users - Conﬁrm window appears.

4.

Review the charges and check the acknowledgment box at the bottom.

5.

Click Next.

Activating by assigning credentials to a user
1.

Select Activate by assigning credentials under Setup Option.

2.

Fill in the info under Credential.
a.

Password

b.

Reenter Password

c.

PIN

d.

Reenter PIN

e.

Security Question

f.

Answer

Note that these are all required ﬁelds.
3.

Check the box for Temporary Password to prompt users to reset the password when they sign in for
the ﬁrst time (optional).

4.

Under Emergency Address, click Add beside the name of users with devices.

5.

Fill in the info for the emergency address.

6.

Read and understand the important notes about emergency calling service, check the box to
acknowledge, then click I Accept.

7.

Click on Edit Role under Assigned Role if you want to change the permissions of the user. By
default, a user is set to have Standard User (International).

8.

Click Next. If you click Next without doing Steps 4-6, there will be a prompt for Missing Emergency
Address. You may click Back to Add Emergency Address or Yes to continue without an emergency
address. If you don’t add an emergency address at this point, user(s) will be required to add their
emergency address when they log in to their RingCentral online account or RingCentral app.
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9.

Review the charges and check the acknowledgment box at the bottom.

10. Click Next.

Activating user at a later time
1.

Select Activate later under Setup Option.

2.

Click on Edit Role under Assigned Role if you want to change the permissions of the user. By
default, a user is set to have Standard User (International).

3.

Click Next. The Add Users - Conﬁrm window appears.

4.

Review the charges and check the acknowledgement box at the bottom.

5.

Click Next.

Adding free users (without a device and a number)
1.

From the Admin Portal, navigate to Users > User List > Users with Extensions.

2.

Click Add User. The Add Users window appears.

3.

Click Select in Mobile User type.
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4.

Fill in the basic information about the user. Require unique email IDs is checked by default. You can
uncheck it if you don’t want this option. Note that if this is unchecked, users cannot be invited by
email.

5.

If you’d like to add more users, enter the number on the ﬁeld provided, then click Add. You can add
up to 24 more users (25 users at a time). You may also click the duplicate icon at the far right to
create a new row to add a user. Click Next.

Setting up free users
After the ﬁnal step in Adding users without devices, you will see the following setup options to onboard the
User:
●

Send invite: Set up a user by sending a welcome email with an activation link.

●

Activate by assigning credentials: Set up and activate a user by assigning credentials. No welcome
email will be sent.

●

Activate later: Set up a user now but activate at a later time. No welcome email or notiﬁcations will
be sent.

Sending invite to a user
1.

Select Send Invite under Setup Option.

2.

Click on Edit Role under Assigned Role if you want to change the permissions of the user. By
default, a user is set to have Standard User (International).

3.

Click Submit.
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Activating by assigning credentials to a user
1.

Select Activate by assigning credentials under Setup Option.

2.

Fill in the info under Credential.
●

Password

●

Reenter Password

●

PIN

●

Reenter PIN

●

Security Question

●

Answer

Note that these are all required ﬁelds.
3.

Check the box for Temporary Password to prompt users to reset the password when they sign in for
the ﬁrst time (optional).

4.

Click on Edit Role under Assigned Role if you want to change the permissions of the user. By
default, a user is set to have Standard User (International).

5.

Click Submit.

Activating user at a later time
1.

Select Activate later under Setup Option.

2.

Click on Edit Role under Assigned Role if you want to change the permissions of the user. By
default, a user is set to have Standard User (International).

3.

Click Submit.
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Deleting users and reassigning phone numbers
When deleting a user or extension assigned with a phone number, you specify whether to return the
number to your number inventory or reassign the number. When reassigning a number you can choose to
reassign to an extension, or to auto-receptionist , audio conferencing, or RingCentral Meetings. Reassigning
a number may require a license. If your account does not have a license, additional costs may apply.
1.

Click the Users tab from the Admin Portal.

2.

Choose User List > Users With Extensions.

3.

Click Delete opposite the disabled user extension. The Delete user window will appear.

4.

In Phone Numbers, select Move to number inventory or Reassign.

5.

In the Reassign number window, choose where to reassign the number.

6.

Click Delete user and reassign number. You receive a message conﬁrming the action.

When deleting multiple users, some numbers may not be reassigned to the number inventory. For example,
BYOC gateway numbers, forwarded numbers, and AU13 numbers may not be reassigned to the number
inventory and will be assigned by default to the auto-receptionist.
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Resetting and assigning a user
You can use the Reset and Assign feature to reset a former user’s settings and assign the extension to a new
user for quicker onboarding. Only disabled extensions have the option to be reset.
1.

Click the Users tab from the Admin Portal. Users with Extensions is the default selection under
User List.

2.

Click on the three-dot More icon at the far right of any entry with a red Disabled marker in the
Status column. Only disabled extensions have the option to be reset to a new user.

3.

Select Reset and Assign. The Reset and Assign window will appear.

4.

Check the boxes to the left of each entry that you want to activate for the user you are reassigning.

5.

Click Next to access the Assign New User page.

6.

Choose setup options, and enter the name and any other proﬁle details you want to change for the
new user being assigned to the extension.

7.

Click Reset and Assign.

A green notiﬁcation banner conﬁrms successful reassignment, along with a conﬁrmation email to the admin.
You can also conﬁrm results in Audit Trail.
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Copying and assigning existing user settings using an unassigned extension
1.

From the Admin Portal, navigate to Users > User List > Users with Extensions.

2.

Select the user you want to copy and click the More button under the Actions column at the far
right.

3.

Select Copy and Assign.

4.

On the Copy and Assign window, choose Use unassigned extension. Click Next.

5.

Select one of the following tabs:
○

Users with Devices: Select this option if you want to assign a device or a DigitalLine to the
new user. Select the device, then click Next.

○

Users without Devices: Select this option if you don’t want to assign a device or a
DigitalLine to the new user. Select the extension, then click Next.
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6.

Select the settings you want to be copied. Any settings not selected will be set to default. Click Next.

7.

Choose a Setup Option. Options include Send invite, Activate by assigning credentials, and Activate
later.

8.

Click Copy and Assign.
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Exporting a user list
Exporting a User List
You can export a list of users and extensions in Microsoft Excel ﬁle format. You can use this feature to create
a company directory or to perform an audit of users.
1.

Click the Users tab from the Admin Portal.

2.

Click Download User List to download a list of users and extensions for audit.

3.

View the ﬁle in Microsoft Excel.
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Bulk adding and editing users
1.

Go to the Admin Portal and sign in.

2.

Go to Users > User List > Users with Extensions.

3.

Click Add Users in Bulk.

4.

Click Download template.

5.

Choose the values you want to include in the template and select the ﬁle format.

6.

Enter your email to receive the template, and then click Download.
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7.

Fill out the template with your users’ information. Learn more.

8.

After entering the required template information, click Browse to upload the template ﬁle. It may
take up to an hour to process the ﬁle.

9.

Select Do your users have unique emails? if you require users to have unique email addresses. This
option may be available only when you want to activate users at a later time or by assigning
credentials.

10. Select the Setup Option. You can select the following options:
a.

Send invite: Set up a user by sending a welcome email with an activation link.

b.

Activate by assigning credentials: Set up and activate a user by assigning credentials. No
welcome email will be sent.

c.

Activate later: Set up a user now but activate at a later time. No welcome email or
notiﬁcations will be sent.

11. An email will be sent to the Super Admin, and the results will be announced in a few minutes. Enter
the email addresses in the ﬁeld that you want the upload result email to be sent.
12. Click Save.
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Note: Import will fail if a Contact Name on your list has the following symbols: <, >, /, ". Before importing,
avoid using these four symbols in the First Name and Surname ﬁelds from the CSV ﬁle. The upload will not
be successful when one of these symbols is used. An email notiﬁcation will be sent to the added email
address(es) without the .xls ﬁle, which will indicate the reason(s) why it failed.

Bulk enabling unassigned extensions
1.

Go to the Admin Portal and sign in.

2.

Go to Users > Unassigned Extensions.

3.

Click Bulk Enable Extensions.

4.

Click Download template.

5.

Choose the values you want to include in the template and select the ﬁle format.

6.

Enter your email to receive the template, and then click Download.
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7.

Fill out the template. Learn more

8.

After entering the required template information, click Browse to upload the template ﬁle. It may
take up to an hour to process the ﬁle. Any updates made to license assignments during this time may
not be reﬂected in the ﬁle.

9.

Select Do your users have unique emails? if you require users to have unique email addresses. This
option may be available only when you want to activate users at a later time or by assigning
credentials.

10. Select the Setup Option. You can select the following options:
a.

Send invite: Set up a user by sending a welcome email with an activation link.

b.

Activate by assigning credentials: Set up and activate a user by assigning credentials. No
welcome email will be sent.

c.

Activate later: Set up a user now but activate at a later time. No welcome email or
notiﬁcations will be sent.

11. An email will be sent to the Super Admin, and the results will be announced in a few minutes. Enter
the email addresses in the ﬁeld that you want the upload result email to be sent.
12. Click Save.
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Note: Import will fail if a Contact Name on your list has the following symbols: <, >, /, ". Before importing,
avoid using these four symbols in the First Name and Surname ﬁelds from the CSV ﬁle. The upload will not
be successful when one of these symbols is used. An email notiﬁcation will be sent to the added email
address(es) without the .xls ﬁle, which will indicate the reason(s) why it failed.

Activating by assigning credentials to a user
1.

Select Activate by assigning credentials under Setup Option.

2.

Fill in the info under Credential:
○

Password

○

Reenter Password

○

PIN

○

Reenter PIN

○

Security Question

○

Answer

Note that these are all required ﬁelds.
3.

Check the box for Temporary Password to prompt users to reset the password when they sign in for
the ﬁrst time (optional).
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Converting a virtual extension to a digital line
To convert a virtual extension to a digital line:
1.

Click the Users tab from the Admin Portal.

2.

Select a user to convert with a direct inward dialing (DID) number but without a digital line.

3.

Click Phones & Numbers.

4.

Click Phones.

5.

Click Add Phone.

6.

In the Add User Phones window:
a.

Select Domestic or International as the location.

b.

Select a phone for the user on the Select Devices screen (this phone may be either a
softphone or a physical phone).

c.

Click Existing Number on the Select Number screen. Select the DID (number) from the
user you are trying to convert.

d.

Select your emergency address on the Add Emergency Address screen.

e.

Complete the wizard.

Note: On the checkout screen, you will see a charge for the digital line and a credit for the DID. You will not
see a credit for virtual extensions that are Active User Extensions, as those are post-billed.
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Managing User Settings
Admins can edit the following user settings:
● User Details
● Phones & Numbers
● Screening, Greeting & Hold Music
● Call Handling & Forwarding
● Messages
● Outbound Caller ID
● Outbound Fax Settings
● Notiﬁcations
Administrators access and edit settings through the Users panel.
1.
2.
3.

From the Admin Portal, select the Users tab
Click the name of the user
On the user settings pane
○ Select a category to edit (for example, Outbound Calls/Faxes)

Under Outbound Calls/Faxes, click the category to edit (Caller ID or Fax Settings)
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User details
Click on User Details to view and edit the selected user’s information. From this menu, you can edit the role
assigned to a user, as well as a user’s extension, name, recording, phone numbers, email address, job title,
department, hours, password, and regional settings. You can also manage the single sign-on policy for your
users here.

Managing single sign-on policy
Admins can manage the single sign-on (SSO) policy at the user level. When SSO is enabled on the account, it
controls the SSO login for all users on the account.
When Enforce SSO is enabled on the account, a user-level setting will be available to provide exceptions for
users that admins would want to allow to use their RingCentral credentials for authentication. The user
extension setting for SSO option is turned on by default when Enforce SSO is enabled on the account level.
Admins can also enforce SSO at a later time for these users that have already set their RingCentral
credentials during onboarding.
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Before you can change the SSO policy at the user extension level, ensure ﬁrst that you have conﬁgured the
SSO settings and have enabled the SSO service on your account. For more information, navigate to Single
sign-on.
To manage SSO policy at the user extension level:
1.

Click the Users tab from the Admin Portal.

2.

Click User List.

3.

Search the name of the user or browser through the list of Users with Extensions. You can also use
the ﬁlter and search by Status, Roles, Department, and Sites. Click the name of the user.

4.

Click User Details.

5.

Click Settings & Permissions.

6.

Check the box next to Enforce SSO under Single Sign-on.

Admins can also manage the SSO policy via templates. To learn more, navigate to Managing templates.
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Hiding users from your Company Directory
Company Directory Control enables admins to take control of the company contacts shown on employees'
clients. Through this feature, you can hide speciﬁc contacts in your company directory from being seen in
the RingCentral app.
Note: Other users can still contact hidden users by directly dialing the number or by entering the email
when creating a new message.
For more information about checking your company contacts, visit Managing your company contacts in the
RingCentral app desktop and web.
1.

From the Quick Access home page, click Manage Users under the Users column. Alternatively, you
can navigate to Users > User List > Users with Extensions.

2.

Select the user you want to manage.

3.

Click User Details.

4.

Tick or untick the checkbox for Include User in Company Directory.

Once a user is hidden, they cannot be directly contacted through phone, message, or video via the
RingCentral app. However, other users can still call a hidden user by directly dialing the number or
messaging them by directly typing their email when creating a new message.

Unpublishing user’s non-extension numbers
Once the direct number, contact phone, or mobile phone number of a user is unpublished, the hidden
number will not be shown in the user’s proﬁle in the RingCentral app. The hidden number cannot be
searched and contacted through phone.
However, other users can still call the hidden number by directly dialing the exact phone number.
1.

From the Quick Access home page, click Manage Users under the Users column. Alternatively, you
can navigate to Users > User List > Users with Extensions.

2.

Select the user you want to manage.

3.

Click Phones and Devices.

4.

Click Unpublish on the non-extension number/s you want to hide.
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5.

Alternatively, you can unpublish contact and mobile phones via User Details > General.

6.

Untick the checkbox for Publish in Company Directory below the number/s you want to hide.
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Phones & Numbers
Click Phones & Numbers to view and edit the selected user’s phone numbers and phone settings. You can
add a direct number for this user, add a phone, download/activate apps, change presence and intercom
settings, and view and edit conference settings.
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Primary Number
Admins and users can set a direct number as a user’s primary number displayed across different endpoints,
namely Admin Portal, RingCentral desktop app, and RingCentral mobile app.
An admin with user management permissions would be able to set this on behalf of other users. A user
would be able to set this on their proﬁle.
To set a user’s primary number:
1.

Click the Users tab from the Admin Portal.

2.

Click the name of the user whose primary number you want to set to under Users with Extensions.

3.

Click Phones & Numbers.

4.

Click Edit under Primary Number.

5.

Select the number you want to set as a primary number.

6.

Click Apply.
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Screening, Greeting & Hold Music
Click Screening, Greeting & Hold Music to view and edit the selected user’s greeting, call screening options,
connecting message, audio while connecting, hold music, and blocked call settings.
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Call Handling and Voicemail
Click Call Handling and Voicemail to view and edit the selected user’s call handling, call forwarding, ring
group, additional phones, ring pattern, incoming call, and call ﬂip settings.
You can enable and disable call forward options on some equipment, such as Polycom® VVX® phones. The
ability to enable call forwarding on the phone hardware must be enabled in your account. Some limitations
apply:
● If the call forward is conﬁgured on the phone hardware, the forwarding will not be indicated in the
RingCentral system.
● The Call Forward selection on the phone setup between multiple devices is restricted to run only
three times.
● If a user receives an E911 callback, and Call Forward is enabled on the user’s phone, the conﬁgured
destination will receive the E911 call.

Learn more about call handling.
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Setting a voicemail greeting
Admins can set up the voicemail greeting feature on behalf of another user.
1.

Go to the Admin Portal and sign in.

2.

Go to Users > Users with Extensions.

3.

Click on the user's name. (Don’t check the box next to the user’s name).

4.

Select Call Forwarding and Voicemail.

5.

Under Work Hours, scroll down to Missed Calls and select Send to voicemail from the dropdown.

6.

Click Play to listen to your current greeting.

7.

Click Edit if you want to record a custom greeting. Learn how

8.

If you want to remove your custom greeting and use the default greeting, click Edit, then select
Default.

9.

By default, voicemails are saved in the user’s voicemail box. To save their voicemails in a different
voicemail box, select Speciﬁc Extension under Select voicemail box and choose from the list of
extensions.

10. Click Save.

Setting up the Forward all calls feature
The Forward all calls feature allows you to easily forward all your incoming calls when you’re unable to
answer. You can forward incoming calls to a voicemail, coworker, external number, call queue,
announcement, IVR menu, or other locations. You can also schedule the time period when the incoming calls
should be forwarded.
Admins can set up the Forward all calls feature on behalf of another user.
1.

Go to the Admin Portal and sign in.

2.

Go to Users > User List > Users with Extensions, then select the relevant user extension.

3.

Click Call Handling.

4.

Turn on the toggle for Forward all calls.
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5.

Select one of the options under Where would you like to forward your calls?. Click Show more
options to see the complete list.

6.

Check the box for Specify start and end dates to set a start and/or end date or time (optional). This
feature is useful for forwarding calls around a break or vacation schedule.

7.

Click Save.

Admins will see a banner at the top of the Call Handling section for the selected user when the Forward all
calls feature is turned on.
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Where to forward your calls
●

Voicemail: Forward calls to your voicemail box. You can play and customize your voicemail greeting.

●

Coworker: Forward calls to a coworker. Type the coworker’s name or extension number in the
search box, then click on the desired coworker.

●

External number: Forward calls to an external number, such as an answering service.

●

Announcement: Play an announcement. You can play and customize the greeting.

●

Call queue: Forward calls to a call queue. Type the call queue name or extension number in the
search box, then click on the desired call queue.

●

Delegated line: Forward calls to a delegated line. Type the delegated line name or extension number
in the search box, then click on the desired delegated line.

●

Shared line: Forward calls to a shared line. Type the shared line name or extension number in the
search box, then click on the desired shared line.

●

Limited extension: Forward calls to a limited extension. Type the limited extension name or
extension number in the search box, then click on the desired limited extension.

●

IVR menu: Forward calls to an IVR menu. Type the IVR menu name or extension number in the
search box, then click on the IVR menu line.

Note:
●

To use the Forward all calls features, the User Settings - Call handling permission is required. If the
user doesn’t have this required permission, the Forward all calls feature won’t be available to them.
For more information, go to List of User Permissions.

When Forward all calls and Do Not Disturb (DND) are both turned on, calls will be forwarded according to
your Forward all calls settings.
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Outbound Calls/Faxes
In the user settings pane, click the Outbound Calls/ Faxes tab to conﬁgure settings for caller ID and fax.

Outbound Caller ID
Click Caller ID to view and edit the selected user’s outbound caller ID numbers.
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Outbound Fax settings
Click Fax Settings to view and edit the selected user’s fax cover page settings and fax via email settings.
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Bulk adding or editing users
1.

Log in as an administrator to the RingCentral online account.

2.

From the Admin Portal, navigate to Users > User List > Users with Extensions.

3.

Click Bulk User Update. This will open the Assign Users window.

4.

Choose a Setup Option. Options include Send invite, Activate by assigning credentials, and Activate
later.

5.

The option for Users require unique email IDs is checked by default. If you’ve selected Send invite
under Setup Option, you are unable to uncheck this box. If you’ve selected either Activate by
assigning credentials or Activate later, you can uncheck the Users require unique email IDs if you
don’t want this option.
Note: If this is unchecked, users cannot be invited by email and you have to select another setup
option.

6.

Select a File Format. Options include Excel Workbook (.xls) and Excel Workbook (.xlsx).

7.

Enter your email address in the Send Email to ﬁeld, and click Send.

8.

Click OK on the Alert window that says the template ﬁle is sent.

9.

Check your email and download the template. Read the instructions carefully and ﬁll out the
template with your users’ information. Save the ﬁle once you’re done.

10. Click Browse under Upload File. Locate the Excel ﬁle containing your users’ info, click Open, and
then click Upload.

Setting up users
After the ﬁnal step in adding a user extension, you will see the following setup options to onboard the user.
●

Send invite: Set up a user by sending a welcome email with an activation link.

●

Activate by assigning credentials: Set up and activate a user by assigning credentials. No welcome
email will be sent.
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●

Activate later: Set up a user now, but activate at a later time. No welcome email or notiﬁcations will
be sent.

Activating by assigning credentials to a user
1.

Select Activate by assigning credentials under Setup Option.

2.

Fill in the info under Credential:
○

Password

○

Reenter Password

○

PIN

○

Reenter PIN

○

Security Question

○

Answer

Note that these are all required ﬁelds.
3.

Check the box for Temporary Password to prompt users to reset the password when they sign in for
the ﬁrst time (optional).
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Managing roles and permissions
Roles and permissions enforce your company security policy by providing ﬂexible, role-based access to your
RingCentral phone system. You can delegate access to certain areas without giving full admin access, or by
retaining control over certain areas. You can use templates and bulk upload options to efﬁciently apply roles
among users across an organization.

Predeﬁned roles
You can grant access privileges by assigning users one of the seven predeﬁned roles:
●

Super Admin: Complete system administrator-level access.

●

Phone System Admin: Phone System settings access plus full access to user-level settings.

●

Billing Admin: Full access to billing functions, user-level settings, international dialing, and some
analytics features.

●

User Admin: Full access to user administration (self and others), international dialing, and system
features/apps.

●

Manager: Provide users with all capabilities of Standard (International) along with access to key
functions such as Reports and Company Call Log.

●

Standard (International): User level access with international dialing access.

●

Standard: User level access without international dialing access.

Note: Predeﬁned roles cannot be modiﬁed.

Custom roles
You can create custom roles to meet your business needs. When creating a custom role you select an existing role as a
starting point, and select permissions to be assigned to the role. To create a custom role, click New Role.
Note: This feature is available only to RingCentral MVP Premium and Ultimate with two or more users in
the US, Canada, and UK.

Assigning users to a role
To assign users to a role: From the Admin Portal, select the Users tab.
1.

Click Roles.

2.

Select one of the roles to assign users.

3.

Click the Assigned Users tab to view the users currently assigned to the selected role.

4.

Click Assign User. A list of users and their currently assigned roles is displayed.

5.

Select the users to assign to the role.

6.

Click Assign.
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The users’ roles are assigned and displayed in the Users list assignments are displayed in the Users list.
Note: The New Role option is available for MVP Premium and Ultimate users only.
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Modifying a user’s role
You can modify a user’s role by editing the user’s page.
1.

Click the Users tab from the Admin Portal.

2.

Click the user whose role you will modify.

3.

Click User Details.

4.

Click Settings & Permissions.

5.

Click the Edit button under Roles.

6.

Select the role.

7.

Click Save.
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Creating a new role
To create a new, custom role:
1.

Click the Users tab from the Admin Portal.

2.

Click the Roles panel.

3.

Click New Role.

4.

Select a role to use as a template, or starting point, then click Next. The Create New Role window
appears.

5.

Enter the Name and Description for the new role, then click Next.

6.

Set the permissions for the new role.

7.

Click Create Role.

Note: This option is available for MVP Premium and Ultimate only.
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Setting a default role
For ease of use, you can create a custom role and then set that role as the default role assigned to all
newly-created users.
If you do not set a default role, all newly-created users are automatically set to the Standard (International)
role.
1.

Create your custom role.

2.

Click Users from the Admin Portal.

3.

Click Roles.

4.

Select the custom role you created.

5.

Click Edit.

6.

Click the checkbox Set as Default.

7.

Click Save.

Note: You can also select one of the predeﬁned roles to be the default role.
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Managing user groups
A RingCentral User Group associates users based on organization hierarchy. A group is managed by a user
group manager who accesses and modiﬁes group members' settings and views their call logs. The account
administrator controls who gets access to view or create user groups.
The account administrator creates multiple groups as required for your organization. A ﬂat, non-nested
group structure is supported. Users may belong to multiple groups. For example, for a director with two
team managers (and their team members), you might create three user groups: one group for each of the
team managers, and an overall group for the director that includes all reporting members.
When a user is assigned to be a user group manager, the user automatically inherits certain permissions.
These permissions work in conjunction with the role assigned to the user in the Roles section of user
administration. You must ensure that the primary role has the correct permissions so that user access is
controlled when the user is given user group manager access.
Note: This feature is available for RingCentral MVP Premium and Ultimate only.
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The tasks involved in managing user groups include:
●

Assigning Users to User Groups: The Templates section in user management allows the account
administrator to streamline the assignment of users to user groups. This assignment is performed in
the User Groups option in Templates.

●

Viewing and modifying User Settings: The User Settings sections, accessed from the User List in
user management, allows the user group manager to view and modify the settings assigned to a
member of their group, including the roles and user groups in the User Details section.

●

Accessing Reports for your group members: The Reports section helps admins and user group
managers optimize the phone system by presenting usage analysis and trending metrics in an
easy-to-read graphical format. When logged in as a user group manager, you can see your group
members’ data only.

Creating a user group
When you create a user group, you organize a group of users by adding members to the group and assigning
a group manager who can modify members’ settings and view their call logs. The manager must at minimum
have User Admin role and permission to access the group manager interface.
1.

Click the Users tab from the Admin Portal.

2.

Click User Groups. You will see a list of existing user groups if any.

3.

Click Create (if no user groups exist), or click New Group.

4.

Enter a Name and Description for the user group.

5.

Click Next.
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6.

Add members to the user group. Search by department or all departments, and check to select the
users.

7.

Click Next.

8.

Select a member of the user group to be the user group manager. (The manager must be a member
of the user group).

9.

Click Done.

The user group is created, and a conﬁrmation message is displayed. The user group’s name and manager are
displayed in the User Groups view.
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Editing or deleting a user group
To edit an existing user group:
1.

Click the Users tab from the Admin Portal.

2.

Click User Groups.

3.

Select an existing group from the list.

4.

On the Overview page, click Edit to change the name or description of the user group. To change
the manager of the user group, click Change, select a new manager, and click Done.

5.

Click Save to save the group’s changes.

6.

On the Members page, add or remove members from the group as needed. To add a member click
Add Member, select members to be added, and click Add.

To delete a user group, click Delete and conﬁrm the deletion. Deleting a group will result in members being
removed from the group and the group manager losing some privileges.
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Managing templates
RingCentral Templates will save you time and repetitive manual effort by streamlining your administrative
routine. There are two types of templates, one for user settings and another for specifying call handling
rules. Create a template and apply it to users as you need.

Creating a template for user settings
To create a template for user settings, follow these steps:
1.

Click the Users tab from the Admin Portal.

2.

Click Templates > User Settings.

3.

Click Add User Settings Template.

4.

Enter a New Template Name.

5.

Click Save.
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6.

Select a template from the left pane. You see options you can set for this template in the right panel,
grouped into categories of settings for Inbound and Outbound calling and Notiﬁcations. For each
group of settings, you can specify whether the settings override each users’ settings by checking
Override User Settings.

7.

Conﬁgure Template Information settings. Under New Template Name, edit the name of your
template and see the last time it was modiﬁed and when it was created.

8.

Conﬁgure User Details settings:
a. Regional Settings: Select regional settings for users such as time zone and time format.
b. User Hours: Set user hours to 24 hours or specify hours.
c.

Roles: Select the role to be applied to the users. Roles give admins the ability to control
what users can do within the system. A role is a collection of permissions that could be
based on a job function.

d. User Groups: Select the user groups where the user is to have a membership.
e. Site: Select site (applicable to multi-site accounts).
f. Conﬁrmation Message: Specify how long the conﬁrmation message will appear after a
successful operation is ﬁnished. You have the option to disable this feature.
g. Job Title: Specify the job title.
h. Single-Sign on: Enforce SSO for users on the account.
i. Video Service: Select the meetings service you want to use in your web portal, RingCentral
app, and integrations.
j. Receive Communications from RingCentral: Select if users receive voicemail messages
from RingCentral on product education.
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9.

Conﬁgure Phones settings.
a. Appearance: Select extensions to display on desk phones and softphones.
b. Permissions: Select users permitted to answer calls of the other extensions.
c.

Emergency Address: Provide a physical address for ﬁrst responders.

d. Bandwidth Settings: To improve the quality of your calls, you can set how much network
bandwidth to use for calls:
●

High Bandwidth - gives you better sound quality but calls can become choppy when
it's not available.

●

Low Bandwidth - gives you lower sound quality but ensures no interruptions during
your conversation.
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10. Conﬁgure Screen, Greeting, and Hold Music settings.
a. User Greeting: Turn on this option when you want the system to answer the call with a
recorded welcome message, so callers know they've reached the right person. This is not a
personal voicemail announcement.
b. Call Screening: Turn on this option when you want callers to announce their name before
continuing to connect the call. This option lets you identify the caller so you can pick up the
call immediately. After turning on this option, go to Call Forwarding and Voicemail >
Settings > Incoming Call Information to set your preferences.
c.

Connecting Message: Set a recorded message you want callers to hear to let them know
the call will now be transferred to your line.

d. Audio While Connecting: Incoming callers will hear the music selection that is conﬁgured
with this setting. The music selection callers will hear when they are placed on hold can be
set in the Hold music selection. Note that the Audio While Connecting setting is applied on
a rule basis, whereas the Hold Music setting is applied for all calls.
e. Hold Music: Turn on this option when you want callers to hear music whenever you put a
call on hold.
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11. Conﬁgure Call Forwarding and Voicemail settings. Under Desktop & Mobile Apps, specify whether
to notify your Desktop and apps before forwarding the incoming call to your desk phones and
forwarding numbers, and specify a wait time.
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12. Conﬁgure Messages settings.
a. Take Messages: Allow or deny users to take voicemail messages; specify a default or custom
voicemail greeting.
b. Voicemail Greeting: Specify a default voicemail greeting.
c.

Message Recipient: Select the recipient of voicemail messages.

d. This extension: Select users to be included as message recipients when applying a template.
e. Speciﬁc extension: Select an extension to be the recipient of voicemail messages.
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13. Click the Outbound tab to conﬁgure settings for outbound calls such as caller ID and fax settings.
a. Caller ID: Specify caller ID settings by phone or by feature. If you select Toll-Free number or
Blocked as your Default Caller ID for any of your endpoints/calling features, you can also
select an alternate local number to use in case we detect that your call will not go through.
b. Fax Settings: Specify fax settings including fax cover page information and settings for
faxes sent through email.
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14. Click the Notiﬁcations tab to conﬁgure the notiﬁcations settings. Select each of the following if you
want to be notiﬁed by email.
a. Voicemail Messages
b. Received Faxes
c.

Missed Calls

d. Fax Transmission Results
e. Received Text Messages
15. Click Save.
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Creating a template for Call Handling settings
1.

Click the Users tab from the Admin Portal.

2.

Click Templates.

3.

Click Call Handling.

4.

Click Add Call Handling Template.

5.

Enter a New Template Name.

6.

Click Next.

7.

Specify the caller ID or date conditions that will trigger the application of this template.

8.

Click Next.

9.

Specify the action to take when incoming calls match this rule.

10. Click Save.
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Applying a template to users
There are several ways to apply a template to users.

Applying a template via Users List
1.

Click the Users tab from the Admin Portal.

2.

Select the number of users.

3.

Click Apply Templates.

4.

Select a template to apply.

5.

Click Apply Template.

6.

Click Continue to conﬁrm that you are about to make settings changes for all the selected user(s).
This will overwrite any conﬁguration the user might have done previously.

7.

An email will be sent to you when it’s completed. You may choose to notify active users of the
change by email and also add more recipients. Click Apply Template.
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Applying a template via User Settings under Templates
1.

Go to Users > Templates > User Settings.

2.

Click the more icon opposite the Template that needs to be applied to User/s and select Apply.

3.

Select the Users who should be assigned to the selected template on the Apply Template pop-up
window.

4.

Click Apply.

5.

Click Continue on the prompt to conﬁrm that the template will be applied to the selected Users.

6.

An email will be sent when the template application is complete. You can tick on the box to notify
only active users. You can also enter additional recipients in the box. Click Apply Template when
done.

Applying a template via User Details
1.

Go to Users > User with Extensions.

2.

Select a user to whom you want to apply a template.

3.

Go to User Details > Settings & Permissions.

4.

Click Apply under Template.
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5.

Select a Template from the popup window.

6.

Click Apply Template.

Managing the Phone System
The Phone System tab houses all of the main settings for your entire phone system. Here you will ﬁnd
settings for:
●

Company Info

●

Phone Numbers

●

Auto-Receptionist

●

Multi-Level Auto-Receptionist

●

Groups

●

Phones & Devices

●

Emergency Calling

●

Automatic Location Updates
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Company Info
Your account may be a single-site account or may contain multiple sites when you have enabled RingCentral
Multi-Site Support. With a single-site account, the Company Info page displays the settings for your account,
including Company Address, Caller ID Name, and Directory Assistance. Select the appropriate tab to access
each section.

Managing Sites with Multi-Site Support
When you have enabled RingCentral Multi-Site Support, the user interface displays each of the conﬁgured
sites in your account and allows you to create a new site (by selecting New Site or Bulk Site Create) or edit
the information for any of your existing sites (by selecting the site from the list). Site ﬁlter controls are also
available from pages that contain site assets.
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Company address
Set your Company Address information for the default company name and your company address for a
Directory Listing (if available for your account).
1.

Click the Phone System tab from the Admin Portal.

2.

Click Company Info.

3.

Click Company Address.

4.

Enter your Company Name and Company Address with City, State, and Zip Code.

5.

Click Save.
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Caller ID Name
Set your Company Caller ID to your company’s name so that your customers will know who is calling them.
This name, along with the phone number, is displayed to the called party whenever an outbound call is made
using the local number as the caller ID.
1.

Click the Phone System tab from the Admin Portal.

2.

Click Company Info.

3.

Click Caller ID Name.

4.

Enter your company name exactly the way you want it to appear on Caller ID displays, for local calls
made from your main company phone number. You can enter up to 15 characters.

5.

Click Save.

Note: Outbound Caller ID cannot be set for an individual number or digital line. It is only available for local
numbers and not toll-free numbers.
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Directory Assistance
Directory Assistance is a free and convenient way to publish your business name, address, main number, and
main fax number to increase your company’s visibility in local directory assistance listings. For more
information about Directory Listing, see Directory Listing Frequently Asked Questions. To publish your
information:
1.

Click the Phone System tab from the Admin Portal.

2.

Click Company Info.

3.

Click Directory Assistance.

4.

Enter your listing information.

5.

Click Next.

6.

Check the box next to I agree to the terms of service.

7.

Click Publish.

Note: Allow ﬁve business days for your listing to appear. Edit or delete your listing any time by following
these same steps.
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Phone Numbers
The Phone Numbers tab allows you to view your numbers by category of number, and add additional
numbers to your account.
The tabs contain these types of numbers:
●

All Numbers: Includes all numbers in your account.

●

Numbers in Use: Numbers currently assigned to an extension or a device.

●

Number Inventory: Numbers that are not assigned to a user extension or device.

●

Transferred and Vanity: Existing numbers that have been transferred, and vanity numbers to help
customers remember your business phone number.
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Adding company numbers
Each RingCentral number can function as a voice and fax line for incoming calls. This means that one number
can be used for both calls and faxing to maximize the use of your service.
1.

Click the Phone System tab from the Admin Portal.

2.

Click Phone Numbers.

3.

Click All Numbers.

4.

Click Add Number.

5.

Select a Location and follow these instructions for the Number Type you choose:
●

Local Number: Provide the State and Area Code. Select one or more numbers and click Add
Numbers.

●

Toll-Free Number: Select a toll-free preﬁx. Note that there is a $30 one-time setup fee per
number if you select 800 as your toll-free preﬁx. Select one or more numbers and click Add
Numbers.

●

Vanity Number: Enter a number that helps customers remember your business phone
number. Click Search to check availability. Select a number and click Add Numbers.

6.

Click Next.

7.

Select Auto-Receptionist to assign the number as a company number.

8.

Click Next.

9.

Review any changes to your number plan. Check the acknowledgment box.

10. Click Next.

RingCentral MVP | Admin Guide | Phone System
98

Adding assigned numbers
Under Numbers in Use, you will see all of the numbers assigned to a user that has been set for your phone
system. From here, you can add a number.
1.

Click the Phone System tab from the Admin Portal.

2.

Click Phone Numbers.

3.

Click Numbers in Use.

4.

Click Add Number.

5.

Select a Location and follow these instructions for the Number Type you choose:
●

Local Number: Provide the State and Area Code. Select one or more numbers and click Add
Numbers.

●

Toll-Free Number: Select a toll-free preﬁx. Note that there is a $30 one-time setup fee per
number if you select 800 as your toll-free preﬁx. Select one or more numbers and click Add
Numbers.

●

Vanity Number: Enter a number that helps customers remember your business phone
number. Click Search to check availability. Select a number and click Add Numbers.

6.

Click Next.

7.

Select Extension to assign the number, and then select the extension you want to assign it to.

8.

Click Next.

9.

Review any changes to your number plan. Check the acknowledgment box.

10. Click Next.
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Forwarding a number
You can maintain your phone number with your current provider and forward calls automatically to your
RingCentral account.
1.

Click the Phone System tab from the Admin Portal.

2.

Click Phone Numbers.

3.

Click All Numbers.

4.

Click the more three-dot icon beside Add Number.

5.

Select Forward Number.

6.

Enter your existing phone number and click Next.

7.

Select where you would want to forward the calls to. The options are Auto-Receptionist and
Extension. If you selected Extension, select an extension.

8.

Click Next.

9.

Review the information about ordering Busy Call Handling and No Answer Call Handling from your
local telephone company, and the local telephone company charges.

10. Click Done.
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Forwarding calls to your RingCentral number
You can forward calls from a third-party number to your RingCentral number. To use your forwarded
number as your outbound caller ID, you’ll need to submit certain documents to RingCentral.
1.

Go to the Admin Portal and sign in.

2.

Click Phone System > Phone Numbers > All Numbers or Numbers in Use.

3.

Click the three-dot More icon at the right, then select Add substitute caller ID/forwarded number
(for countries that support substitute caller ID) or Forward Number (for countries that don’t
support substitute caller ID).

4.

In the Phone Number ﬁeld, enter the number you want to add as a substitute caller ID and/or
forwarded number, then click Next.
Note: Supported phone numbers include local, mobile, and toll-free numbers. An international
number may not be used as a substitute caller ID or forwarded number.
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●

Substitute caller ID: Maintain your phone number with your current provider and use it as
your RingCentral account’s outbound caller ID.
○

Note: You cannot use mobile numbers as substitute caller IDs when forwarding
mobile number calls to RingCentral. Please reach out to support to have the mobile
numbers enabled.

●

Forwarded number: Maintain your phone number with your current provider, and when it’s
busy or there’s no answer, forward calls to your RingCentral account.

5.

On the left, choose whether to forward your calls to Auto-Receptionist or Extension, then click
Next.

●

Auto-Receptionist: Can be used as an outbound caller ID for all extensions that will be
enabled when you submit the required documents.

●

Extension: Can be used as an outbound caller ID only for the selected extension when you
submit the required documents. If you select Extension, click the Select Extension button,
then select the extension to which you want to forward your calls in the Select Extension
window. Click Select when done. The extension’s call handling and forwarding rules will be
implemented.
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6.

Verify the ownership of your substitute caller ID number by contacting RingCentral support to
provide the following documents:
a.

The Outbound Caller ID Substitution Agreement for RingCentral MVP. (Download
this agreement as a PDF.) You need your RingCentral user ID to ﬁll out this form.

b.

A copy of the most recent bill that demonstrates ownership of your substitute
caller ID number(s).

7.

c.

A CSV ﬁle of the list of relevant phone numbers, listed in E.164 format.

d.

Click Next when done.

Before clicking Done in the Set up forwarding section, note that you’ll need to order Busy Call
Handling and No Answer Call Handling from your local telephone company so that RingCentral can
answer your existing home or home ofﬁce telephone line.
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Ordering Call Handling
a.

Contact your local telephone company’s customer service department and request that Busy Call
Handling and No Answer Call Handling* be installed on your telephone line.

b.

Explain that you would like Fixed call handling, not variable or basic.

c.

Your telephone company will ask you which number you want your calls forwarded to. For the
number to work with RingCentral, the telephone company must enter this forwarding number
exactly as listed, including the 1 before the area code. Ask the representative to verify the number.

d.

When ordering No Answer Call Handling, you must choose how many rings you want to hear
before your calls are forwarded to RingCentral. You may choose as many or as few as you like. We
recommend setting it to four (4) rings.

*If the customer service representative says these features are unavailable, ask to speak to a supervisor. These
features are available almost everywhere in the US.

Telephone company charges
Your local phone company may charge you an activation fee and/or an ongoing monthly fee for adding these
services. Check with your phone company for details about such charges.
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Naming phone numbers
Admins can assign phone numbers with “nicknames” for reference or organization purposes. This allows
them to efﬁciently search by their name in the Phone Numbers tab.
1.

Click the Phone System tab from the Admin Portal.

2.

Click Phone Numbers.

3.

Click Numbers in Use.

4.

Click the number that you want to assign a name to.

5.

Enter a name on the Name ﬁeld.

6.

Click Save.
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Viewing unassigned numbers
Under Number Inventory, you will see all the numbers that are not assigned to a user extension or a device.
1.

Click the Phone System tab from the Admin Portal.

2.

Click Phone Numbers.

3.

Click Number Inventory.

4.

Filter the numbers by Locations and Sites.

5.

Click a number to see more information.

You can view phone properties in the Phones & Devices tab.
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You can see unassigned numbers that have a device under All Numbers and Numbers in Use by ﬁltering
them.
1.

Click the Phone System tab from the Admin Portal.

2.

Click Phone Numbers.

3.

Click All Number or Numbers in Use.

4.

Click the ﬁlter icon beside the search bar.

5.

Click Types.

6.

Select Unassigned Extension.
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Viewing transferred and vanity numbers
Under Transferred and Vanity, you will see the numbers that you have transferred, as well as vanity
numbers.
1.

Click the Phone System tab from the Admin Portal.

2.

Click Phone Numbers.

3.

Click Transferred and Vanity. Select Transfer Orders, International Number Orders, or Pending
Vanity Numbers. Click a number to see more details.

4.

To transfer a number to RingCentral, select Transfer Numbers under Transfer Orders. Select US or
US territory Local Number, US or US territory Toll-Free Number, Canadian Number, or
International Number. Complete the process.
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Viewing number blocks
Many RingCentral customers are based in the EU, UK, and other geographical areas outside of North
America. These countries and other geographical areas have regulations and lengthy processes for
telephone number acquisition.
Companies acquire additional numbers, more than the current need, to account for their growing business.
This results in a need to store the extra numbers not currently in use, especially when they port numbers
from other phone providers over to RingCentral. These numbers can be in contiguous sequences (or number
blocks), or they can be stragglers.
With this feature, customers can store these “held numbers” on their accounts without having to pay a
reserved number fee* and easily assign them to users or lines as that need arises.
*While there isn’t a billing license fee for “held numbers” in number blocks storage (not in use), we plan to introduce a
nominal license fee in 2023. Number blocks that are in use will follow the current pricing structure.”

Viewing number blocks via ﬁlter
1. Go to the Admin Portal and sign in.
2. Go to Phone System > Phone Numbers, then select any of these tabs:
○

All Numbers

○

Numbers in Use

○

Number Inventory

3. Click the ﬁlter funnel icon.
4. Select a number block on the Number Block ﬁlter.
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Note:
●

The Number Block ﬁlter and Number Block column are only available if the account has a number
block.

●

The numbers on the Number Inventory tab are not assigned to a user extension or device. Numbers
in a number block don’t have a number license yet. A standard license fee will be charged when they
are assigned.

Viewing number blocks via Transferred tab
1.

Go to the Admin Portal and sign in.

2.

Go to Phone System > Phone Numbers > Transferred.

3.

Select the Number Blocks tab. You’ll see a list of the number blocks in your account.
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Viewing block details
1.

Go to the Admin Portal and sign in.

2.

Go to Phone System > Phone Numbers > Transferred.

3.

Select the Number Blocks tab. You’ll see a list of the number blocks in your account.

4.

Click on a Block ID to view all the numbers in this block. You can change the block Name on the
upper-right side of this page.

Setting up auto number blocks
You can hold numbers with auto block creation without having to pay reserved number fees. Numbers will
be easily and readily available for use.
●

Auto enabled for new sign-ups

●

Disabled by default for existing accounts

●

No charge until number is assigned to an extension

●

Cannot delete numbers in Admin Portal

Global ofﬁce customers with US/CAN numbers can place their US numbers in a Block via SCP, with the help
of the Porting Team.
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Auto-Receptionist
Create your own auto-receptionist for your phone system. Customize your options for effective call
management. For example, choose your company hours, set your company greeting, deﬁne rules for call
handling, and more.
Note: The auto-receptionist defaults to IVR Mode: single level. You can change the IVR mode to multi-level
for a more intricate IVR menu. Once the settings are changed to multi-level IVR mode, options are slightly
different.
When you have enabled RingCentral Multi-Site Support, the user interface displays the auto-receptionist
for each of the sites’ auto-receptionist with individual business hours, custom rules, IVR settings, and
regional settings.

RingCentral MVP | Admin Guide | Auto-Receptionist
114

RingCentral MVP | Admin Guide | Auto-Receptionist
115

Company business hours
Customize your company's business hours. You can specify the opening and closing time for each day of the
week or select 24 hours. This establishes the settings for the Business Hours and After Hours tabs in other
settings areas (such as call queue settings and user settings).
1.

Click the Phone System tab from the Admin Portal.

2.

Click Auto-Receptionist.

3.

Click General Settings.

4.

Select Company Hours.

5.

Set your Company Hours to:
a.

24 hours to have incoming calls handled the same way all the time.

b.

Custom hours lets you specify hours for each day of the week. You can also set separate
call-handling rules and greetings for Business Hours and After Hours. To copy hours from
one day to all weekdays, or to the entire week, select Copy to Weekdays or Copy to All
Days.

6.

Click Save.

Note: If you have global companies, select ﬁrst which level to which the site you're conﬁguring should belong
to by selecting from the Multi-level dropdown menu in the upper right.
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Company call handling
Company Call Handling provides call handling options for single-level IVR accounts. This controls what
callers hear when they dial your company number/s during business or after hours. You can conﬁgure
separate settings for business hours and after hours.
There is also an option for accounts with a single-level IVR setting to forward all company calls when
needed, such as during holidays, manual closures, or emergencies. Incoming calls can be forwarded to a
company greeting, announcement, voicemail, coworker, call queue, or shared line. You can set the time
period when the incoming calls should be forwarded.
1.

From the Admin Portal, navigate to Phone System > Auto-Receptionist > General Settings.

2.

Click IVR Settings. Company Call Handling appears.

3.

Select Forward all company calls if you want this option, and specify

4.

a.

Where calls should be forwarded.

b.

Start and end times for forwarding.

c.

Review the company greeting and click Save.

Under Business Hours and After Hours, select one of the following:
●

Company Greeting: Sends the call to company greeting. Callers may hear options where
they want to be connected to.

●

User Extension: Sends the call to a User extension.

●

Call Queue Group: Sends the call to a Call Queue Group.

●

Shared Line: Sends the call to a Shared Line.

●

Voicemail: Sends the call to a Message-only Extension.

●

Announcement: Sends the call to an Announcement-only Extension.

●

Limited Extension: Sends the call to a Limited Extension.

Learn more about Company call handling.

Company greeting
1.

From the Admin Portal, navigate to Phone System > Auto-Receptionist > General Settings.

2.

Click IVR Settings. Company Call Handling appears.

3.

Under Business Hours and After Hours, select Company Greeting.

4.

Click Edit under Play company greeting. The Company Hours Greeting window will appear.
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5.

For Set Greeting, select:
●

Default: Plays system default greeting.

●

Custom: Plays your custom recording. Select one of the following to record your greeting:
○

Phone: Choose a phone number from the dropdown menu if you have saved
numbers or select Enter a new number and type the phone number in the Call me at
ﬁeld. Click the Call Now button and RingCentral will call you to record your
greeting.

○

Computer Microphone: Click Allow if RingCentral asks to use your microphone.
The Microphone Test and Record settings will appear. When ready, click the red
record button to record your greeting through your computer microphone. Stop
the recording and listen to the playback. Click the arrow up to upload your
recording.

○

Importing: Browse for a WAV or MP3 ﬁle you want to use. Click Open.

6.

Under If Caller Enters no Action, select Connect to operator or Disconnect.

7.

Click Done.

8.

Click Save.
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Regional Settings
Set your timezone in Regional Settings. Typically, your timezone is linked to the area code of your main
company number. For example, for area code 650 (California), the time zone defaults to Paciﬁc Time. If you
are not physically located in your area code, you may want to change your timezone. You can also set the
following Regional Settings:
●

Time Zone

●

Time Format

●

Home Country Code

●

User Language

●

Greetings Language

●

Regional Format

To conﬁgure regional settings:
1.

Click the Phone System tab from the Admin Portal.

2.

Click Auto-Receptionist.

3.

Click General Settings.

4.

Click Regional Settings.

5.

Under Regional Settings, select options:
●

Select your Time Zone.

●

Select Time Format as 12hr or 24hr.

●

Select your Home Country Code.

●

Select your User Language as the default language used for all accounts and notiﬁcations.

●

Select the Greetings Language as the default language you want to use for phone greetings.

●

Select Regional Format as the format used to show date, time, currency, and other
numbers.

6.

Click Save.
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Dial-by-name directory
The Dial-by-Name section allows you to enable callers to search your phone system by users’ ﬁrst or last
names using their dialpad keys. To Conﬁgure the Dial-By-Name Directory:
1.

Click the Phone System tab from the Admin Portal.

2.

Click Auto-Receptionist.

3.

Click General Settings.

4.

Click Dial-by-Name Directory.

5.

Under Dial-by-Name Directory, set the slider button to On. Select options for dialing by name:
●

By default, all extensions are included in the directory.

●

To limit included extensions, under Extensions in Directory, click Edit. Then select the
extensions you want to include in the Dial-by-Name Directory.

6.

Click Done.
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Operator extension
Select the extension to use for the operator, which receives all calls and messages by default. The operator
extension is 101 by default.
Note: Use caution when changing this setting, as the operator is the default call recipient when no other
extension is dialed.
To reset the Operator Extension:
1.

Click the Phone System tab from the Admin Portal.

2.

Click Auto-Receptionist.

3.

Click General Settings.

4.

Click IVR Settings.

5.

Under General IVR Settings, click Select Extension. The Operator Extension window appears.

6.

Select the extension for the operator.

7.

Click Done.

8.

Click Save.

The assigned Operator Extension will now appear under IVR Settings heading.
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Zero dialing
Directly routes calls to a speciﬁed destination. Three options let you designate the call handling when the
caller dials zero within your IVR.
To set zero dialing:
1.

Click the Phone System tab from the Admin Portal.

2.
3.
4.
5.
6.

Click Auto-Receptionist.
Click General Settings.
Click IVR Settings.
Scroll down and click Zero Dialing.
Select one of three options:
● Connect to Company Greeting.
● Do Nothing: the system ignores any ‘0’ dialed by the caller and continues uninterrupted.
This applies regardless of the number of times the caller dials ‘0’.
● Connect to Extension: choose from Operator or Speciﬁc Extension.
For multi-site accounts, you may conﬁgure different or multiple operators on a per-location basis.
Click Save.

7.
8.

Note: When deleting an extension, a warning shows that if the extension is selected for zero dialing
connection, deleting the extension will result in zero dialings by callers to be connected to Company
Greeting.
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Name or label deﬁnitions
You can label phone numbers in a meaningful way to help identify locations or users in your system*. Larger
businesses with multiple locations and advanced call handling rules might involve selecting from lists of
numbers. Many numbers may appear similar unless they are renamed. An admin can assign an alternative
name to a particular number using the following steps:
1.

Click the Phone System tab from the Admin Portal.

2.
3.
4.
5.
6.

Click Phone Numbers.
Click Company.
Click the phone number to which you want to apply a label.
Enter the label text in the Name ﬁeld. You can designate the kind of number by using Number Type.
Click Save.

Note: This option is available for RingCentral Ultimate users.
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On-demand call recording
On-demand Call Recording makes it easy for RingCentral users to record calls they make or receive. When
you enable On-demand Call Recording, users can activate it by pressing *9 on their phone’s dialpad.
Note: State and federal laws require that your callers hear a call-recording notiﬁcation before and after a
call is recorded. As an administrator, you need to ensure your company's call recording procedures comply
with federal and state laws; RingCentral is not responsible for your company’s compliance.

Choosing an on-demand call recording announcement
This explains how to select a particular recording announcement once On-demand call recording is enabled.
1.

Click the Phone System tab from the Admin Portal.

2.
3.
4.
5.

Select Auto-Receptionist.
Click General Settings.
Click Call Recording. Slide the button on for On-demand Call Recording.
Click Edit to change:
a. Announcement on Start
● Click Set Greeting and choose Default or Custom.
● Click View In, choose the language for viewing the message text.
b. Announcement on Stop
● Click Set Greeting and choose Default or Custom.
● Click View in, choose the language for viewing the message text.
Click Done.
Click Save.

6.
7.

RingCentral MVP | Admin Guide | Auto-Receptionist
126

RingCentral MVP | Admin Guide | Auto-Receptionist
127

Enabling on-demand call recording announcement
1.
2.
3.
4.
5.
6.

Click the Phone System tab from the Admin Portal.
Click Auto-Receptionist.
Click General Settings.
Click Call Recording.
Move the slider button to the right next to, Enable On-demand Call Recording.
Click Save.
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Interactive Voice Response (IVR)
In the RingCentral system, you can create a multi-level IVR as an additional option for the
Auto-Receptionist. It extends the Auto-Receptionist menu with more powerful and efﬁcient call handling.

Multi-level IVR options
Single-location IVR example
A local dentist ofﬁce provides services to both English- and Spanish-speaking customers. The dental ofﬁce IT
Manager conﬁgures the phone routing system with identical prompts in two languages.

Multiple-location IVR example
A nationwide furniture retailer has ﬁve stores located in San Francisco, Chicago, New York, Dallas, and
Miami. The IT Manager sets up a toll-free number for the automated attendant system that can route
incoming calls to the proper stores in the entire retail chain.
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Switching to multi-level IVR mode
As an option, you can change your Auto-Receptionist from a single-level to a multi-level IVR to serve users
at multiple locations or to provide callers with multilingual menus.
1.

Click the Phone System tab from the Admin Portal.

2.
3.
4.

Click Auto-Receptionist.
Click General Settings.
Click the Single Level button and select Multi-level. The Switch to Multi-level IVR window will
appear with a warning message. By switching to multi-level IVR mode, all of your company call
handling settings will be discarded.
Conﬁrm that you wish to proceed.
Click Continue to conﬁrm switching to multi-level IVR.
The Switch to Multi-level IVR window appears. Do one of the following:
● Enter a top-level menu in the Select the top level menu to connect to the search ﬁeld.
● Select the button next to one of the listed Names.
Click Save.

5.
6.
7.

8.

Because your call handling settings are discarded, you will need to reset them. Your IT department should
validate and test the IVR conﬁguration to ensure the routing and prompts in a root menu work well before
connecting them to the Auto-Receptionist.
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Managing general IVR settings
When you have set multi-level IVR mode, you can see General IVR Settings from the Auto-Receptionist
menu. To set general IVR settings:
1.

Click the Phone System tab from the Admin Portal.

2.
3.
4.
5.
6.

Click Auto-Receptionist.
Click General Settings.
Select IVR Settings.
Scroll down to General IVR Settings.
Under General IVR Settings, select options:
a. Conﬁgure the actions for the general navigation keys. When callers press # (hash/ pound) or
* (star/asterisk), the following actions are available:
● Repeat menu greeting.
● Return to root menu.
● Return to previous menu.
b. If the caller enters no action after the prompt is played three times, the following actions
are available:
● Disconnect: The call will be disconnected.
● Connect to extension: The caller is routed to the extension you specify.
Click Save.

7.
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IVR Editor
RingCentral provides additional IVR tools to help you create and manage your IVR Menus.
Auto-Receptionist consists of three parts that help you conﬁgure your IVR: IVR Menus, IVR Editor, Prompts
Library. Use the IVR tool to:
●

Conﬁgure IVR menus with the Visual IVR Editor

●

Import prompt recordings

●

Record prompts

●

Import and export XML ﬁles

Note: Any change on the IVR menu overwrites the imported XML ﬁle. It is suggested that you export and
save a new XML ﬁle after making changes.
Access the IVR Tool by using the following steps:
1.

Click the Phone System tab from the Admin Portal.

2.

Click Auto-Receptionist.

3.

Click IVR Editor.
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IVR menus
RingCentral offers various tools to help manage and create IVR (interactive voice response) menus.
Administrators can add new IVR menus as shown in the following instructions, use the Visual IVR Editor, or
import an XML ﬁle.

Adding an IVR menu group
1.

Click the Phone System tab from the Admin Portal.

2.

Click Auto-Receptionist.

3.

Click IVR Menus.

4.

Click the New IVR Menu button. The Add IVR Menu window will appear.

5.

Enter the Extension Number and Extension Name.

6.

Click Save.

The new IVR Menu appears listed under IVR Menus.
Note: Available for MVP Premium and Ultimate users only.
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Conﬁguring an IVR menu
After you have created an IVR Menu, you can now conﬁgure the Extension Info, Direct Numbers, Prompt,
and Call Handling.

Conﬁguring extension info
After you select an existing IVR Menu, edit your extension number, name, or delete your menu.
1.

Click the Phone System tab from the Admin Portal.

2.

Click Auto-Receptionist.

3.

Click IVR Menus.

4.

Select an existing IVR Menu.

5.

Enter the Extension Number, Extension Name, and set the Language.

6.

●

Click Add if you would like to add a Direct Number.

●

If you would like to delete this IVR menu, click Delete IVR Menu.

Click Save.
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Adding Key Presses
Before you can switch your company call handling to multi-level IVR, you must ﬁrst add and set-up your IVR
menu. The Auto-Receptionist greets callers with a recorded message when they call your company. Your
Auto- Receptionist is initially set to play a default greeting with your company name using text-to-speech
technology. You can set a custom greeting by recording through your phone or computer or by uploading a
sound ﬁle. You can also connect the Auto-Receptionist calls directly to an extension of your choice.
1.

Click the Phone System tab from the Admin Portal.

2.

Click Auto-Receptionist.

3.

Click IVR Menus. To add a new IVR Menu, click New IVR Menu, ﬁll in the ﬁelds for Extension
Number and Extension Name, and then click Save.

4.

Click Key Presses.

5.

Click Add Key. The Key Press Assignment window appears.

6.

Set the Key Press.

7.

Select a Connect to action:
a. Transfer to voicemail of
b. Connect to Dial-by-name directory
c.

8.

9.

External transfer

Select to whom the setting will apply:
a.

All extensions

b.

Users

c.

IVR menu

d.

Others

e.

Groups

Select Users.

10. Click Save.
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Adding a direct number
1.

Click the Phone System tab from the Admin Portal.

2.

Click Auto-Receptionist.

3.

Click IVR Menus.

4.

Click an existing IVR Menu.

5.

Click Add under Direct Number.

6.

Select a Location and follow these instructions for the Number Type you choose:
a.

Local Number: Provide the State and Area Code. Select one or more numbers.

b.

Toll-Free Number: Select Toll-Free Number and select a Toll-Free preﬁx. Select one or more
numbers.

c.

Vanity Number: Select Vanity. Enter a number that helps customers remember your
business phone number. Click Search to check availability. Select a number.

7.

Click Add Numbers.

8.

Click Next when ﬁnished choosing your number.
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Visual IVR Editor
The Visual IVR Editor lets you conﬁgure your Multi-level IVR using an easy-to-use graphical interface. Add
menus and assign to extensions with just a few clicks. To launch the visual editor, follow these steps:
1.

Click the Phone System tab from the Admin Portal.

2.

Click Auto-Receptionist.

3.

Click IVR Editor.

4.

Click Launch Visual IVR Editor. The Visual IVR Editor opens in a new browser tab.

Creating a new IVR menu or open an existing IVR menu
Follow these steps to create a new IVR menu with the visual editor.
1.

In the new tab, you will see your Visual IVR Editor. On this page, you will have a New Tree waiting to
be created. You have the option to create a new IVR from this screen, or open an existing IVR and
edit it in the Visual IVR Editor.
a.

In the upper-left corner of the screen you have icons for Open Existing Menu, Save,
Validate, and Clear Workspace.

2.

In the upper-right corner, you have a search bar, an information dropdown menu with options for
Take a Tour and Learn More, and when you are viewing an IVR menu, you will see zoom in and out
buttons.
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3.

Click the Phone icon to start a new tree.

4.

Your new tree will be automatically assigned a name and extension number.

5.

Click the name or extension number to edit the text ﬁeld and enter your preferred name and
extension. Press enter when you are ﬁnished and the title will change automatically.

6.

Hover over your new IVR menu to see more options.

7.

Click “+” to add sub-items to your tree. Sub-items include:
a.

New Menu: Create a new IVR menu as an option within your tree.

b.

Existing Menu: Choose an existing IVR menu from a different IVR tree.

c.

External Transfer: Include an external number in your tree.

d.

Directory: Attach your company’s dial-by-name directory to your tree.

e.

Voicemail: Give the option to leave a voicemail.

f.

Extension: Add a speciﬁc extension to your tree.
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8.

9.
10.
11.
12.
13.
14.

As you add sub-items to your tree, they will appear in the Visual IVR Editor. Once you have added
your items to your menu, hover over an item to edit it and see more options. For some items you will
see a “+” and “…” and other items will only have the trash can icon.
Click the IVR name and extension text ﬁelds to edit them.
Click “+” to add sub-items to your tree.
Click “…” to open the menu for Settings, Duplicate, and Delete.
Click Settings to edit your IVR Menu settings just as you would edit them in the IVR Group settings.
Click Delete to delete this item.
To save the conﬁguration, click Save at the top left corner.
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Editing an existing IVR menu with the visual IVR editor
1.

Click the Phone System tab from the Admin Portal.

2.
3.
4.
5.
6.
7.
8.
9.

Click Auto-Receptionist.
Click IVR Editor.
Launch the Visual Editor, then click the Open Existing Menu icon.
Click on an existing menu to see a preview of the menu.
Click Open to be able to edit the menu in the Visual IVR Editor.
After editing your menu, click the Validate icon.
to check your IVR menu.
Click the Save icon once you are done editing to save your IVR.
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Prompt recordings
Prompt recordings guide callers with instructions on keys to press. Prompts can be pre-uploaded and saved
to the Prompts Library, which you can then set up as prompts using the IVR Tool.
There are two prompt modes: audio and text-to-speech.
●
●

Audio prompts are voice recorded
Text-to-speech prompts are written by you, then RingCentral’s automated system reads the prompt
to your callers.

Note: An IVR menu can function independently from the Auto-Receptionist, so it does not have to be set up
for an Auto-Receptionist greeting.

Recording an audio prompt
1.

Click the Phone System tab from the Admin Portal.

2.
3.
4.
5.
6.

Click Auto-Receptionist.
Click Prompts Library.
Click Record Prompts. The Record Prompt window will appear.
Enter a name for your prompt in the Prompt Name ﬁeld.
Select one of these prompt methods and follow the on-screen instructions:
● Phone
● Computer Microphone
Follow the remaining on-screen instructions to record your prompt.

7.
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Selecting audio prompt mode
1.

Click the Phone System tab from the Admin Portal.

2.
3.
4.
5.
6.
7.

Click Auto-Receptionist.
Click IVR Menus.
Select an existing IVR Menu. The Extension Info will appear.
Click Prompt.
Under Prompt mode, select the button next to Audio.
Click Select under Select Prompt. The Select Prompt window appears with a list of pre-uploaded
prompts.
8. Select the button next to the prompt you’d like to set.
9. Click Select.
10. Click Save.
You can listen to your new prompt by dialing into the extension.
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Selecting text-to-speech prompt mode
RingCentral's text-to-speech utility converts the text greeting you typed into a voice ﬁle and saves it to the
IVR Prompt Library. Set an IVR prompt using text-to-speech. The text you enter must contain only letters,
digits, space, commas, and periods. No special symbols. Use the words “hash” or “pound” or “star” instead of
“#” or “*” if needed.
To set up a text-to-speech prompt for an IVR menu:
1.

Click the Phone System tab from the Admin Portal.

2.
3.
4.
5.
6.
7.
8.

Click Auto-Receptionist.
Click IVR Menus.
Select an existing IVR Menu. The Extension Info will appear.
Click Prompt.
Under Prompt mode, select the button next to Text to speech.
In the box for Text, type your desired greeting and connection instructions for your callers.
Click Save.
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Importing or exporting XML ﬁles
In the XML section, you can import and export XML ﬁles for your IVR. Your IVR Menus are validated by
RingCentral once you import an XML ﬁle.

Downloading a sample XML ﬁle
1.

Click the Phone System tab from the Admin Portal.

2.

Click Auto-Receptionist.

3.

Click IVR Editor. The XML Editor displays.

4.

Under Download Sample IVR XML Files,
●

Click Single Level IVR.
OR

●

Click Multi-level IVR.

The sample XML ﬁle is downloaded to your browser.
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Exporting an XML ﬁle
1.

Click the Phone System tab from the Admin Portal.

2.

Click Auto-Receptionist.

3.

Click IVR Editor. The XML Editor displays.

4.

Under Export IVR XML File, click Export. The sample XML ﬁle is exported to your browser.

Importing an XML ﬁle
1.

Click the Phone System tab from the Admin Portal.

2.

Click Auto-Receptionist.

3.

Click IVR Editor. The XML Editor displays.

4.

Under Import XML ﬁle, click Import to browse and locate the XML ﬁle. Then click Import.

RingCentral detects conﬁguration issues as soon as you click Import. You can manually ﬁx the errors in the
XML ﬁle and upload it again or you can click Accept and Continue to manually ﬁx the errors using your
RingCentral Online account.
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Recording greetings and messages
Several tasks require admins to record messages or greetings for your RingCentral system. These steps
explain how to do the following:
●

Record Over the Phone

●

Record Using the Computer Microphone

●

Import a WAV or MP3 ﬁle

Importing a WAV ﬁle for your IVR prompt
In the Prompts section, you can import or record your IVR prompts and edit prompts that have already been
imported. To import a WAV ﬁle, do the following:
1.

Click the Phone System tab from the Admin Portal.

2.
3.
4.
5.
6.

Click Auto-Receptionist.
Click Prompts Library.
Click the Import Prompts button.
Navigate to the prompt ﬁle location.
Select the ﬁle and click Open.
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Recording a prompt over the phone
Account admins and users with permissions can create a custom audio prompt. One way to create this
prompt is to record the prompt using your phone.
1.

Click the Phone System tab from the Admin Portal.

2.
3.
4.
5.
6.
7.

Click Auto-Receptionist.
Click Prompts Library.
Click Record Prompts.
The Record Prompt window appears.
Enter a name in the text ﬁeld next to Prompt Name.
Click Phone.
● In the Call me at ﬁeld, choose a phone number from the drop-down menu if you have saved
numbers or type a phone number in the text ﬁeld.
● Click the Call Now button, and RingCentral will call you to record your message. Record
your IVR prompt over your phone when prompted.
Click Done.

8.
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Recording a prompt using your computer microphone
Account admins and users with permissions can create a custom audio prompt. One way to create this
prompt is to record the prompt using your computer microphone.
1.

Click the Phone System tab from the Admin Portal.

2.
3.
4.
5.
6.
7.
8.

Click Auto-Receptionist.
Click Prompts Library.
Click Record Prompts.
The Record Prompt window will appear.
Enter a name for your prompt,
Click Computer Microphone. Click Allow if RingCentral asks to record through your computer.
The Record Prompt window will appear
● When ready, click the red Record button to record or re-record your IVR prompt through
your computer microphone.
● Click the Play button to listen to your prompt and then click the Record button to re-record
your IVR prompt.
● Click the Upload button to save your recording to the Prompts Library.
Click Done.

9.
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Company custom rules
Company custom rules allow you to create different call experiences for incoming callers.
When an incoming call is received that matches any custom rule conditions you have set, for example, Caller
ID, Dialed Number, or Date and Time, you can apply different call handling, such as playing the company
greeting, ringing a user extension, call queue, or shared line, or send the call to voicemail.
After you create a custom rule, be sure to test the rule to verify that it works as intended.

Creating a custom rule
1.

Click the Phone System tab from the Admin Portal.

2.

Navigate to Auto-Receptionist > General Settings. Select a site if you have a multi-site account.

3.

Click IVR Settings.

4.

Under Custom Answering Rules, click Add Custom Rule or Edit Custom Rule.

5.

Click Add Rule.
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6.

Enter Your Rule Name, then click Next.

7.

Deﬁne the call conditions, then click Next.

Continue to the following pages according to the rule condition(s) that you want to apply.
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Custom answering rule conditions
Custom rule condition - Caller ID
Caller ID applies the rule according to the phone numbers you specify. Be sure the speciﬁed number is caller
ID enabled.
1.

Click the checkbox next to CallerID.

2.

Enter the phone number or contact name and click Add.

3.

Click Next.

4.

Deﬁne the call handling action to be performed when the conditions are met. Call handling options
include Company Greeting, User Extension, Call Queue Group, Shared Line, Voicemail, and
Announcement.

5.

Click Save.

RingCentral MVP | Admin Guide | Auto-Receptionist
153

Custom rule condition - Called Number
Called Number applies the rule to the phone number dialed.
1.

Click the checkbox next to Called Number.

2.

Click Select Number, then select a number.

3.

Click Done, and then click Next.

4.

Deﬁne the call handling action to be performed when the conditions are met. Call handling options
include Company Greeting, User Extension, Call Queue Group, Shared Line, Voicemail, and
Announcement.

5.

Click Save.
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Custom rule condition - Date and/or Time
This condition applies rules based on a time of day, week, or date range.
1.

Click the checkbox next to Date and/or Time.

2.

Conﬁgure one of the following under Select When This Rule Should be Active.
●

Weekly Schedule: Select the speciﬁc day of the week and a speciﬁc time to apply the
custom rule.

●
3.

Speciﬁc Date Range: Designate the dates when the custom rule begins and ends.

Click Next.
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4.

Deﬁne the call handling action to be performed when the conditions are met. Call handling options
include Company Greeting, User Extension, Call Queue Group, Shared Line, Voicemail, and
Announcement.

5.

Click Save.
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Custom answering rule call handling actions
●

Company Greeting: Plays your company greeting. You can customize the company greeting as
needed.

●

User Extension: Routes calls to a user extension.

●

Call Queue Group: Routes calls to a call queue.

●

Shared Line: Routes calls to a shared line.

●

Voicemail: Routes calls to a voicemail box (message-only extension).

●

Announcement: Routes calls to an announcement-only extension.

Note: Customers with the RingCentral MVP Essentials plan will not see the Shared Line option since they
don’t get it with their package.

Custom answering rule list
All created custom answering rules are listed when you follow these steps:
1.

Click the Phone System tab from the Admin Portal.

2.

Click Auto-Receptionist.

3.

Click General Settings.

4.

Click IVR Settings.

5.

Under Custom Answering Rules, click Edit Custom Rule.

To add a custom rule, click Add Rule. Follow the instructions on the previous pages. To validate the list of
created rules click Validate. To edit an existing rule, click Edit.
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Call groups
RingCentral offers different types of groups for your phone system needs. Let’s take a closer look at these
groups:
●

Call Queues are different from extensions. Call queues increase the efﬁciency of your company by
directing the calls to the right employees. Call queues can support up to 25 calls waiting in a call
queue. Queue overﬂow can be enabled to extend your call queue.

●

Paging Only groups enable real-time one-way broadcasting through multiple desk phones and
overhead paging devices

●

Shared Lines allow calls made to one phone number to be answered by multiple phones. Answered
calls can easily be handed off to other phones sharing the same phone number.
Note: Paging only and Shared lines are not available for on-line accounts.

●

Park Locations are private locations for your employees to park and pick up calls. Create up to 100
park locations for different groups of users in your phone system.

●

Call Monitoring allows you to set permissions that allow speciﬁc users to monitor the calls of other
users.
Note: This feature is only available for MVP Premium and Ultimate users only.

●

Call Pickup Groups allow group members to answer each other’s calls from their own devices..

●

Message-Only Extensions allow you to create a dedicated extension speciﬁcally for receiving voice
messages. All calls routed to this extension are automatically directed to the extension's voicemail
box.

●

Announcements-Only Extensions allow you to create a dedicated extension speciﬁcally for playing
an announcement. All callers that are routed to this extension will only hear a recorded
announcement/greeting.

●

Limited Extensions allow you to create an extension installed in a common area (meeting rooms or
in hotel rooms) for anyone who has the need to access basic inbound/outbound calling capabilities.
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Call queues
Create a call queue when you want a speciﬁc group of users (such as Sales, Support, or Billing) to share
incoming calls. Each call queue can have an extension or direct (local or toll-free) number of its own. You can
deﬁne speciﬁc business hours for each call queue and set up email or text message notiﬁcations of any
missed calls or voicemails.

Adding a call queue group
1.

Click the Phone System tab from the Admin Portal.

2.

Click Groups.

3.

Click Call Queues.

4.

Click the New Call Queue button. The Add Call Queue window will appear.

5.

Enter a Group Name and Extension Number.

6.

Click Select Call Queue (optional) if you’d like to copy the settings from an existing call queue.
●

Select the button next to the call queue name.

●

Click Done.

7.

Click Next.

8.

Conﬁgure the following options:
a.

If you’d like to have several managers for the call queue, select the button for Select
Managers From User List.

b.

9.

●

Enter a PIN, then re-enter it on the ﬁelds provided.

●

Select managers and specify their permissions.

●

Click Next.

If you’d like to have one manager for the call queue, select Use Manager’s Email.
●

Enter the email on the Manager’s Email ﬁeld.

●

Click Next.

Select the users you’d like to add to the group from the Call Queue Members list.

10. Click Done.
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Conﬁguring a call queue
After you have created a Call Queue, you can conﬁgure the Call Queue Details, Direct Numbers, Greeting,
Call Handling, Pickup settings, and Messages & Notiﬁcations.
1.

Click the Phone System tab from the Admin Portal.

2.

Click Groups.

3.

Click Call Queues.

4.

Select an existing Call Queue. If you don’t have any existing call queues, go to the previous page to
learn how to create one.

5.

Edit your settings:
a.

Call Queue Details
●

Extension Number

●

Group Name

●

Record Group Name

●

Company Name

●

Contact Phone

●

Manager Email

●

Password

●

Delete Group

●

Regional Settings

●

Business Hours

●

Address

●

Conﬁrmation Message

●

Video Service

b. Direct Numbers
●
c.

Add Direct Number

Greeting & Hold Music
●

Call Queue Greeting

●

Audio While Connecting

●

Hold Music

●

Interrupt Audio

●

Blocked Calls

d. Call Handling & Members
●

Business Hours

●

After Hours

●

Wait Settings

●

Display Settings

●

Overﬂow

●

Custom Rules

●

Call Queue Members

e. Pickup Settings & Members
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f.

6.

●

Pickup members

●

Alert timer

Messages & Notiﬁcations

Click Save.

●

Voicemail Greeting

●

Message Recipient

●

Notiﬁcation Settings
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Conﬁguring call queue-to-queue overﬂow
Call queue-to-queue overﬂow allows scalable management of inbound calls during heavier-than-usual or
peak-season inbound call activity. You can append existing queues to the original queue, so if all lines are
busy in the original queue, calls overﬂow to additional queues.
Call handling follows the call queue policy. Call queue overﬂow is supported for the Rotating and In Fixed
Order sequence protocols. The Simultaneous protocol is not supported.
The Overﬂow Call Queues section lets you enable, create, and manage your overﬂow queues.
1.

Click the Phone System tab from the Admin Portal.

2.

Click Groups.

3.

Click Call Queues.

4.

Select an existing call queue group. The call queue group must be conﬁgured with either a Rotating
or Sequential call handling protocol.

5.

Click Call Handling & Members.

6.

Click the arrow down additional options icon and click Overﬂow.

7.

Click the toggle on to enable the Overﬂow Queue feature. Select a maximum of three groups from
the call queue list.

8.

Click Save.
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Adding a direct number
1.

Click the Phone System tab from the Admin Portal.

2.

Click Groups.

3.

Click Call Queues.

4.

Select an existing Call Queue.

5.

Click Direct Numbers.

6.

Click Add Direct Number.

7.

Select a Location and follow these instructions for the Number Type you choose.
a.

Local Number: Select Local Number. Provide the State and Area Code and select number.

b.

Toll-Free: Select Toll-Free Number. Select a Toll-Free preﬁx and select a number from the
list of available numbers.

c.

Vanity: Select Vanity. Choose a number that helps customers remember your business
phone number. Click Search to see if it is available.

8.

Click Next when ﬁnished choosing your number.
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Setting call queue greeting and hold music
If you would like your callers to hear a recorded greeting before being connected to a call group, turn on the
Call Queue greeting. In this section, you can also set the audio while connecting, hold music, and if you want
to interrupt audio.
Note: If you have set custom call queue hours, follow these steps for both the Call Queue Hours and After
Hours tabs.
To set call queue greeting and hold music, follow the steps below:
1.

Click the Phone System tab from the Admin Portal.

2.

Click Groups.

3.

Click Call Queues.

4.

Select an existing Call Queue.

5.

Click Greeting & Hold Music.

6.

Tick the checkbox for each of the following to enable the settings and click Edit:
●

Call Queue Greeting: Choose your preferred type of greeting:
○

Default: Select Default if you want to use a system-default call queue greeting

○

Custom: Select Custom and select how you’d like to set your custom recording:
■

Phone: Next to Call me at, choose a phone number from the dropdown
menu if you have saved numbers or type a phone number in the text ﬁeld.
Click the Call Now button and RingCentral will call you to record your
message

■

Computer Microphone: Click Allow if RingCentral asks to record through
your computer. The Microphone Test and Record settings will appear.
When ready, click the red Record button to record your greeting through
your computer microphone. Stop the recording and listen to the playback

■
●

Importing: Browse for a WAV or MP3 ﬁle you want to use. Click Open

Audio While Connecting: Set the audio to the following:
○

Ring Tones: Select Ring Tones if you want your callers to hear ring tones while the
call is being connected

○

Music: Select Music if you want callers to hear music

○

Custom: Select Custom if you want to upload your own audio ﬁle. Click Browse and
select your audio.

●

Hold Music: Set what you want callers to hear when you put a call on hold
○

Ring Tones: Select Ring Tones if you want your callers to hear ring tones while the
call is being connected

○

Music: Select Music if you want callers to hear music

○

Custom: Select Custom if you want to upload your own audio ﬁle. Click Browse and
select your audio.
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●

Interrupt Audio: Set this if you want callers to hear an audio prompt playing in speciﬁc
intervals while waiting for a call queue member to answer the call. Select from the
dropdown list how often the audio will be interrupted by the prompt and set your Interrupt
Prompt:
○

Default: Select Default if you want to use a system-default recording and select
your preferred audio from the options provided.

○

Custom: Select Custom if you want to utilize a fully customized audio recording
using the available options.

7.

Click Done.

8.

Click Save.

Incoming call handling
Choose how you’d like each call queue to handle incoming calls. Set the order in which the calls will be
transferred to the members of the call queue.
1.

Click the Phone System tab from the Admin Portal.

2.

Click Groups.

3.

Click Call Queues.

4.

Click the name of the Call Queue you’d like to conﬁgure.

5.

Select Call Handling & Members > Business Hours to edit your call handling settings.

6.

Select the order in which calls are transferred to department members:
a.

Rotating: Regularly changes the order that you ring available members to evenly distribute
the calls.

7.

b.

Simultaneous: Routes an incoming call to all available members at the same time.

c.

Sequential: Ring available members one at a time in the order you set.

Click Save.
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Pickup Settings & Members
The Call Queue Pickup feature allows administrators to specify an alternate group of users to answer calls
when the primary agents of a call queue are unavailable. Pickup group members receive call notiﬁcations
when callers wait on hold ‘in-queue’ for more than the conﬁgured ‘Alert’ time. Answer queued calls by
pressing the pickup feature key on the phone.

Setting up Call Queue Pickup Groups
1.

From the Admin Portal, go to Phone System > Groups > Call Queues.

2.

Click the desired Call Queue name, then click Pickup Settings & Members.

3.

On the Pickup members tab, select Add Pickup Member.

4.

Search or browse the names, then add pickup members.

5.

Click Done. This will prompt a conﬁrmation box.

6.

Click OK.

Setting up an alert timer
1.

From the Admin Portal, go to Phone System > Groups > Call Queues.

2.

Click the desired Call Queue name, then click Pickup Settings & Members.

3.

Click Settings.
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4.

Select an alert time duration. This is the amount of time before pickup group members will be
notiﬁed there is a call waiting.

5.

Click Save.

Removing a Pickup member
1.

From the Admin Portal, go to Phone System > Groups > Call Queues.

2.

Click the desired Call Queue name, then click Pickup Settings & Members.

3.

Click Remove at the far right of the member’s name you want to remove.

Setting up visual/audible call notiﬁcations
1.

From the Admin Portal, go to Users > User List > Users with Extensions.

2.

Click on the user you want to conﬁgure.

3.

Select Phones & Numbers.

4.

Click Presence.

5.

Select Ring my phone when any user I am monitoring rings.

6.

Click Save.

Messages and notiﬁcations
In this section, set your message recipient, voicemail greeting, and notiﬁcations. RingCentral allows each
Call Queue a separate voicemail message to greet unanswered calls, as well as allowing you to set a recipient
for these voicemails.

Setting a voicemail greeting
1.
2.

Click the Phone System tab from the Admin Portal.
Click Groups.

3.

Click Call Queues.

4.

Select a Call Queue.

5.

Click Messages & Notiﬁcations.

6.

Click Edit under Voicemail Greeting.

7.

A window will appear displaying the current Voicemail Greeting. Choose your preferred type of
greeting
●

Default: Select Default if you want to use a system-default voicemail greeting.

●

Custom: Select Custom and select how you’d like to set your custom recording.
○

Phone: Next to Call me at, choose a phone number from the dropdown list if you
have saved numbers or type a phone number in the text ﬁeld. Click the Call Now
button, and RingCentral will call you to record your message
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○

Computer Microphone: Click Allow if RingCentral asks to record through your
computer. The Microphone Test and Record settings will appear. When ready, click
the red Record button to record your greeting through your computer microphone.
Stop the recording and listen to the playback

○
8.

Click Done.

9.

Click Save.

Import: Browse for a WAV or MP3 ﬁle you want to use. Click Open.
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Setting message recipients
After you have set your Voicemail Greeting, you can set which users or call queues to receive messages. To
do this, follow the steps below:
1.

Click the Phone System tab from the Admin Portal.

2.

Click Groups.

3.

Click Call Queues.

4.

Select a Call Queue.

5.

Click Messages & Notiﬁcations.

6.

Click Select Extension under Message Recipient.

7.

A window will appear with a list of members to receive messages left for this call queue.

8.

Select the button next to the recipient.

9.

Click Done.

10. Click Save.
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Setting voicemail-to-text transcription
The voicemail-to-text transcription provides a text version of your voicemail that allows you to get the gist
of the message. The voicemail transcription is delivered to your RingCentral mobile or desktop application
or via email.
1.

Click the Phone System tab from the Admin Portal.

2.

Click Groups.

3.

Click Call Queues.

4.

Select an existing Call Queue.

5.

Click Messages & Notiﬁcations.

6.

Click Settings.

7.

Click the toggle switch to enable or disable Voicemail-to-Text
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Setting notiﬁcations
As an administrator, you can set up notiﬁcations to be sent to your phone or email when voicemails, faxes,
missed calls, and text messages are received for each call queue. To do this, follow the steps below:
1.

Click the Phone System tab from the Admin Portal.

2.

Click Groups.

3.

Click Call Queues.

4.

Select a Call Queue.

5.

Click Messages & Notiﬁcations.

6.

Click Settings.

7.

Click Edit under Notiﬁcations.

8.

A pop-up will appear with notiﬁcation options. Set your notiﬁcations by checking the boxes and
ﬁlling in email and phone numbers.
a.

Click Basic Settings > Advanced Settings to see more detailed notiﬁcation settings.

b.

Set your Advanced Settings. Here, you can customize your notiﬁcations for voicemail
messages, received faxes, and received text messages. You can choose different email
addresses and phone numbers for your notiﬁcations, and select options for email
attachments.

9.

Click Save.
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Paging only groups
Paging Only groups enable real-time one-way broadcasting through multiple desk phones and overhead
paging devices. Paging Only groups are great for a variety of locations such as warehouse/shipping centers,
retail stores, schools, and hospitals, among others.
You can page using a special phone with a paging soft- key, or by dialing *84 from your digital desk phone or
from your VoIP calling-enabled mobile phone. In each case, you need to set up the Group number or the
number representing a group of extensions receiving a paged message prior to the page.

Adding a paging only group
1.

Click the Phone System tab from the Admin Portal.

2.

Click Groups.

3.

Select Paging Only.

4.

Select New Paging Only button in the upper right.

5.

Enter the Group Name and Extension Number.

6.

Click Save.

Note: This feature is available for accounts with two or more users.
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Conﬁguring a paging only group
After you set up a paging group, select the devices to receive pages from the list of paging devices and user
phones that have this capability.
1.

Click the Phone System tab from the Admin Portal.

2.

Click Groups.

3.

Select Paging Only.

4.

Select a Paging Only group.

5.

In the Paging Only Details tab, edit your extension number, group name, disable the extension, or
delete the group.

6.

Click Save.

7.

Click the Paging tab.

8.

Click Devices to Receive Page: Select the User Phones or Paging Devices to receive pages.

9.

Click Users Allowed to Page this Group: Select the users who are to be allowed to page.

10. Click Save.
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Shared line groups
The Shared Lines feature allows calls made to one phone number to be answered by up to 16 phones as a
designated group. Multiple groups of shared lines can be set up. Answered calls can easily be handed off to
other phones sharing the same phone number.

Adding a shared line group
1.

Click the Phone System tab from the Admin Portal.

2.

Click Groups.

3.

Click Shared Lines.

4.

Click New Shared Line. The Add Shared Line window will appear.

5.

Select a location: Domestic or International.

6.

Enter the Group Name, Manager’s Email, and Extension Number.

7.

Click Next.

8.

Follow the prompts to add phone lines, the order of phone number, and devices.

9.

Click Save.
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Conﬁguring a shared line group
Conﬁgure the Shared Lines group’s name, password, business hours, and regional settings. You can also
apply a template to the group. Edit your extension number, name, or delete your menu.
1.

Click the Phone System tab from the Admin Portal.

2.

Click Groups.

3.

Click Shared Lines.

4.

Select a shared line from the list.

5.

Click Shared Line Details.

6.

Edit the details under the following:
a. General

b.

7.

●

Extension Number

●

Group Name

●

Manager Email

●

Password

●

Status

●

Record Group Name

Settings
●

Regional Settings

●

Site

●

Conﬁrmation Message

●

Business Hours

●

Shared LInes Devices

●

Automatic Call Recording

Click Save.

Adding a direct number
A direct number is a phone number that can be called without going through the auto-receptionist.
1.

Click the Phone System tab from the Admin Portal.

2.

Click Groups.

3.

Click Shared Lines.

4.

Select an existing Shared Lines group.

5.

Click Direct Numbers.

6.

Click Add Direct Number.

7.

Select a Location and follow these instructions for the Number Type you choose:
a.

Local Number: Provide the State and Area Code. Select one or more numbers and click Add
Numbers.

b.

Toll-Free Number: Select Toll-Free Number and a toll-free preﬁx. Select one or more
numbers and click Add Numbers.
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c.

Vanity Number: Select Vanity. Choose a number that helps customers remember your
business phone number. Click Search to see if it is available. Select a number and click Add
Numbers.

8.

Click Next after choosing your number. Follow the prompts to purchase your new number.

Setting a greeting
Set a greeting and keep the default, or record a custom group greeting.
1. Click the Phone System tab from the Admin Portal.
2. Click Groups.
3. Click Shared Lines.
4. Select an existing Shared Lines group.
5. Click Greeting and then click Business Hours.
6. Tick the checkbox below the following to enable the feature:
a.

Shared Line Greeting

b.

Audio While Connecting

c.

Hold Music

7. Choose your preferred type of greeting:
a.

Default: To use the provided greeting, click Default.

b.

Custom: Select Custom and select how you’d like to set your custom recording:
●

Phone: Next to Call me at, choose a phone number from the dropdown list if you
have saved numbers or type a phone number in the text ﬁeld. Click the Call Now
button, and RingCentral will call you to record your message.

●

Computer Microphone: Click Allow if RingCentral asks to record through your
computer. The Microphone Test and Record settings appear. When ready, click the
red Record button to record your greeting through your computer microphone.
Stop the recording and listen to the playback.

●

Importing: Browse for a WAV or MP3 ﬁle you want to use. Click Open.

8. Click Save.

Managing blocked calls
Select Blocked Calls tab to block speciﬁc calls or all calls for this call group. Then, set up the message blocked
callers will hear.
1.

Click the Phone System tab from the Admin Portal.

2.

Click Groups.

3.

Click Shared Lines.

4.

Select an existing Shared Lines group.

5.

Click Greeting and then click Blocked Calls.

6.

Click Edit under Callers will hear section. The Callers will Hear window will appear.
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7.

Click the dropdown list under View In and select language.

8.

Tick to select a default greeting under Callers will hear. Click the play button to listen to the
preview.

9.

Click Done.

10. Click Save.

Setting custom music on hold
You can customize Music on Hold for shared lines to tailor the caller's waiting experience. The Music on
Hold options include:
●

Ring Tones

●

Music: Acoustic, Beautiful, Classical, Corporate, Country, Holiday, Latin, Modern Jazz, Nature,
Reggae, World

●

Upload custom ﬁle in WAV or MP3 format

To set up custom Music on hold:
1.

Click the Phone System tab from the Admin Portal.

2.

Click Groups.

3.

Click Shared Lines.

4.

Select an existing Shared Lines group.

5.

Select Greeting and select Business Hours.

6.

Under Hold Music, check Enable.

7.

Click Edit under Hold Music.

8.

Click the dropdown under Set Audio and select Custom.

9.

Click Browse.

10. Select your audio.
11. Click Done.
12. Click Save.

Managing call handling
Review or change each option for handling incoming calls for both business hours and after hours.
1.

Click the Phone System tab from the Admin Portal.

2.

Click Groups.

3.

Select Shared Lines.

4.

Select an existing Shared Lines group.

5.

Click Call Handling.

6.

Conﬁgure the following under Business Hours:
a.

When all lines are busy, forward calls to:
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b.

●

Click Edit.

●

Select Group Voicemail or an extension.

●

Click Done.

Select an option on the dropdown menu under Number of seconds to wait before
forwarding unanswered calls.

7.

Click After Hours.
a.

The Conﬁrmation window will appear if the business hours for the group is set to 24 hours
a day. Click Yes and then change the business hours.

b.

Click Save.

c.

Click the dropdown menu under How to handle calls during after hours.

d.

Click your selection.

e.

If you selected unconditional forwarding, enter the number where calls should be
forwarded under Forward Calls.

8.

Click Save.

Managing outbound caller ID
Set up an outbound caller ID for the group, or use individual numbers as caller IDs for each line.
1.

Click the Phone System tab from the Admin Portal.

2.

Click Groups.

3.

Click Shared Lines.

4.

Select an existing Shared Lines group.

5.

Click Outbound Caller ID.

6.

Click the dropdown under Outgoing Call Displayed as.

7.

Select Group or Individual Lines.

8.

If you selected Group, click Edit below the dropdown box.

9.

Select a phone number you want to display as your caller ID number for the outgoing call. Click
Done.

10. Click Edit below Alternate Caller ID. Select a phone number you want to display as your Caller ID
number for Alternate Caller ID. Click Done.
11. Click Save.
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Messages and notiﬁcations
Set up a group voicemail and notiﬁcation options.

Setting up voicemail greeting
1.

From the Admin Portal, select the Phone System tab.

2.

Click Groups.

3.

Click Shared Lines.

4.

Select an existing Shared Lines group.

5.

Click Messages & Notiﬁcations.

6.

Take Messages feature is enabled by default. To disable the group from taking messages during
business hours, uncheck Enable.

7.

Click the Play button to listen to the default voicemail greeting. To customize, click Edit below
Voicemail Greeting.

8.

Click the drop-down box under Set Greeting, then select Custom.

9.

Click the tab corresponding to how you prefer to customize the greeting:
●

Phone: Next to Call me at, choose a phone number from the dropdown list if you have
saved numbers or type a phone number in the text ﬁeld. Click the Call Now button, and
RingCentral will call you to record your message.

●

Computer Microphone: Click Allow if RingCentral asks to record through your computer.
The Microphone Test and Record settings will appear. When ready, click the red Record
button to record your company greeting.

●

Importing: Browse for a WAV or MP3 ﬁle you want to use. Click Open.

10. Click Done.
11. Click Save.
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Setting a message recipient
Set a message recipient for a Shared Line.
1.

Click the Phone System tab from the Admin Portal.

2.

Click Groups.

3.

Click Shared Lines.

4.

Select an existing Shared Lines group.

5.

Click Messages & Notiﬁcations.
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6.

Ensure that the checkbox for Take Messages is ticked.

7.

Below Message Recipient, click Select Extension.

8.

Select the extension.

9.

Click Done.

10. Click Save.

Setting voicemail-to-text
The voicemail-to-text transcription provides a text version of your voicemail that allows you to get the gist
of the message. The voicemail transcription is delivered to your RingCentral mobile or desktop application
or via email.
1.

Click the Phone System tab from the Admin Portal.

2.

Click Groups.

3.

Click Shared Lines.

4.

Select an existing Shared Lines group.

5.

Click Messages & Notiﬁcations.

6.

Click Settings.

7.

Click the toggle switch to enable or disable Voicemail-to-text.

Setting notiﬁcations
Choose who will receive notiﬁcations for voicemail messages and how they will receive them.
1.

Click the Phone System tab from the Admin Portal.

2.

Click Groups.

3.

Click Shared Lines.

4.

Select an existing Shared Lines group.

5.

Click Messages & Notiﬁcations.

6.

Click Settings.

7.

A pop-up will appear with notiﬁcation options. Set your notiﬁcations by checking the boxes and
ﬁlling in email and phone numbers.

8.

Click Basic Settings > Advanced Settings to see more detailed notiﬁcation settings.

9.

Set your Advanced Settings. Here, you can customize your notiﬁcations for voicemail messages,
received faxes, and received text messages. You can choose different email addresses and phone
numbers for your notiﬁcations, and select options for email attachments.

10. Click Save.
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Park location groups
Use Park Location groups to create a private location in which speciﬁc users can park and pick up calls. Once
users have been added to the group, the park location can be added to the user’s Presence on a desk phone
or HUD in the RingCentral app. You can have up to 100 park locations in your phone system.

Adding a park location
1.

Click the Phone System tab from the Admin Portal.

2.

Click Groups.

3.

Click Park Locations.

4.

Click New Park Location. The Add Park window will appear.

5.

Enter the Group Name and Extension Number.

6.

Click Yes to add a Phone Key automatically to member phones (optional).

7.

Click Save.

Note: Only one call can be parked in each location at a time.
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Conﬁguring a park location
After you have created a Park Location, you can edit its information and the users in the group.
To edit your Park Location’s Extension Number and Name:
1.

Click the Phone System tab from the Admin Portal.

2.

Click Groups.

3.

Click Park Locations.

4.

Select an existing Park Location.

5.

Click Park Location Details.

6.

Edit the Extension Number and Park Location.

7.

Click Save.
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Adding members to a park location
To add or remove users from a Park Location:
1.

Click the Phone System tab from the Admin Portal.

2.

Click Groups.

3.

Click Park Location.

4.

Select an existing Park Location.

5.

Click Location Members.

6.

Select the names of the Users that should be added to the list.

7.

Click Save. If the added user/s belong to a ring group, all members of the ring group must be added
to the Users of the park location.

8.

An Alert window appears as a reminder to set up the User's Presence. Click OK.

9.

Set up Presence Appearance on the online account.
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Setting up presence appearance
1.

Click the Users tab from the Admin Portal.

2.

Click the name of the user that was added to the park location.

3.

Select Phones & Numbers.

4.

Select Phones.

5.

Select Presence.

6.

Click Select a User.

7.

Select the Park Location extension from the list.

8.

Click Done.
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Call monitoring groups
Call monitoring groups all authorized users to access calls made by other users in real-time. These functions
provide training, coaching, and QA tools for supervisors or other levels of the management team. They can
also help improve teams’ performance and productivity. The following actions are available for an
authorized user in a call monitoring group: Monitor, Whisper, Barge, and Take Over.
To set up call monitoring, you’ll need to create a call monitoring group and conﬁgure it. The system prompts
you to select the users who will have permission to monitor, and lastly, select the users who can be
monitored.
After creating a call monitoring group, users who have permission to monitor others’ calls will use the
touch-tones on their phones to access the call monitoring features. These users will select a current call in
progress on their phones then press the touch-tone for the action they’d like to take.
You must have a supported device with presence capabilities to use this feature. The following devices are
supported:
Polycom

•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

Polycom IP650
Polycom VVX 310
Polycom VVX400
Polycom VVX410
Polycom VVX411
Polycom VVX500
Polycom VVX501
Polycom VVX600
Polycom VVX601
Polycom VVX150
Polycom VVX250
Polycom VVX350
Polycom VVX450
Polycom CCX 400
Polycom CCX 500
Polycom CCX 600
Polycom CCX 700

Cisco

●
●
●
●
●
●
●

Cisco SPA525G
Cisco CP8851
Cisco SPA504G
Cisco SPA509G
Cisco CP7841
Cisco 7841
Cisco 8861
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Adding and conﬁguring a call monitoring group
1.

Click the Phone System tab from the Admin Portal.

2.

Click Groups.

3.

Click Call Monitoring.

4.

Select New Call Monitoring.

5.

Enter a Group Name.

6.

Click Next.

7.

Select the users that can monitor this group.

8.

Click Next.

9.

Select the users that can be monitored by this group.

10. Click Save.
Note: The users who will be monitoring (for example, supervisors) can add the users who are monitored (for
example, agents) in their desk phone Presence appearance. The desk phone may need to be rebooted after
these settings have been changed.
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Directed call pickup
Administrators can set and manage call pickup permissions for multiple users together. Pickup group Users
can answer each other’s calls from their own device by dialing *58 followed by the ringing extension’s
number. Administrators can set and manage call pickup permissions for multiple users at once.

Adding a call pickup group
To add a new call pickup group:
1.

Click the Phone System tab from the Admin Portal.

2.

Click Groups.

3.

Click Call Pickup.

4.

Click + New Directed Call Pickup. The Add Directed Call Pickup window will appear.

5.

In the Add Details tab, enter the group name and choose a site from the drop down menu.

6.

Click Next.

Choose group members in the Select Members tab, where you can ﬁlter by using the Search ﬁeld and by
dropdown lists for Department and Site.
7.

From the Name list, check the box to the left of any entry to include them in the group.

8.

Click Save.
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Message-only extensions
Create an extension dedicated to receiving messages. All calls routed to this extension are automatically
directed to the extension’s voicemail box.

Adding a message-only extension
1.

Click the Phone System tab from the Admin Portal.

2.

Click Groups.

3.

Click Message-Only Extensions.

4.

Click New Message-Only Extension. The Add Message-Only Extension window appears.

5.

Enter the Extension Name, Short Extension Number, and Email.

6.

Click Save.
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Conﬁguring a message-only extension
After you’ve created a Message-Only Extension, conﬁgure the Extension Details, Direct Numbers, and
Messages & Notiﬁcations.

Managing extension details
Edit your extension number, name, or delete your extension.
1.

Click the Phone System tab from the Admin Portal.

2.

Click Groups.

3.

Click Message-Only Extensions.

4.

Select an existing message-only extension.

5.

Click Message-Only Extension Details to edit the following:
●

Short Extension Number

●

Record Extension Name

●

Extension Name

●

Record Extension Name

●

Company Name

●

Contact Phone

●

Email

●

Status

●

Delete Group

6.

Click Save.

7.

Click Settings to edit the following:
●

Regional Settings

●

Site

●

Conﬁrmation Message
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Recording an extension name
You can use this option to ensure the extension name is pronounced correctly by the system operator. You
can spell out the name the way it sounds to help the operator, or you can record the name in your own voice
and use it for announcements instead.
1.

Click the Phone System tab from the Admin Portal.

2.

Click Groups.

3.

Click Message-Only Extensions.

4.

Select an existing message-only extension.

5.

Click Message-Only Extension Details.

6.

Click Edit under Record Extension Name.

7.

Select an option under Record by.
a.

RingCentral text-to-speech

b.

Record extension name:
●

Phone: Choose a phone number from the dropdown list if you have saved numbers
or select Enter a new number and type a phone number in the ﬁeld for Call me at.
Click the Call Now button, and RingCentral will call you to record your extension
name. Click Save.

●

Computer Microphone: Click Allow if RingCentral asks to record through your
computer. The Microphone Test and Record settings will appear. When ready, click
the red Record button to record your voicemail greeting. Click Save.

●

Importing: Click Browse and select the WAV or MP3 ﬁle you want to use. Click
Open. Click Save.

8.

Edit the Greeting Name (optional).

9.

Click Save.
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Adding a direct number
1.

Click the Phone System tab from the Admin Portal.

2.

Click Groups.

3.

Click Message-Only Extensions.

4.

Select an existing message-only extension.

5.

Click Direct Numbers.

6.

Click Add Direct Number. The Add Direct Number window will appear.

7.

Select a Location and follow these instructions for the Number Type you choose:
●

Local Number: Provide the State and Area Code. Select one or more numbers and click Add
Numbers.

●

Toll-Free Number: Select a toll-free preﬁx. Note that there is a $30 one-time set up fee per
number if you select 800 as your toll-free preﬁx. Select one or more numbers and click Add
Numbers.

●

Vanity Number: Enter a number that helps customers remember your business phone
number. Click Search to check availability. Select a number and click Add Numbers.

8.

Click Next.

9.

Review the charges (if any) and click the acknowledge box.

10. Click Next.
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Designating a message recipient
Choose an extension to receive and save messages.
1.

Click the Phone System tab from the Admin Portal.

2.

Click Groups.

3.

Click Message-Only Extensions.

4.

Select an existing message-only extension.

5.

Click Messages & Notiﬁcations.

6.

Click Select Extension under Message Recipient. The Select Message Recipient window will
appear.

7.

Select the user.

8.

Click Done.

9.

Click Save.
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Setting a voicemail greeting
Set the voicemail greeting you would like to use for your Message-Only Extension.
1.

Click the Phone System tab from the Admin Portal.

2.

Click Groups.

3.

Click Message-Only Extensions.

4.

Select an existing message-only extension.

5.

Click Messages & Notiﬁcations.

6.

Click Edit below Voicemail Greeting. The Voicemail Greeting window will appear.

7.

Choose your preferred type of greeting under Set Greeting:
a.

Default: Select Default to set the system-default voicemail greeting. Select the language to
display the default greeting text under View In. Your selection here affects only your
current view of the greeting text, it will not change the greetings language setting.

b.

Custom: Select Custom and select how you’d like to set your custom recording:
●

Phone: Choose a phone number from the dropdown list if you have saved numbers
or select Enter a new number and type a phone number in the ﬁeld for Call me at.
Click the Call Now button, and RingCentral will call you to record your extension
name.

●

Computer Microphone: Click Allow if RingCentral asks to record through your
computer. The Microphone Test and Record settings will appear. When ready, click
the red Record button to record your voicemail greeting. Click the up arrow to
upload your recorded message.

●

Importing: Click Browse and select the WAV or MP3 ﬁle you want to use. Click
Open.

8.

Click Done.

9.

Click Save.
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Setting voicemail-to-text
The voicemail-to-text transcription provides a text version of your voicemail that allows you to get the gist
of the message. The voicemail transcription is delivered to your RingCentral mobile or desktop application
or via email.
1.

Click the Phone System tab from the Admin Portal.

2.

Click Groups.

3.

Click Message-Only Extensions.

4.

Select an existing message-only extension.

5.

Click Messages & Notiﬁcations.

6.

Click Settings.

7.

Click the toggle switch on to enable or disable Voicemail to Text.
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Setting notiﬁcations
Choose who will receive notiﬁcations for voicemail messages and how they will receive them.
1.

Click the Phone System tab from the Admin Portal.

2.

Click Groups.

3.

Click Message-Only Extensions.

4.

Select an existing message-only extension.

5.

Click Messages & Notiﬁcations.

6.

Click Settings.

7.

Click Edit under Notiﬁcations. The Notiﬁcations window will appear. Set your notiﬁcations by
checking the boxes and ﬁlling in email and phone numbers.

8.

Click Basic Settings > Advanced Settings to see more detailed notiﬁcation settings. Set your
Advanced Settings. Here, you can customize your notiﬁcations for voicemail messages, received
faxes, and received text messages. You can choose different email addresses and phone numbers for
your notiﬁcations, and select options for email attachments.

9.

Click Save.
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Announcement-only extensions
Create an extension that only plays an announcement for your callers. All callers routed to this extension
will hear a recorded announcement, such as a holiday closure announcement.

Adding an announcement-only extension
1.

Click the Phone System tab from the Admin Portal.

2.

Click Groups.

3.

Click Announcement-Only Extensions.

4.

Click New Announcement-Only Extension. The Add Announcement-Only Extension window
appears.

5.

Enter the Extension Name, Short Extension Number, and Email.

6.

Click Save.
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Editing announcement-only extension details
1.

Click the Phone System tab from the Admin Portal.

2.

Click Groups.

3.

Click Announcement-Only Extensions.

4.

Select an existing announcement-only extension.

5.

Click Announcement-Only Extension Details.

6.

Edit the info for the extension under General:
●

Short Extension Number

●

Extension Name

●

Company Name

●

Contact Phone

●

Email

●

Status

●

Delete Group

7.

Click Save.

8.

Click Settings to edit the following:
●

Regional Settings

●

Site

●

Conﬁrmation Message
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Adding a direct number
1.

Click the Phone System tab from the Admin Portal.

2.

Click Groups.

3.

Click Announcement-Only Extensions.

4.

Select an existing announcement-only extension.

5.

Click Direct Numbers.

6.

Click Add Direct Number.

7.

Select a Location and follow these instructions for the Number Type you choose:
●

Local Number: Provide the State and Area Code. Select one or more numbers and click Add
Numbers.

●

Toll-Free Number: Select a toll-free preﬁx. Select one or more numbers and click Add
Numbers. Note that there’s a $30 one-time setup fee for each number if you select 800 as
your toll-free preﬁx.

●

Vanity: Enter a number that helps customers remember your business phone number. Click
Search to check availability. Select a number and click Add Numbers. Note that there’s a
one-time setup fee for each vanity number you select.

8.

Click Next.

9.

Review the charges (if any) and click the acknowledge box.

10. Click Next.
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Setting an announcement
Customize a greeting for an announcement-only extension.
1.

Click the Phone System tab from the Admin Portal.

2.

Click Groups.

3.

Click Announcement-Only Extensions.

4.

Select an existing announcement-only extension.

5.

Click Announcement.

6.

Click Edit under Announcement Greeting. The Announcement Greeting window will appear.

7.

Choose your preferred type of announcement under Set Greeting:
a.

Default: Select Default to use a system-default announcement. Select the language to
display the default greeting text under View In. Your selection here affects only your
current view of the greeting text, it will not change the greetings language setting.

b.

Custom: Select Custom and select how you’d like to set your custom recording:
●

Phone: Choose a phone number from the dropdown list if you have saved numbers
or select Enter a new number and type a phone number in the ﬁeld for Call me at.
Click the Call Now button, and RingCentral will call you to record your extension
name.

●

Computer Microphone: Click Allow if RingCentral asks to record through your
computer. The Microphone Test and Record settings will appear. When ready, click
the red Record button to record your voicemail greeting. Click the up arrow to
upload your recorded message.

●

Importing: Click Browse and select the WAV or MP3 ﬁle you want to use. Click
Open.

8.

Click Done.

9.

Click Save.
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Limited extensions
Create limited extensions for installation in a common area (meeting room or hotel room) for anyone who
has the need to access basic inbound/outbound calling capabilities.
RingCentral provides the ability to separately purchase limited extensions as unassigned extensions,then
later set up and activate those extensions by assigning them. Bulk purchases of up to 1,000 extensions are
also supported.
A limited extension is an extension with limited features offered at a lower price. Unlike a user extension, a
limited extension is not tied to a speciﬁc user. For more information, visit RingCentral Limited Extension
Overview.
Note: This feature is available on an on-demand basis. Contact RingCentral Support to discuss the
requirements for enabling this feature for your account.

Adding a limited extension
1.

Click the Phone System tab from the Admin Portal.

2.

Click Groups.

3.

Click Limited Extensions.

4.

Click New Limited Extension.

5.

Select a location and click Next.

6.

Enter the quantity, and select the following:
a.

Cost Center

b.

State

c.

Area Code

d.

Number Option

e.

Site (if you have a multi-site account)

f.

Device for use as limited extension

7.

Click Add.

8.

Click Next.

9.

Select your shipping preferences.

10. Click Next.
11. Conﬁrm the order. An order summary is displayed.
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Once the purchase of a limited extension is complete, it will appear in your account with an unassigned
status. You can activate unassigned extensions as needed.
Once assigned, a limited extension can be unassigned or reassigned as needed.
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Assigning a limited extension
1.

Click the Phone System tab from the Admin Portal.

2.

Click Groups.

3.

Click Limited Extensions.

4.

Click a limited extension with Unassigned status.

5.

Fill out the required ﬁelds:

6.

●

Extension Number

●

Extension Name

●

Site

●

Emergency Address

●

Extension Email

●

International Calling

Click Save & Enable. The status for the extension becomes Assigned.
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Editing limited extension info
1.

Click the Phone System tab from the Admin Portal.

2.

Click Groups.

3.

Click Limited Extensions.

4.

Select an existing Limited Extension with Assigned status.

5.

Click Limited Extension Details.

6.

Edit the following under General:
●

Extension Number

●

Extension Name

●

Record Extension Name

●

Company Name

●

Contact Phone
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●

Email

●

International Calling allowed

●

Status

7.

Click Save.

8.

Edit the following under Settings:
●

Regional Settings

●

Template

●

Site (if you have a multi-site account)

●

Conﬁrmation Message
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Recording an extension name
You can use this option to ensure the extension name is pronounced correctly by the system operator. You
can spell out the name the way it sounds to help the operator, or you can record the name in your own voice
and use it for announcements instead.
1.

Click the Phone System tab from the Admin Portal.

2.

Click Groups.

3.

Click Limited Extensions.

4.

Select an existing limited extension.

5.

Click Limited Extension Details.

6.

Click Edit under Record Extension Name.

7.

Select an option under Record by.
a.

RingCentral text-to-speech

b.

Record extension name:
●

Phone: Choose a phone number from the dropdown list if you have saved numbers
or select Enter a new number and type a phone number in the ﬁeld for Call me at.
Click the Call Now button, and RingCentral will call you to record your extension
name. Click Save.

●

Computer Microphone: Click Allow if RingCentral asks to record through your
computer. The Microphone Test and Record settings will appear. When ready, click
the red Record button to record your voicemail greeting. Click Save.

●

Importing: Click Browse and select the WAV or MP3 ﬁle you want to use. Click
Open. Click Save.

8.

Enter a Greeting Name (optional).

9.

Click Save.
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Adding a direct number
1.

Click the Phone System tab from the Admin Portal.

2.

Click Groups.

3.

Click Limited Extensions.

4.

Select an existing limited extension.

5.

Click Phones & Numbers.

6.

Click Add Direct Number. The Add Direct Number window will appear.

7.

Select a Location and follow these instructions for the Number Type you choose:
●

Local Number: Provide the State and Area Code. Select a Cost Center if you have more than
one. Otherwise, it will be preselected. Select one or more numbers and click Add Numbers.

●

Toll-Free Number: Select a toll-free preﬁx. Note that there is a $30 one-time set up fee per
number if you select 800 as your toll-free preﬁx. Select a Cost Center if you have more than
one. Otherwise, it will be preselected. Select one or more numbers and click Add Numbers.

●

Vanity Number: Select a Cost Center if you have more than one. Otherwise, it will be
preselected. Enter a number that helps customers remember your business phone number.
Click Search to check availability. Select a number and click Add Numbers.

8.

Click Next.

9.

Follow the prompts to purchase your new number.
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Setting an announcement and enabling hold music
Customize a greeting for an announcement-only extension.
1.

Click the Phone System tab from the Admin Portal.

2.

Click Groups.

3.

Click Limited Extensions.

4.

Select an existing limited extension.

5.

Click Announcement & Hold Music and then click Edit under Unavailable Greeting. The
Unavailable Greeting window will appear.

6.

Choose your preferred type of announcement under Set Greeting:
a.

Default: Select Default to use a system-default announcement. Select the language to
display the default greeting text under View In. Your selection here affects only your
current view of the greeting text, it will not change the greetings language setting. Click
Done.

b.

Custom: Select Custom and select how you’d like to set your custom recording:
●

Phone: Choose a phone number from the dropdown list if you have saved numbers
or select Enter a new number and type a phone number in the ﬁeld for Call me at.
Click the Call Now button, and RingCentral will call you to record your extension
name. Click Done.

●

Computer Microphone: Click Allow if RingCentral asks to record through your
computer. The Microphone Test and Record settings will appear. When ready, click
the red Record button to record your voicemail greeting. Click the up arrow to
upload your recorded message. Click Done.

●

Importing: Click Browse and select the WAV or MP3 ﬁle you want to use. Click
Open. Click Done.

7.

Ensure there is a check for Enable under Hold Music if you want callers to hear music whenever you
put the call on hold. If hold music is enabled, click Edit to set your hold music. The Hold Music
window will appear.

8.

Choose your preferred type of audio under Set Audio:
a.

Ring Tones: Select Ring Tones if you want your callers to hear ring tones while the call is being
connected.

b.

Music: Select Music if you want callers to hear music. Select the type of music under Select
Music.

c.

Custom: Select Custom to upload your own audio ﬁle. Click Browse and select the WAV or
MP3 ﬁle you want to use. Click Open.

9.

Click Done.

10. Click Save.
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Setting outbound caller ID
Select the phone number you want to display as caller ID for outgoing calls.
1.

Click the Phone System tab from the Admin Portal.

2.

Click Groups.

3.

Click Limited Extensions.

4.

Select an existing limited extension.

5.

Click Outbound Caller ID.

6.

Click Edit under Existing Phone. The Select Number window will appear.

7.

Select the number you want to use as your outbound caller ID. Click Done.

8.

Click Edit under Alternate Caller ID if you prefer to set this option. The Select Number window will
appear.

9.

Select the number you want to use as your alternate caller ID. Click Done.

10. Check the box for Display my extension number for internal calls if you want to display your
extension as your caller ID when making internal calls.
11. Click Save.
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Phones and Devices
This section provides you a view of all phones that are associated with your RingCentral MVP account. You
can also add phones and devices, change a phone, and reassign a phone from this section,

Viewing and editing devices
1.

Click the Phone System tab from the Admin Portal.

2.

Click Phones & Devices.

3.

Click on the following tabs to see the following:
a. User Phones
b. Common Area Phones
c.

Paging Devices

d. Shared Lines
e. Unassigned
4.

Click on a device to view and edit details.
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Searching devices
You can search or ﬁlter the phones or devices by specifying search text, status, or device, and selecting the
search icon. The search displays results for devices meeting the search criteria in the device category.

Adding a device
You can add a phone or device by clicking Add Device in the upper right. See the next pages for more
detailed instructions.

Adding a user phone
1.

Click the Phone System tab from the Admin Portal.

2.

Click Phones & Devices.

3.

Click User Phones.

4.

Click Add Device.

5.

Select a Location.
●

Domestic

●

International

6.

Click Next.

7.

Select a user to assign the phone to.

8.

Select a device to buy.

Note: You can only add devices for one country at a time. Repeat the process for different countries as
needed.
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9.

Assign an existing or a new number to the device and click Next.

10. Add an emergency address and click Next.
11. Select your shipping preferences and click Next.
12. Conﬁrm your order by checking the acknowledgment box. Click Next.
Note: When adding international phones, you will also need to register an emergency address in the
selected country for your phone. Review these details when conﬁrming your order.
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Adding a common area phone
A common area or hot desk phone provides hot desking, and enables any employee to log in to a shared
phone that adopts the user’s phone settings
1.

Click the Phone System tab from the Admin Portal.

2.

Click Phones & Devices.

3.

Click Common Area Phones.

4.

Click Add Device.

5.

On the Add Hot Desk Phones window, enter the quantity and select a device. Click Add,
and then Next.

6.

Add an emergency address. Click Next.

7.

Select your shipping preferences and click Next.

8.

Conﬁrm your order by checking the acknowledgment box. Click Next.
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Adding a paging device
A paging device is a wall-mounted speaker or ampliﬁer that enables overhead paging. Follow the steps below
to add a paging device:
1.

Click the Phone System tab from the Admin Portal.

2.

Click Phones & Devices.

3.

Click Paging Devices.

4.

Click Add Device.

5.

Enter a name for the paging device.

6.

Click Next.

7.

View the provisioning information for the device.

8.

Click Done to add the paging device to your system.
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Changing a phone
To change the phone of a user:
1.

Click the Phone System tab from the Admin Portal.

2.

Click Phones & Devices.

3.

Locate the phone that you want to replace.

4.

Click Change Phone from the more menu.

5.

Select from the following options:
a.

Order a new phone from RingCentral: We will ship you a new desktop IP desk phone if you
select this option. These phones are pre-conﬁgured and should be automatically
provisioned once connected to the internet.

b.

Existing RingCentral phone: Select this option if you already have a desktop IP phone
purchased from RingCentral but not currently in use. You can also swap phones with
another user. A reboot is needed if you exchange phones with another user. Provisioning is
required if you select a phone not presently in use. For more information, visit Intro to
deskphones provisioning.

c.

Phone not purchased from RingCentral: Select this option if you own a SIP phone not
purchased from RingCentral. Provisioning is required after assigning these phones to a
user. For more information, visit Intro to deskphones provisioning.

d.

RingCentral Phone app: Select this option if you prefer to use RingCentral’s desktop
application for taking your calls. You can download the RingCentral app from the
RingCentral Downloads page.

Reassigning a phone
To reassign a phone to another user:
1.

Click the Phone System tab from the Admin Portal.

2.

Click Phones & Devices.

3.

Locate the phone that you want to replace.

4.

Click Reassign to from the more menu.

5.

Select the user where you want to reassign the phone, then click Next.

6.

You will be prompted with a warning message, click Yes to proceed.
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Viewing shared lines
1.

Click the Phone System tab from the Admin Portal.

2.

Click Phones & Devices.

3.

Click Shared Lines. The group assigned to a particular Shared Line and the Phones Assigned to that
shared line are listed.

4.

Filter numbers by search term or device.

5.

The Shared Line and Phones Assigned are shown here. If you have made any changes, click Apply.

Adding an unassigned phone
An unassigned phone is an IP phone in your account that is not yet activated or assigned to a user. Use the
following steps:
1.

Click the Phone System tab from the Admin Portal.

2.

Click Phones & Devices.

3.

Click Unassigned.

4.

Click Add Device.

5.

Select a Location.
a.

Domestic

b.

International

6.

Click Next.

7.

Select a device.

8.

Click Next.
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9.

Select your shipping preferences and click Next.

10. Conﬁrm your order by checking the acknowledgment box and click Next.
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Enabling video calls
You can enable video on internal point-to-point calls in your RingCentral MVP account. Supported devices
include the Polycom VVX 501/500 and 601/600 (supporting detachable cameras for video calling).
Phones with video support include video codecs with audio for all outbound calls. No new ﬁrmware is
required for the Polycom phones to enable video.
This feature is available as a on-demand feature for Premium and Ultimate tiers. Contact support to ask
about this feature.
To enable video:
1.

Click the Phone System tab from the Admin Portal.

2.

Click Phones & Devices, then click User Phones.

3.

Select a supported phone.

4.

Check the box next to Enable Video Calling.

5.

Click Save.

Note: You can enable video calling for multiple devices by multi-selecting the Polycom devices in the list and
enabling video calling in bulk.
The phone will be resynchronized to make and receive video calls with similarly conﬁgured devices within
your RingCentral MVP account.

Redundant audio (RED) codec for calls
A codec deﬁnes how your voice and video is compressed into packets that are sent over the Internet. There
are many types of codecs designed for different environments and network conditions (e.g. wiﬁ vs cellular,
good vs weak connection, low vs high packet loss). A RED codec adds duplicate voice and video information
to the packets sent over the Internet which helps maintain call quality during poor network conditions.
The Redundant Audio Codec is supported on RC App Desktop & RC App Mobile clients, version 22.4.10 or
later.
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Common area phones
Hot desking or common area phone enables any employee to log in to a hot desk phone that adopts the
user’s phone settings. Employees who travel from different ofﬁces can share the same hot desk phone and
desk while keeping their own extension proﬁles and voicemail access.

Types of hot desk phones
The following conﬁgurations of hot desk phones that support access to hot desking are available to support
your business needs:
●

Hot desk (common) phone: An employee visiting from a different ofﬁce can log in to a hot desk
phone and use it as their own, accessing their own extensions, proﬁles, voicemail, and other phone
features. Hot desk phones do not provide any telephony support unless the guest user activates
them by entering their credentials (except for making emergency calls).

●

Hot desking for limited extension: Limited extensions are installed in common areas (meeting
rooms or in hotel rooms) for anyone who has the need to access basic inbound/outbound calling
capabilities. With Hot Desking for Limited Extension, a visiting employee can log in to a limited
extension phone and use it as their own with access to full telephony features. Hot desking enables
ﬁeld sales and remote employees to work in a variety of spaces when visiting different ofﬁces and
the fact that this feature is available on limited extension phones ensures that the hardware still
provides functional value for on-site employees in all other cases.

Phone support and setup
You can either purchase a new phone that supports Hot Desking, or convert an existing unassigned Polycom
VVX phone to a hot desk phone. Supported phone models are the Polycom VVX 310, 311, 410, 411, 500,
501, and 601.

Using hot desking for limited extension
Calls are routed to a Hot Desking for Limited Extension phone as follows:
●

Calls to the Guest User: the limited extension device is added to the forwarding rules of User
Business Hours and After Hours (if it has forwarding rule). Calls are routed to a Limited Extension
device based on the active answering rule of the guest user.

●

Calls to Limited Extension are still routed to its device: Extension, DID, or DL number, and paging
calls. However, calls to the phone number of the Limited Extension DL follow the guest answering
rules.

After logging out through the logout soft key on the physical phone device, the phone resumes operation as
a limited extension device.
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Note: This option is available for MVP Premium and Ultimate only.

Enabling a limited extension phone for hot desking
To enable a visiting employee to log in to a limited extension phone and use it as their own with access to full
telephony features:
1.

Click the Phone System tab from the Admin Portal.

2.

Click Phones & Devices.

3.

Click Common Area Phones.

4.

Select a Limited Extension to view the device details.

5.

Click the checkbox for Use as Hot Desk Phone.

6.

Click Save.

Note: On the Phone & Devices page, the device type is now identiﬁed as Limited Ext + Hot Desk.
A login softkey is provisioned on the device. Once a guest user is logged in, the device details page displays
the guest user name.

Converting an unassigned phone to a hot desk phone
Converting an unassigned phone to a hot desk phone makes that phone only available for use in hot desking.
No minutes are included for any type of calls.
To convert an unassigned phone to a hot desk phone:
1.

Click the Phone System tab from the Admin Portal.

2.

Click Phones & Devices.

3.

Click Unassigned. Select an unassigned phone.

4.

Under Phone Details, select Convert to Common Phone.

5.

Follow the instructions to complete the conversion.
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Unassigning a hot desk phone
You can unassign a hot desk phone to remove it from hot desking use, and return it to the list of unassigned
devices. To unassign a hot desk phone:
1.

Click the Phone System tab from the Admin Portal.

2.

Click Phones & Devices.

3.

Click Common Area Phones.

4.

Select a hot desk phone.

5.

Under Phone Details, select Unassign Phone The phone is returned to Unassigned phones.

Logging out a hot desk phone
You can log out the currently logged in user from the hot desk phone. To log out a hot desk phone:
1.

Click the Phone System tab from the Admin Portal.

2.

Click Phones & Devices.

3.

Click Common Area Phones.

4.

Select one or more hot desk phones.

5.

Click Logout.

The currently logged in users are logged out from the selected phones.
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Setting the hot desking session timeout
The hot desking session timeout speciﬁes the time period when guest users will be logged out from phone
endpoints. The default session timeout is 12 hours.
Certain enterprises with a mobile workforce may use the ‘Never’ value for the timeout to conﬁgure that all
hot desk sessions in the account will not timeout. When using this option, the hot desk session can only be
logged out by a user from the phone.
To set session timeout for all hot desk phones on the system:
1.

Click the More tab from the Admin Portal.

2.

Select Security and Compliance.

3.

Select Hot Desk Session Timeout.

4.

Select the duration from the list provided. To conﬁgure no timeouts, select the Never value.

5.

Click Save.
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Assisted provisioning
You can provision supported third-party devices with your service. Follow these steps:
1.

Click the Phone System tab from the Admin Portal.

2.

Click Phones & Devices.

3.

Click User Phones.

4.

Select the device that needs to be provisioned.

5.

Click Setup and Provision.

6.

Select your phone model. If you have selected:
●

Avaya IP Phone: Select the phone model, provide the phone’s MAC Address and click Next.
Proceed with the steps described in the wizard.

●

Cisco/Linksys IP Devices: Select the phone model from the menu. Provide the phone’s IP
address and click Next. Proceed with the steps described in the wizard.

●

Polycom IP Phones: Select the phone model from the menu. Provide the phone’s MAC
address and click Next. Proceed with the steps described in the wizard.

●

Yealink IP Phone: Select the phone model from the menu. Provide the phone’s MAC
address and click Next. Proceed with the steps described in the wizard.

●

Other Phones: Click Select. The next window displays the SIP Conﬁguration or information
needed for manual provisioning. Contact your manufacturer to know how to conﬁgure your
phone using these conﬁgurations.
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Automatic Location Updates
RingCentral MVP supports automatic location detection of certain devices and apps. This allows the most
current location to be made available when a user dials 911 from these endpoints. Location detection is
based on the application or device’s interaction with network infrastructure elements with known locations,
such as WiFi access points, IP address ranges, and/or Ethernet switch MAC addresses.
Note: This feature is currently in controlled release. Contact your RingCentral account manager to have this
feature enabled for your account.
Current support covers the following endpoints:
●
●

RingCentral app for desktop
Polycom VVX x50 hard phones

Setting up emergency response location
Emergency Response locations (ERLs) represent the business locations where end users will be using their
RingCentral service to make phone calls. The scope of an ERL depends on physical/geographic coverage
needs. It should be deﬁned to assist emergency responders in locating a 911 caller in a reasonable amount of
time.
Typical examples include:
●
●
●

SOHO customer : Single ERL referring to a single address.
SMB customer : Single ERL referring to a single address and possible a suite # in an ofﬁce building.
Enterprise customer: Multiple ERLs referring to buildings on a campus, buildings in different
geographic locations, possibly one ERL per ﬂoor in a multi-story ofﬁce park.

1.

From the Admin Portal, navigate to Phone System > Emergency Calling > Emergency Response
Locations.
Toggle the Enable Emergency Response Locations switch on to enable the feature.
Important note: This enables the use of emergency response location for your account. This action
is not reversible.
Click + Add Emergency Response Location.
Enter a Nickname for the emergency response location.
Click Edit under Emergency Address.
Fill up the address information, then click Done.
Click Add.
Note: You can also check Private Location to make the private emergency response location visible
only to the selected owner.

2.

3.
4.
5.
6.
7.
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Automatic location updates for RingCentral app for desktop
The location detection for the RingCentral app for desktop is based on the app’s interaction with network
infrastructure elements with known locations, such as WiFi access points and/or IP address ranges.
The RingCentral app for desktop dynamically detects and reports changes in WiFi BSSID or IP address. It
looks up the location and then updates the emergency location for the app.
Note that only the desktop version of the RingCentral app supports Nomadic 911. The web version doesn’t
support it.

Automatic location updates for compatible desk phones
Prerequisites:
●

Polycom VVX x50 Desk Phone/s (VVX 150, 250, 350, or 450)

●

Hardwired ethernet connection (WiFi connected Desk Phones are not supported)

●

Managed ethernet switch/es (LLDP enabled)

RingCentral account admin deﬁnes a network map in the Admin Portal to specify on-net locations by IP
Address ranges with corresponding physical address/es or Chassis IDs of ethernet switches with
corresponding physical address/es. If location lookup is successful, the emergency address is automatically
updated upon restart.
Note: If location lookup is unsuccessful, the phone is deemed as Off-Net and a notiﬁcation is sent to the
admin allowing them to deal with the situation. Phones in Off-Net status will enter a restricted calling state:
No PSTN calling, only calls within account.
Before enabling the Automatic Location Updates, you must add your ethernet switches to the Switch Map
or add your IP addresses to the IP Address Range Map.

Enabling automatic location updates of compatible desk phones
1.

From the Admin Portal, navigate to Phone System > Emergency Calling > Automatic Location
Updates.

2.

Click Status > Automatic Location Updates for Compatible Desk Phones.

3.

Turn on the toggle switch for Enable Automatic Location Updates for Compatible Desk Phones.

4.

Tick the checkbox for Accept legal disclaimers, then click Conﬁrm.
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Setting up the network infrastructure with known locations
Location detection is based on the application or device’s interaction with network infrastructure elements
with known locations, such as WiFi access points, IP address ranges, and/or Ethernet switch MAC addresses.

Adding wireless access point to the wireless access point map
1.

From the Admin Portal, navigate to Phone System > Emergency Calling > Automatic Location
Updates.

2.

Click Wireless Access Point Map.

3.

Click + Access Point.

4.

Enter the BSSID (Mac address of the wireless access point) and Nickname of the Wireless Access
Point.
Note: BSSID is not the same as the SSID of the access point.

5.

Select an Emergency Response Location, then click Save.

Adding an IP address range to the IP address range map
1.

From the Admin Portal, navigate to Phone System > Emergency Calling > Automatic Location
Updates.

2.

Click IP Address Range Map.

3.

Click + Add Network.

4.

Enter the Network Name and select the Site (for multi-site accounts).

5.

Click + Add in the Public IP Address(es) section.

6.

Select Single or Range, then enter the IP address or IP address range, and then click Save.

7.

Click + Add in the Private IP Addresses section.

8.

Select Single or Range, then enter the IP address or IP address range.

9.

Enter a Nickname and select an Emergency Response Location, then click Save.

10. Click Save.
Note: IP address ranges need to be speciﬁed as the combination of public IP address and all private IP
ranges. For example: your devices are in the following private network range : 192.169.10.0 192.168.10.255. You also have two IP addresses from your Internet Service Provider. To deﬁne this network
you would add the network, add two single IP addresses as public IP addresses as well as one private IP
address range using the steps described above.

Adding an ethernet switch to switch map
1.

From the Admin Portal, navigate to Phone System > Emergency Calling > Automatic Location
Updates.

2.

Click Switch Map.

3.

Click + Add Switch.

RingCentral MVP | Admin Guide | Automatic Location Updates
246
4.

Enter the Chassis ID and Nickname of the ethernet switch. In many cases, the Chassis ID will be the
MAC address of the switch.

5.

Select an Emergency Response Location, then click Save.

Selecting a User extension to be treated as nomadic
After enabling the Automatic Location Updates, you can select a User Extension to be treated as nomadic.
1.

From the Admin Portal, navigate to Phone System > Emergency Calling > Automatic Location
Updates.

2.

Click Extensions.

3.

Select the User extension to be treated as nomadic by clicking Activate at the top of the Status
column. To remove a User Extension, select the extension, then click Deactivate at the top of the
Name column.
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Meetings
The Meetings tab is where you can see information and conﬁgure the settings related to your meetings.
Here, you can see the following tabs:
●

Recording Management

●

Rooms

●

Meetings Settings

●

Downloads

Accessing and managing Rooms
When you have purchased a RingCentral Rooms License and set up the hardware for your RingCentral
Rooms system, you can access and manage it on your online account.
1.

Click the Meetings tab from the Admin Portal.

2.

Click Rooms. You can view the following tabs:
●

Rooms List: This menu lets you view the list of all Devices and Rooms in the account. It also
allows you to modify the Global Settings, add or edit Locations and Rooms, upgrade all
Devices, and export rooms.

●

Calendars: This tab allows you to add Calendar Services (Google Calendar, Ofﬁce 365,
Exchange) that can be integrated with RingCentral Rooms. It also lets you authorize or
deauthorize, sync, and delete calendars.

RingCentral MVP | Admin Guide | Meetings
248

Managing Meetings settings
RingCentral Video allows admins and users to conveniently control the features with a user-friendly
settings interface that is available on the RingCentral online account. Account admins have the capability to
enable and disable RingCentral Video features that will be applied for all RingCentral Video users on the
account.
1.

Click the Meetings tab from the Admin Portal.

2.

Click Meetings Settings.

3.

Admins can enable and disable RingCentral Video features on their account. The following sections
are available:
a. Security
b.

Basic

c.

Recordings

d. Email Notiﬁcations
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Call log reports
The Call Log reports on inbound and outbound calls and faxes for the company number and speciﬁed
extensions. The Call Log is available as a Simple view, which concisely summarizes the calls, and as a
Detailed view, which shows additional call record details.
You can ﬁlter the call log records by number, time period, call direction or type of call (inbound or outbound).
Select your ﬁlter criteria, and click Apply to refresh the log. In Delivery Settings, you can set delivery of the
call log to an email address on a daily, weekly, or monthly basis, on a speciﬁed day.
In the Type column you can see the types of calls. In the Recording column, you will see an icon if the call has
been recorded. Click the play icon to hear a recording.
To access the call log:
1.

Click the Reports tab from the Admin Portal.

2.

Click Call Log.
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Downloading call log and recorded calls
You can download the Call Log in .csv format and the recorded calls in mp3 format from the Call Log page.
The downloaded ﬁle will only contain the details of the ﬁlter you have selected.
Downloading the Call Log and recorded calls may take some time and may possibly time out. The
Background Call Log feature makes it possible to avoid your downloads from timing out and lets you work in
the background or switch to another page on your RingCentral Online account. Contact Support or your
Account Manager to have the Background Call Log feature enabled.
To download your call log and recorded calls:
1.

Click the Reports tab from the Admin Portal.

2.

Click Call log.

3.

Click the Type of View: Simple or Detailed.

4.

Filter the information that you wish to include in the Call Log Report.

5.

Click More to select other information ﬁlters.

6.

Click Apply.

7.

Click Download.

8.

Call Log (csv) is selected by default. Select what needs to be downloaded: Call Log or Recorded
Calls or both. If you select Recorded Calls (mp3), all call recordings will be downloaded. Click
Download to save the ﬁle on your computer.

Note: If the Background Call Log feature is disabled, you will not be able to exit from the current window
until the download gets completed. If the Backlog Call Log feature is enabled, a pop-up window will advise
that your download has started and may take a while depending on the size of the ﬁle and internet
connection. Click OK to close it.
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Analytics
The Analytics Portal lets you access reports such as Adoption & Usage, Performance, Company Numbers,
Device Status, Live Reports, Meetings Dashboard, and Quality of Service. It also lets you view existing
Historical Reports under the Subscriptions tab.
To access the Analytics Portal:
1.

Click the Reports tab from the Admin Portal.

2.

Click Analytics.

3.

If it is your ﬁrst time logging in, you will be asked to authorize the Analytics Portal to sign in with
your RingCentral credentials. Click Authorize.

4.

The Analytics Portal contains the follow tabs:
●

Adoption & Usage

●

Company Numbers

●

Meetings Dashboard

●

Performance Reports

●

Quality of Service

●

Rooms & Devices

●

Alerts

●

Subscriptions
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Adoptions and usage
Adoption & Usage (A&U) Analytics gives visibility into usage and adoption patterns of the RingCentral
products across your organization. You can gain intelligent insights on the following:
●

if, and how, RingCentral products are being used (at the organizational level or across sites and
departments)

●

determining the power users

●

trends and patterns of usage

●

who are the low users/non-users

●

which locations/departments could beneﬁt from a training session

●

user preferences such as preferred devices

●

most used endpoints, etc.

To access:
1.

Click the Reports tab from the Admin Portal.

2.

Click Analytics to open the Analytics portal on another page.

3.

The Adoption & Usage tab is the landing page of the Analytics Portal.

From the Adoption & Usage tab, you can select to view the following tabs:
●

Overview: Dashboard showing all Message, Video, and Phone metrics

●

Message: RingCentral app

●

Video: RingCentral Video analytics

●

Phone: RingCentral Telephony/PBX
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Company numbers reports
The Analytics Portal can generate a report using Company Numbers. There are also a number of Key
Performance Indicators (KPIs) available for this report.
Company Numbers KPIs include the following:
●

The number or percentage of all inbound calls answered on a company number

●

The number or percentage of all calls to a company number in which a Voicemail was left

●

The number or percentage of all calls that were missed (includes voicemail)

●

The total amount of handle time the user spent on the calls on a company number. Handle time is all
live talk time and all hold time

●

The average duration of a company number call, from answered until terminated. This includes live
talking plus time on hold

●

The number of calls placed on hold for the numbers selected, the average hold time, or the number
of abandoned calls put on hold

●

The number of calls transferred, parked (or answered from park), total park time and the number of
calls abandoned while the caller was put on park

To access Company Numbers:
1.

Click the Reports tab from the Admin Portal.

2.

Click Analytics.

3.

Click the Company Numbers tab.
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Performance reports
The RingCentral Performance Reports tab is an additional tool that enables you to research call records to
determine your business unit performance. By using Key Performance Indicators (KPI) as well as targeted
ﬁlters, Performance Reports assists you in combining user, queue, and call activity to evaluate performance.
Performance Reports offer the following features and beneﬁts:
●

Dozens of available KPIs for a deeper understanding of performance

●

New modern interface, with extremely fast performance

●

Targeted ﬁlters available for all reports providing better investigation

●

Highly customizable reports to individualize reporting experience

●

Enhanced capabilities to better match customer behaviors

The Performance Reports page contains the follow tabs:
●

Queues: Call queue performance for the call segment that is relevant to each queue
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●

Users: User performance in the context of inbound and outbound calls for the call segment that is
relevant to each user. If User Groups are in use (Ultimate and Premium plans), only users from
queues and deﬁned user groups are available for monitoring

●

Calls: Lists the breakdown of the call records with basic metadata

To access Performance Reports:
1.

Click the Reports tab from the Admin Portal.

2.

Click Analytics Portal.

3.

Click Performance Reports.
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Quality of Service reports
The Quality of Service reports provide near real-time information on the global health of the account and
RingCentral Video and allows for proactive monitoring and reactive troubleshooting of potential issues. It
gives you the ability to anticipate and diagnose call quality issues impacting your users globally before they
escalate to critical problems.
To access Quality of Service reports:
1.

Click the Reports tab from the Admin Portal.

2.

Click Analytics.

3.

Click Quality of Service.

The Quality of Service page contains the following tabs:
●

●

Overview: This tab enables you to:
○

Monitor overall account level quality proactively.

○

Monitor audio stream quality on top Geo locations.

○

Monitor patterns of audio quality for top ISPs and Endpoints.

○

Understand the impact of meeting stream volume on quality.

○

Filter quality information with different dimensions.

Extensions: The Extensions tab features QoS analysis by user name or extension. It displays the
aggregate data for an individual user, allowing for a much deeper analysis of the call and
RingCentral Video meeting quality by leveraging user-speciﬁc graphs and trends.

●

Calls: The Calls tab lets you view call quality data at a per call level so that you can identify speciﬁc
quality issues.

●

MOS Performance: The Mean Opinion Score (MOS) Performance dashboard provides an overview
of call quality levels based on the minimum and target MOS thresholds for the previous month.

●

Meetings: This enables you to:
○

Reactively troubleshoot when their employees report issues with their meetings.

○

List down a record of all meetings held within the selected timeframe.

○

Filter by various dimensions to be able to narrow down the list of records.
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Rooms and Devices reports
The Rooms & Devices report provides admins the ability to proactively monitor the global health of the
company’s RingCentral Rooms and hard-phone infrastructure. The report can be used to identify issues
impacting users regarding service availability of Rooms and hard-phones.
The rooms part of this report provides an overview of the rooms' conditions over time, providing the trends
and patterns of the devices. It provides data about the rooms' location, health, and status. It also gives
information about the Host and Controller's model, operating system, app version, and status.
The Rooms & Devices page contains the following tabs:
●

Overview: Provides the admins with visibility into the current state of RingCentral Rooms and
hard-phones globally.

●

Rooms: Lets you ﬁlter data by name, location, date range, room health, room status, ISP, Host’s app
version, and Controller’s app version. This section is divided into 2 parts, Health Trend and Rooms
list.

●

Devices: Provides a list of ofﬂine devices with detailed information now and in relation to a historic
(within the last 7 days) time period, to allow users to see the ofﬂine devices overtime

●

Unprovisioned Devices: Devices that were recorded in the RingCentral system, but have never
been set up.

To access Rooms & Devices:
1.

Click the Reports tab from the Admin Portal.

2.

Click Analytics.

3.

Click Rooms & Devices.

Creating analytics alerts
The RingCentral Analytics Portal allows you to create alerts based on your analytics data.
To create an alert, follow these steps:
1.

Click the Reports tab from the Admin Portal.

2.

Click Analytics.

3.

Click Alerts.

4.

Click Alerts List, then click Create New. For ﬁrst time setup, click Create New in the middle.

5.

Conﬁgure the parameters of your alert.
a. General Information: Enter the Alert Name and Alert Severity.
b. Alert Trigger: You can set your Target, Target Value, Trigger, Condition, Threshold,
Monitoring Timeframe, and Alert Frequency.
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c. Advanced Options: Monitor your speciﬁc endpoints, day of the week, time of the day, or
over a minimum call leg volume.
d. Delivery Channel: You have a choice to receive your alert notiﬁcations via email or
RingCentral app.
e. Edit Settings: Alert owner can restrict access to an alert to View only (locked alert) or
Edit (unlocked alert).
6.

Click Create Alert.
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Creating report subscriptions
Subscriptions provide a way for you to automatically generate reports and send them via email to recipients.
For example, if you would like a report generated that shows the number of calls that were abandoned while
the caller was put on hold, you can do so with a subscription setting for a Queue Report.
To make use of the Subscription feature, you must ﬁrst save a generated report. After that, you can use the
Subscription page to send the report via email.
To save a report for the example given above:
1.

Click the Reports tab from the Admin Portal.

2.

Click Analytics.

3.

Click Performance Reports, then select Queues.

4.

Click Select KPIs.

5.

Tick the box for # Abandon (Hold)

6.

Click Done.

7.

Click Save in the upper right.

8.

Enter a report name.

9.

Click Save.

To create a subscription:
1.

Click the Reports tab from the Admin Portal.

2.

Click Analytics.

3.

Click Subscriptions.

4.

Click Create Subscription.

5.

Under General Information, enter the subscription name. Click the dropdown menu for Report
Type and select (from the example above) Performance Report. Click the dropdown for Report and
select the name of the report you saved. Note that only reports you have generated are available to
you in this list.

6.

Select the tabs.

7.

Select the Email Delivery Schedule.

8.

Select the File Type to be generated.

9.

Enter the email address for the recipient of the report in the Email the report to ﬁeld. You can
specify more than one email address by clicking the plus sign (+) and adding other email addresses.

10. Click Create Subscription.
Subscriptions should be created on reports that have preset date-time windows such as yesterday, last
week, last month, etc., in Performance Reports. Saving a report with a custom date range with speciﬁc dates
will result in the recipient receiving the same report repeatedly. The user who created the Subscription
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Report has exclusive permissions to see, edit, and delete the subscription. No other user will have access to
the subscription.
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Billing
The Billing tab leads to menus for managing your Usage, Calling Rates, Meetings (including licenses), and
Device Orders. View and edit your service plan, payment information, international calling plans, and cost
center codes here.
If enabled for your account through RingCentral support, you will also see a Professional Services menu item
in the Billing tab.
Note: Billing is an administrator function only. This option is not available to standard users.

Overview page
The Overview page of the Billing tab contains information about your service plan, additional services, and
payment information. This is the landing page of the Billing tab.
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Managing your service plan
Viewing/changing service plan
1.

Click the Billing tab from the Admin Portal.

2.

On the Overview tab, the service plan is under Your Plan.

3.

Click Change to open the Upgrade Subscription window.

4.

Click here to open the RingCentral Plans and pricing page. To proceed with changing your Service
Plan, contact RingCentral Support.
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Canceling your service plan
1.

Click the Billing tab from the Admin Portal.

2.

Under Your Plan, click Cancel.

3.

Follow the instructions on the Cancel Service Plan window.

4.

Click Close.
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Using auto purchase
The Auto Purchase feature ensures you will never run out of calling credits. The selected package will be
automatically purchased when you are running low on calling credits, which prevents any potential
interruption of service. Purchased funds will roll over month-to-month for up to 12 months.
To view and select options for auto-purchase:
1.

Click the Billing tab from the Admin Portal.

2.

Click Change under Auto-Purchase.

3.

Select the Calling Credits Package you wish to purchase.

4.

Click Save.
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Viewing your Service Billing Detail
The Service Billing Detail tab contains information about your next billing date, service name, discounts, and
charges.
1.

Click the Billing tab from the Admin Portal.

2.

Select Service Billing Detail.
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Viewing your Billing History
Billing History contains a list of your billing transactions and billing statements.
To view your billing history:
1.

Click the Billing tab from the Admin Portal.

2.

Click Billing History.

Click View at the far right to view and print your billing statement for the speciﬁed month
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Managing payment methods
The Payment Method contains the credit card information attached to the RingCentral account. You can
change your organization's credit card information or payment method via your RingCentral online account.
You can also add a backup credit card.
1.

Click the Billing tab from the Admin Portal.

2.

Click Payment Method.

3.

View your Payment Information and Billing Address.

4.

Click Edit.

5.

Edit your card details and billing address.

6.

Click Save.
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Updating your credit card information
As an admin, you can update or edit the credit card that’s linked to your RingCentral account.
RingCentral accepts the following payment methods: Visa, MasterCard, AmericanExpress, and Discover. In
the EU and UK, you can pay with direct debit.
To choose your payment method:
1.

Sign in to the Admin Portal.

2.

Go to Billing > Payment Method.

3.

At the top right, click Update to edit your card’s information.

4.

If you have two or more cards linked, select the tab for the card you want to update, then click Edit.

5.

Enter your card details and billing address.

6.

Click Save.

Removing a credit card
As an admin, you can delete credit cards that are linked to your RingCentral account. You can only do this if
you’ve linked two or more cards to your account.
1.

Sign in to the Admin Portal.

2.

Go to Billing > Payment Method.

3.

Select the tab of the card that you want to delete.

4.

Click Remove.

Adding a backup credit card
Credit card charges can sometimes be denied because of issues with expiration dates, fraud, or other
matters. Setting up a secondary credit card will prevent your account from being suspended in case your
primary card is compromised.
1.

Sign in to the Admin Portal.

2.

Go to Billing > Payment Method.

3.

At the top right, click Add Backup Payment Method.

4.

Enter your payment information and billing address.

5.

Under To be used for, select either All charges or Only recurring and calling credit charges.

6.

Check the box to authorize the charges, then click Save.
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Adding an alternate payment method
You can also add an alternate payment method, such as direct debit, to your RingCentral account.
Note: If you’d like to pay with direct debit but don’t see that option in your online account, contact
RingCentral Support.
1.

Sign in to the Admin Portal.

2.

Go to Billing > Payment Method.

3.

At the top right, click Add Alternate Payment Method.

4.

Select Direct Debit.

5.

Enter your payment information and billing address.

6.

Check the box to authorize the charges, then click Save.
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Licenses & Inventory
The Licenses & Inventory tab provides an overview of licenses and devices on your account in one place. You
can ﬁlter by product category, cost center, and site.
To access Licenses & Inventory:
1.

Click the Billing tab from the Admin Portal.

2.

Click Licenses & Inventory to display a list that shows Product Name, Total, In-Use, Available, and
Actions.

3.

In the Actions column, click the dropdown arrow to show additional details.
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Managing licenses
You can view, upgrade, downgrade, download, and delete licenses and devices of users in your company’s
RingCentral account.
To view your users’ active licenses:
1.

Click the Users tab from the Admin Portal.

2.

Click Users with Extensions.

3.

Hover on the user you want to manage then select the license under the Licenses column.

4.

This will open the license details, including the License name and quantity.

To update your users’ licenses:
1.

Click the Users tab from the Admin Portal.

2.

Click Users with Extensions.

3.

Hover on the user you want to manage, then click the more button at far right.

4.

Click Edit licenses and select the license you want for the user. You can also select Add-on licenses if
applicable to the license you are selecting.
Note: You can only upgrade a user to an available license in your inventory. If you don’t have
available licenses, you will need to purchase a new license.

5.

Click Update.

Note: The license of a downgraded user will be placed in the license inventory for future use.
To download licenses from inventory:
1.

Sign in to the RingCentral Admin Portal.

2.

Go to Billing > Licenses & Inventory.

3.

Click Download Licenses.
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4.

Check the box next to the name of the license(s) you want to download.
a.

You can click the Product Category dropdown to select or search for license types.

5.

Click Select.

6.

Enter the email address where you want to send the license.
Note: The email may take up to 15 minutes to arrive, depending on the size of your account.

7.

Click Send.
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To delete additional local numbers or additional toll-free numbers:
1.

Go to Billing > Service Billing Detail.

2.

Look for Additional Local Numbers or Additional Toll-Free Numbers, then click the More menu
icon under Actions.

3.

Click Delete.

4.

Select the license that you need to delete, then click Next. (Note: Only unassigned licenses can be
deleted.)

5.

Specify how many licenses you want to delete, then click Next.

6.

Review selected licenses, then click Delete.

7.

If you have reserved numbers in inventory, you may be asked to delete extra numbers (optional).

8.

Check if your billing details has changed. (You may be prompted to accept a billing pre-statement if,
for example, the removal of one or more licenses causes a credit return on an annual account.)

Viewing your usage
The Usage tab includes your total used plan minutes for the current billing cycle, SMS log, mobile users,
available included credits for your account, international calling credits, and purchased calling credits.
To view your Usage:
1.

Click the Billing tab from the Admin Portal.

2.

Click Usage.

3.

Under General Usage, the Current Plan Usage shows how many minutes you have used on your
account’s Unlimited Usage.

4.

Click View Log for Paid SMS Usage to ﬁlter and display the SMS logs of the account.

5.

Calling Credits shows the remaining minutes on your account. The number of minutes depends on
the type of plan you have.

6.

Click View Rates on Purchased Calling Credits to show the available purchased calling credits on
your account.
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Downloading the SMS log
You can download a SMS log that is complete and accurate to better manage company resources.
1.

Go to Billing > Usage.

2.

Select View Logs next to Included SMS Usage.

3.

Click Download.

4.

Filter entries by your speciﬁed date (ex. 30 days).

5.

Click Download.

6.

Click OK.
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Viewing mobile user history
A virtual extension is a user extension without an assigned digital line. Virtual extensions forward incoming
calls to mobile phones, extensions, or other external numbers and allow for limited outbound dialing. It
becomes a Mobile User extension if it makes or receives ten or more calls in a given month (billing cycle).

To view the mobile users in your account:
1.

Click the Billing tab from the Admin Portal.

2.

Click Usage.

3.

Click View History on Mobile Users.

4.

Review the page for the number of mobile users.

5.

Filter your view and click Apply.

6.

View the Renewal Period, Name, Extension, and Number of External Calls.

7.

Click Done.
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Adding calling credits bundles
The Credits section in the Usage tab contains your calling credits bundle and international calling credit
bundle.
To add Additional Bundles:
1.

Click the Billing tab from the Admin Portal.

2.

Click Usage.

3.

To add a toll-free minute bundle:

4.

a.

Click Add Bundle on Calling Credits.

b.

Select toll-free minutes bundle from the dropdown list.

c.

Click Next.

d.

Conﬁrm your purchase.

To add an international calling credit bundle:
a.

Click Add Bundle on International Calling Credits.

b.

Select the international calling credit bundle from the dropdown list.

c.

Click Next.

d.

Conﬁrm your purchase.
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Managing Calling Rates
The Calling Rates tab under Billing contains international calling rates and premium domestic rates.

Enabling international calling and SMS
1.

Click the Billing tab from the Admin Portal.

2.

Click Calling Rates.

3.

Click Outbound Rates.

4.

Toggle on the switches for International Calling and International SMS.

5.

You can search for the country to view the call rate and SMS rate.

6.

To disable a speciﬁc country, do one of the following:
a.

Tick the box beside the country, click Disable, and click Yes on the Conﬁrmation window.

b.

Click the More kebab icon at the far right of the country under Actions, click Disable, and
click Yes on the Conﬁrmation window.
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Viewing inbound rates
The Inbound Rates tab shows the rates when you receive calls to your RingCentral local or toll-free number
from speciﬁc countries.
To view the Inbound Rates:
1.

Click the Billing tab from the Admin Portal.

2.

Click Calling Rates.

3.

Click Inbound Rates.

Viewing premium rates
The Premium Rates tab shows the premium domestic rates.
To view the Premium Rates:
1.

Click the Billing tab from the Admin Portal.

2.

Click Calling Rates.

3.

Click Premium Rates.
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Managing Purchases in the Billing tab
The Purchases tab gives you a catalog of purchase options in one convenient place.
1.

Click the Billing tab from the Admin Portal.

2.

Click on Purchase for an overview of purchase options.

3.

Click on any tile to see relevant purchase options, or use the Search ﬁeld to type in your search
criteria.
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4.

Click Add to Cart in the lower right corner to add your selection to your shopping cart.

5.

To buy additional products, click Back in the upper left corner of the pane to return to the Purchase
overview page and continue shopping.

6.

Or, click on the shopping cart icon at the upper right corner to access your shopping cart.
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Using the Shopping cart to check out
When you’re ﬁnished shopping and are ready to check out, click on the shopping cart icon in the upper right
corner. A Review Items and Checkout window displays to lead you through completing the process. The
screen may vary depending on your selections.

Review Items
Review your purchases, change quantities or delete items.

Assign Site
In this pane, you can choose a site to which you want the new assets assigned. Use the Select Site dropdown
ﬁeld in the upper right, or use the dropdown in the Site column. Assign all assets to the same site, or choose
Split in the Actions column to allocate resources to different sites. Click Assign to Selected, then click Next.
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Add Shipping Info
Choose a ship-to address from the Select Shipping Address dropdown. Choose Edit to modify an existing
address or New to add a new address. In the Attention to ﬁeld, add a recipient name. Choose a shipping
method from the Select Shipping Method dropdown. Check the box to the left of the entry you want to
assign. Choose Split in the Actions column to allocate purchases to more than one recipient. Click Next.
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Review Order
The Review Order pane shows an itemized list of purchases for the current order and their cost breakdown.
Click the checkbox next to the acknowledgement at the bottom of the pane, then click Next.
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View Statement
The View Statement pane shows a summary of all purchase and account details for your order. Click Print to
keep a hard copy for your records. Click Done to complete the transaction.
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Managing meetings in the Billing tab
The Meetings section allows you to manage RingCentral Video, including managing licenses, downloading
software, adding and viewing rooms, and managing settings.

RingCentral Rooms licenses
RingCentral Rooms offers a convenient way to start, join, and control RingCentral Video meetings in a
conference room from an iPad or Poly controller. Use RingCentral Rooms to start or join RingCentral Video
meetings which are initiated from different endpoints. RingCentral Rooms supports up to 200 participants
in a single meeting.
RingCentral Rooms requires a RingCentral MVP subscription and add-on licenses for the RingCentral
Rooms conference rooms.

Adding a Rooms license
1.

Click the Billing tab from the Admin Portal.

2.

Click Meetings.

3.

Click Rooms.

4.

Click Add Licenses.

5.

Enter the number of licenses.

6.

Click Next.

7.

Review the charges. Tick the acknowledge checkbox to conﬁrm your order.

8.

Click Next.

Note: You can add a maximum of 50 RingCentral Rooms licenses at a time. If you plan to purchase more than
50 licenses in bulk, you must break the purchase into several orders.
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Managing device orders
The Device Orders management feature allows you to view past orders and edit those device orders that
are in pending status to change the devices ordered, or the shipping address.
An authorized agent can extend the deadline up to 9 hours from Admin Web after your initial order
placement. You can edit those orders during this hold period. An order can only be modiﬁed a single time.
After which, it is submitted immediately to the distributor for processing.
1.

Click the Billing tab from the Admin Portal.

2.

Click Device Orders.

3.

Click Edit Order on a pending order.

4.

Click the pencil icon to make changes. Select the items that you want to change and change the
devices (one or many) to the desired device.

5.

Once completed, new charges (or credits) are displayed under Phone Order Charges/Credit.

6.

Click Next.
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7.

Update the Shipping Address if needed. The shipping charge will be adjusted and will reﬂect on New
Shipping Fees.

8.

You will see a pre-statement and statement with Adjustments for the credits and charges for new
phones.

9.

Click Next.

10. Click OK to conﬁrm that once submitted, you can no longer update the order.
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The order update is complete, and the order status is changed to Submitted. You can click View Order to see
the ﬁnal order.
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Using the Cost Center Management feature
The Cost Center Management feature allows you to manage and monitor expenses for groups or individuals.
Administrators can assign purchases of RingCentral services to a department or an individual with cost
center codes. Each transaction can be assigned to a speciﬁc cost center code that you have created. You can
create cost center codes while you are in process or upload predeﬁned codes.
1.

Click the Billing tab from the Admin Portal.

2.

Click Cost Center Management.

3.

Click Cost Centers.

4.

Select an existing Cost Center Code. If you do not have any cost center codes, see the next page on
how to create one.

5.

6.

You will see the Cost Center’s summary, which includes:
a.

Number of users assigned to the Cost Center.

b.

The Cost Center’s total recurring charges per month.

c.

Billing Items - Assigned: queue/user extensions and DigitalLines.

d.

Billing Items - Unassigned and Shared: company numbers.

Click See details for the complete list of Billing Items.

Note: To enable the Cost Center Management feature, contact your RingCentral account manager.
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Adding Cost Center codes
1.

Click the Billing tab from the Admin Portal.

2.

Click Cost Center Management.

3.

Click Add Cost Center.

4.

Enter your preferred Name and Billing Code (optional).

5.

Click Save.

Note: Administrators can also add a Cost Center Code while processing a transaction. When the
administrator is asked to assign a purchase to a Cost Center Code, there will be a button to Add New Code
the administrator can click.
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More
In the Admin Portal, the More menu lists many important features for your company’s phone system.
●

Audit Trail lets you ﬁnd and capture changes made by users that affect system events,
conﬁguration, and user accounts.

●

Service Status allows Users and Administrators to view any high level service impacting issues on
the RingCentral platform with or without logging in.

●

Appearance lets you add your company logo to your RingCentral online account. You can also link
your company logo to your company’s website for smoother navigation.

●

Directory Integration allows you to automatically provision users from your Active Directory or G
Suite corporate directory into RingCentral.

●

Multi-Site Settings allows you to conﬁgure and manage your different ofﬁce locations under one
account.

●

Single Sign-On (SSO) lets employees in a company access multiple applications with one set of
credentials. RingCentral SSO supports the Kerberos network authentication service (on Windows),
as well as integrates with Google SSO.

●

Session Timeout lets you conﬁgure a session timeout for all users.

●

Hot Desk Session Timeout speciﬁes the time period when guest users will be logged out from
phone endpoints, or allows you to conﬁgure no timeout.

●

Masked Numbers setting hides certain information from Administrators for a subset of users in
order to meet country-speciﬁc compliance requirements.

●

Trust Portal allows customers to access RingCentral's security and compliance documents. It
provides audit reports and compliance documentation to assist customers with their compliance,
regulatory, and data protection diligence.

●

Archiver lets you securely save your messages and recorded calls automatically and easily search
the stored data at any time from within your SFTP or Dropbox cloud storage account to quickly
retrieve the records.

●

App Gallery is where you can discover application integrations that are commercially available, and
where developers can showcase their integrations.

●

Developer Portal is a place where you request access to the RingCentral Connect Platform.
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Service console
Using the Audit Trail feature
The Audit Trail feature allows the Super Admin or a User assigned with a Billing Admin role to:
●

Track the changes on the RingCentral account which can be used for auditing and/or
troubleshooting.

●

Generate the report with ﬁlter options.

●

See changes made by other Administrators (applicable to organizations with multiple
administrators who need a changelog in order to provide coordinated support).

●

Detects failed logins and locked accounts.

Audit Trail captures changes to the following events:
Admin Level Changes:
●

System events: Successful logins (Service Web only) and Failed login & Locked accounts due to bad
passwords (all clients, plus integrations).

●

●

Phone System
○

Company Info: Company Address, Directory Assistance, Caller ID Name.

○

Phone numbers: Company and assigned.

○

Auto-Receptionist: General settings.

○

Phones & Devices: User Phones, Common area phones, Paging devices, shared lines.

Users:
○

User list: Users with extensions and unassigned extensions.

○

Roles.

●

Billing: License purchases, license deletes, upgrades/downgrades.

●

Tools:
○

Account Settings: Custom Fields and Outbound Call Preﬁx.

User/Extension level changes
●

Settings
○

User Name/Ext: User Details (partial); Phones & Numbers (partial, add/delete number
only); Screening, Greeting, & Hold Music; Call Handling & Forwarding, Messages.

○

Outbound Calls/Faxes: CallerID and Fax Settings.

○

Notiﬁcations: Messaging Notiﬁcations.

RingCentral app admin settings
●

Administrators: Administrators added or removed (First Last, Ext.).
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●

Company settings: Enable phone features (on/off); Allow employees to add people (on/off); File
sharing (service, on/off), for example Google Drive on/off, Evernote on/off, etc.; Allow Giphy sharing
(max rating), for example, Max rating of PG-13.

●

Data Retention: Policy set to N days.

●

Compliance exports: Exports (on/off); Request/ download export enabled/disabled for UserName;
Download requested by Name/ email.

Accessing the Audit Trail feature
1.

Click the More tab from the Admin Portal.

2.

Under Service Console, click Audit Trail.

Audit Trail report details
When a particular event is captured, these details are provided in the report:
●

Date/Time - changes logged using Coordinated Universal Time (UTC) and displayed based on
logged-in user’s regional timezone setting.

●

Change made by - person who made the change.

●

Role*- permission level of the person who made the change.

●

Change made to - indicates which item was changed.

●

Item affected - indicates the conﬁguration that was changed.

●

Change details - description of the change.

●

Endpoint*- application name.

●

IP Address*- application IP address.

*Indicates these report ﬁelds are only available in a downloaded comma- delimited (CSV) log ﬁle.
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Search Capability
You can search records that provide report details by time periods: Today, Yesterday, Last 7 days, Last 30
days, Last 60 days, Last 90 days, and Last 180 days.

Searching by Change
You can also search by speciﬁc change, such as a change made by a user (Change by) or a change made to
(Change to) a particular extension. This can be done by selecting one of these options in the menu. When
you select Change by or Change to, a list of extensions is displayed for you to choose which one of these is
affected.

Searching by Items Affected
The Items Affected menu lets you select the speciﬁc event items that can be searched. You can either select
from this list or choose All.

Downloading an Audit Trail report
Once you have searched and found information in Audit Trail, you can download an Audit Trail report in
.csv format. To download, follow the steps below:
1.

Click the More tab from the Admin Portal.

2.

Under Service Console, click Audit Trail.
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3.

Do an Audit Trail search.

4.

When you would like to generate a CSV ﬁle containing the Audit Trail result, click the Download
button.

5.

Click Download on the Conﬁrmation window.

Note: Audit Trail is available to all tiers of RingCentral MVP accounts and is enabled by default. To disable
the feature, Contact RingCentral Support.
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Service Status
The RingCentral Service Status site allows admins and users to view any high level service impacting issues
on the RingCentral platform with or without logging in. This site allows customers to see by feature and
region what is being impacted. It also notiﬁes the admin and users for service impacting issues via email and
SMS.
To log in to the Service Status page from the RingCentral online account:
1.

Click the More tab from the Admin Portal.

2.

Under Service Console, click Service Status.

The Service Status page opens on another window.

RingCentral MVP | Admin Guide | More
299

RingCentral MVP | Admin Guide | Account settings
300

Account settings
Account linking
Account Linking is a solution that provides a set of features to support customers who are split across
different accounts, and allows account users to ﬁnd one another across accounts on all endpoints. Large
customers may have this split because of a limit of number of users per account, or business needs for having
different accounts or billing.
Accounts are linked into a federation that includes:
●

The ability to create accounts in multiple tiers, allowing for a mix-and-match of certain feature sets

●

A consolidated company directory

●

Non-metered extension-to-extension and direct number dialing support in the federation

Before setting up Account Federation:
1.

Contact RingCentral support to request access to the Account Federation feature. RingCentral
support will help evaluate if your account qualiﬁes for the feature.

2.

The RingCentral support agent enables the Account Federation feature and adds your linked
accounts within your online account.

3.

Unique extensions in the federation are preferred. If extensions are not unique, the support agent
may be able to update the extension numbers of the linked account for you by applying a template.

4.

When the Account Federation setup is complete, all account users can ﬁnd one another across
accounts on all endpoints.

Note: Feature not available for all accounts. Contact RingCentral support to evaluate if your account
qualiﬁes for this feature.

Navigating the Appearance tab
The Appearance tab allows you to add a company logo to your RingCentral account, change the phone
numbers the users see in their online account proﬁle, and customize the email notiﬁcations that you receive.

Company logo
The company logo will appear at the top-right corner of your online account once you log in. To upload and
link an image:
1.

Click the More tab from the Admin Portal.

2.

Click Account Settings.

3.

Click Appearance.

4.

Click Company Logo.
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5.

Click Browse to browse your computer for an image to upload and select the ﬁle you want to use.

6.

Click Open.

7.

Enter the URL that will be opened when a user clicks on your image.

8.

Click Save.

9.

View your logo in the top-right corner of your online account and test the URL by clicking on the
image.
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Proﬁle number
In the proﬁle tab, administrators have the option to choose which numbers are displayed on their user's
account page.
The number format may differ depending on the country code. If a user does not have a direct number, the
main number and extension will be displayed. If a user has multiple numbers, the user can click on the
drop-down arrow to view these numbers. Administrators can upgrade a direct number or DID (additional
local number) of a user to a full MVP license.
To select the numbers that users will see in their proﬁle:
1.

Click the More tab from the Admin Portal.

2.

Click Account Settings.

3.

Click Appearance.

4.

Click Proﬁle Number.

5.

Select from the following options:

6.

a.

Direct Number and Extension.

b.

Direct Number.

c.

Main Number and Extension.

d.

Direct Number, Main Number, and Extension.

Click Save.
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Customizing welcome email
Whenever an admin creates a user extension, the user receives a welcome email to set up their account. You
can customize the email that the user receives and add your information.
To customize the welcome email sent to your new users:
1.

Click the More tab from the Admin Portal.

2.

Click Account Settings.

3.

Click Appearance.

4.

Click Email Notiﬁcations.

5.

You may add the following optional information to your welcome email:
a.

Custom Logo: Enter an image URL to customize the logo that appears in your email
headers.

6.

b.

Message: Enter up to 750 characters.

c.

Contact Email: Add your contact email.

d.

Support Contact Phone Number: Add your company support contact phone number.

e.

Support Website: Add your company website.

Tick the following checkboxes to add the info to your welcome email:
a.

Include the main company number.

b.

Include direct number.

c.

Include RingCentral Support Center information.

7.

Click Update Preview to see your email preview.

8.

Click Save.

Note: To set the welcome email back to default, click Reset to Default.
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Archiver Settings
Archiver settings let admins and users control archiving independently. Super Admins and managers
automatically have Archiver access, and Super Admins can turn on this feature for any user. When a user’s
Archiver option is turned on, they can archive the data of their own user extension.

Enabling Archiver for Admins
Super Admins and Managers are predeﬁned roles that have admin archiver access by default. Super Admins
can create a new custom role with admin-level archiving permissions. They can turn Archiver on for Admins
in Roles if already available or create a new custom role with Admin level archiving permissions.
1.

Log into your RingCentral account as an admin.

2.

Navigate to Users via the top bar.

3.

Click on Roles in the side navigation bar.

4.

Click on an existing role or create a new one.

5.

Scroll down to the Features section and check the box next to Archiver for Admins.

6.

Click Save.
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Enabling access for users
Super Admins and Managers can archive data for all; or enable users to archive their own data.
1.

Log into your RingCentral account.

2.

From the Admin portal (or My Extension for managers), go to More from the top navigation tabs.

3.

Click on Archiver Settings in the left navigation bar.

4.

Use the slider to enable archiver.

Directory integration
Directory Integration allows you automatically provision users from your corporate directory into
RingCentral.

Active Directory
RingCentral integrates with Microsoft Active Directory to let you automatically provision users from Active
Directory to RingCentral.
The service leverages Okta so you can perform an initial import from Active Directory to RingCentral, and to
synchronize Active Directory and RingCentral on user status. Users are automatically enabled or disabled in
RingCentral as they join or move around your organization.
To set up the RingCentral directory integration service, follow these steps:
1.

Click the More tab from the Admin Portal.

2.

Click Account Settings.

3.

Click Directory Integration.

4.

Select from the following Directory Provider:
●

None
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●

Google Cloud Directory

●

Active Directory

●

SCIM

5.

Enable your selected directory by following the steps provided.

6.

If required, edit the extensions of provisioned users in User Management in the Admin Portal.

RingCentral MVP | Admin Guide | Account settings
308

Cloud Connector
Cloud Connector’s hybrid directory integration lets you connect external phone systems to your
RingCentral phone system. Devices in a hybrid connection can use existing dialing plans and call routing
while being added to your RingCentral corporate directory. Once added, they can be located by and dialed
from the RingCentral apps and devices.
To enable Cloud Connector in your account, you need to contact RingCentral Support.
To add or delete hybrid directory contacts:
1.

Go to the Admin Portal and sign in.

2.

In the top menu, click More, then go to Account Settings > Directory Integration.

3.

Under Directory Integration, go to Hybrid Directory and select the directory you want to modify.

4.

Click Bulk add or delete contacts.

5.

To receive the current contact list, either enter your email address and click Send or click the
Download button. By default, the ﬁle is an empty CSV ﬁle.

6.

Add or delete contacts in the CSV ﬁle. Note: Edit the downloaded CSV ﬁle in a text editor. If you are
using Excel or another similar program, make sure it doesn't change the ﬁle format after saving.
a.

Contact names are required.

b.

The Email and DirectNumber ﬁelds are optional. If you ﬁll in the DirectNumber ﬁeld, then the
number can be used to call users.

c.

Take care not to alter the format of the template.
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7.

Once the template is complete, save it and upload the revised ﬁle by clicking Browse.

8.

Click Next.

9.

A conﬁrmation window will appear after a successful upload, and you’ll also receive a conﬁrmation
email. If you want to notify others, you can enter additional emails in the Additional notiﬁcation
recipients ﬁeld.

10. In the conﬁrmation window, click Submit, then click Done.

Multi-site settings
Multi-Site Support provides a management solution for customers with multiple branch locations. Multi-Site
Support is available for RingCentral MVP Premium and Ultimate users with Multi-Level IVR enabled.
Accounts conﬁgured with multi-site support can enable the Site Code feature to deﬁne a dial plan for
intra-site and inter-site calling. This feature allows the administrator to allocate account user or group
extensions for deﬁned sites.
To enable Multi-Level IVR mode, conﬁgure the dial-by- name directory, create at least one IVR menu and
enable the feature in Auto-Receptionist.
To enable your account to support multiple sites:
1.

Click the More tab from the Admin Portal.

2.

Click Account Settings.

3.

Click Multi-Site Settings.
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4.

Toggle the switch on to Enable account support for multiple sites.

5.

Conﬁgure site codes, if required for your dialing plan.

Your online account can now create and conﬁgure multiple sites. Site ﬁlters are available on pages with site
assets to allow you to view the list of assets by sites.
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Creating a new site
RingCentral Multi-Site support allows you to provision independent account conﬁgurations for your
individual sites, to enable you to uniquely register and manage each site from your account. Once Multi-Site
Support is enabled, you can create additional sites as needed.
To create a site, follow the steps below:
1.

Click the Phone System tab from the Admin Portal.

2.

On the Company Info page, click New Site.

3.

On the Site Info page, enter the Site Name, Site Address, and Site Extension. Or, you may click
Select Site under Copy Settings from to copy settings from another site. Click Next.

4.

Conﬁgure the Regional Settings and Business hours. Click Next.

5.

Assign Numbers to the Site. You may assign existing numbers or add (and purchase) new direct
numbers. Click Next.

6.

On the Caller ID Name page, enter the Outbound Caller ID Name.

7.

On the IVR Menu page, select an Existing IVR or a New IVR.

On the Summary page, you will be notiﬁed that the site is created successfully. Click Done. You can view or
edit site information within Phone System > Company Info.
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Setting up site codes
Accounts conﬁgured with multi-site support can enable the Site Code feature to deﬁne a dial plan for
intra-site and inter-site calling. This allows users within a site to call each other using a short extension
number, and users between sites to use a full extension number, consisting of a site code plus the short
extension.
To set up your site codes:
1.

Click the More tab from the Admin Portal.

2.

Click Multi-Site Settings.

3.

Verify that Multi-Site support is enabled.

4.

Under Site Codes, click Enable Site Codes.

5.

In the Extension Number Length window, select an appropriate digit length for the short extension
and the site code. The values must fall within the limits of the full extension number length, per the
maximum extension length of ﬁve digits.* Click Next.

6.

In the Provision Site Codes window, the system will suggest site codes for all sites, per selected
lengths for site code and short extension. Click Next.

7.

In the Adjust Extension Numbers window, Existing extensions that have more digits than enabled
with site code need to be adjusted or use system suggestions. Click Conﬁrm.

Extensions in the Users with Extensions view display a site code plus a short extension. For example: Site
Code: 11, Short Ext. #: 001, and Full-Ext #: 11001.
Note: A maximum extension length of six to eight digits is available on-demand for certain international
cases.
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Moving assets across sites
The Change Site function of Multi-Site Support allows you to move selected Users, IVR Menus, and Call
Queues to another site. This feature allows for individual or bulk movement of Users, IVR Menus, and Call
Queues between sites.

Moving users across sites
1.

Click the Users tab from the Admin Portal.

2.

On the Users with Extensions tab, check the box of the users you want to assign to a different site,
and click Change Site.

3.

Select the site.

4.

You may check the option to Adjust time and regional settings to the settings of the new site? to
apply it to the moved users.

5.

Click Change Site.
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Moving IVR menus across sites
1.
2.

Click the Phone System tab from the Admin Portal.
Click Auto Receptionist.

3.

Click IVR Menus.

4.

Select from the list of IVR Menus.

5.

Click Change Site.

6.

Select the site.

7.

Click Change Site.
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Moving call queues across sites
1.
2.

Click the Phone System tab from the Admin Portal.
Click Groups.

3.

Click Call Queues.

4.

Select the Call Queues that you want to move.

5.

Click Change Site.

6.

You may check the option to Adjust time and regional settings to the settings of the new site? to
apply it to the moved Call Queue.

7.

Click Change Site.
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Security and compliance
Single sign-on
Single Sign-on allows employees in a company to access multiple applications with one set of credentials.
You can work with RingCentral Customer Support to set up Single Sign-on for your RingCentral services, or
you can set it up by yourself.
On Windows based systems, Single-Sign-on supports the optional use of your company’s Kerberos network
authentication service to authenticate clients.
RingCentral also integrates with Google SSO, which allows G Suite customers to use the Google SSO service
(offered as part of G Suite IDaaS) to sign into RingCentral. Google lists RingCentral as an approved SSO app
in their SAML apps catalog. You conﬁgure RingCentral for SSO in the G Suite Admin Console and conﬁgure
the RingCentral SSO as described here.

Conﬁguring SSO
1.

Click the More tab from the Admin Portal.

2.

On the left-hand side, click Security and Compliance.

3.

Click Single Sign-on.

4.

Choose an option to set up SSO:
●

Set up SSO by yourself: Use the self-service UI to conﬁgure the Service Provider (SP)
settings. Perform the steps in Set up Single Sign-On by Yourself .

●

Contact Customer Support: Use RingCentral Customer Support to conﬁgure the Service
Provider (SP) settings. Click the View Detail link, and contact RingCentral support.

5.

After conﬁguring the SSO, you can turn on the SSO service for your company. To do so, check the
box next to Enable SSO Service.
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Setting up single sign-on by yourself
To set up SSO by yourself, upload your Identity Provider (IDP) SAML metadata, make sure the attribute is
mapped correctly, and download the metadata for importing it into your Federation Server:
1.

In the Set up SSO by yourself box, click Set Up to set up SSO for the ﬁrst time, or Edit to change your
conﬁguration.

2.

Under Upload IDP metadata, click drop down and select either Upload with ﬁle or URL. To upload
with a ﬁle, click Browse, select a ﬁle, and click Open. To upload with a URL, paste the URL and click
Import.

3.

Select email attributes you want to use within your metadata from the drop down list under Map
Email Attribute to. If the email attribute is not recognized, type out the name of the attribute by
clicking Custom in dropdown.

4.

Under Certiﬁcate Management, click Upload to upload a certiﬁcate and set the primary one. Click
Save.

5.

Download the Service Provider metadata and import it into your IDP server to complete the
conﬁguration on your IDP side.

6.

Tick Enable SSO Service checkbox.

7.

Click Save.
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Contacting support to enable SSO
This section describes how to prepare the request, and contact RingCentral Customer Support to conﬁgure
the Service Provider (SP) settings required to enable SSO on your IDP server:
1.

In the Contact Customer Support box click the View Detail link, and perform the steps as described.

2.

Get your SAML 2.0 metadata details from your Identity Provider (IDP), such as PingFederate, Okta,
or a homegrown IDP.

3.

Contact RingCentral Customer Support to request Single Sign-on setup assistance. A support
member will ask for your SAML 2.0 metadata ﬁle and answer your Single Sign-On questions.

4.

You will receive an email from RingCentral containing your SAML 2.0 SP metadata. Import the
metadata into your IDP server to complete the conﬁguration on your IDP.

5.

Check Enable SSO Service.

6.

Click Save.
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Conﬁguring session timeout
Conﬁgure a session timeout for all users on your account. If a user is inactive for a certain period of time, a
warning message will appear notifying the user that the session is about to expire. The user can click OK to
keep the session alive. However, if a user does not click OK before the time runs out, the user is logged out of
the system and is asked to log in again.
To set a time interval for your phone system’s session timeout:
1.

Click the More tab from the Admin Portal.

2.

Click Security and Compliance.

3.

Click Session Timeout.

4.

Click the drop-down to view a list of time intervals.

5.

Select the time interval you would like to use.

6.

Click Save.
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Enabling masked numbers
The Masked Numbers setting hides certain information from Administrators for a subset of users in order to
meet country-speciﬁc compliance requirements. This feature needs to be activated ﬁrst before the
Unmasked Numbers permission can be accessed in Roles. Administrators with the Super Admin role will
automatically have the Unmasked Numbers permission enabled.
To enable Masked Numbers:
1.

Click the More tab from the Admin Portal.

2.

Click Security and Compliance.

3.

Click Masked Numbers.

4.

Check Activate Masked Numbers.

5.

Click Accept & Save.

6.

Click OK on the Alert dialog.

7.

At this point, you can either create a role with the Unmasked Numbers permission enabled, or you
can enable the Unmasked Numbers for a role.
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Accessing the Trust Portal
All current RingCentral MVP, RingCentral Contact Center, and data center compliance and security
documentation will be accessible via the portal. For questions, please contact your Account Manager or
Sales Representative.
To access the Trust Portal:
1.

Click the More tab from the Admin Portal.

2.

Click Security and Compliance.

3.

Click Trust Portal.

4.

Accept the terms, then click Login.

5.

Click the report name to view or download the PDF.
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Mobile app security settings
The Mobile App Security section of the RingCentral Online account allows admins to disable third party
keyboard on a user’s mobile device (iOS only).
Note: Disabling a third party keyboard prohibits a user from using another keyboard when typing texts
which can expose your device to security risks. For iOS and iPadOS 14.5 and later, settings will take effect
immediately. For older versions, try restarting or relaunching the app if the settings didn’t load.
1.

From the Admin Portal, click More.

2.

Go to Security and Compliance > Mobile App Security.

3.

Use the checkboxes to turn on or off to allow third party keyboards.

Creating a customer service record for porting numbers
Customers who are in North America and with RC transport can download Customer Service Record (CSR)
onthe Admin Portal.
1.

Sign in to the Admin Portal.

2.

Navigate to Phone Numbers > All Numbers.

3.

Click Download next to CSR for porting out.

4.

Tick the box next to the site(s) you want to download.
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Apps and resources
Archiver
The RingCentral Archiver allows you to backup RingCentral data via Dropbox, SFTP, Google Drive, and Box
integration. This provides an automatic backup solution, as well as a convenient way of storing and
retrieving phone data.
To conﬁgure Archiver:
1.

Click the More tab from the Admin Portal.

2.

Click Apps and Resources.

3.

Click Archiver Beta.

4.

Connect RingCentral Archiver to one of the following:
a.

Dropbox

b.

SFTP

c.

Google Drive

d.

Box

e.

Smarsh

Note: You can only connect to one storage per instance. For example, one cannot use Dropbox and
Google Drive at the same time
5.

Click Sync Options.

6.

When connected to the archiver account, you can enable or disable data backup by selecting Enable
Backup.

7.

Select the types of Data to backup. By default, Call Recordings are backed up for admins and users.
Users can select for their own extensions whether to backup Call Recordings, Voice Mails, SMS
and/or Fax.

Note: Archiver is available to RingCentral MVP Premium and Ultimate customers. It is also available to
RingCentral customers in Canada, UK, and Europe.
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App Gallery
The App Gallery is a destination where you can discover application integrations that are commercially
available, and where developers can showcase their integrations.
To access the App Gallery via the online account:
1.

Click the More tab from the Admin Portal.

2.

Click Apps and Resources.

3.

Click App Gallery.

A new window will open to the RingCentral App Gallery website.

Developer Portal
The RingCentral Developer Portal offers a set of tools and services to build, deploy, and manage custom
integrations using RingCentral APIs. With this, developers can build out-of-the-box integrations with
RingCentral to add powerful communication capabilities to business applications.
To access the Developer Portal via the RingCentral online account:
1.

Click the More tab from the Admin Portal.

2.

Click Apps and Resources.

3.

Click Developer Portal.

4.

A new window will open to the Developer Portal.
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SMS and MMS
There are two types of SMS:
●

Person-to-Person (P2P) or standard SMS: Communication of two or more people over text
messaging. Sending text messages from your phone to another person's phone is an example of P2P.

●

Application-to-Person (A2P) or High Volume SMS: A text message that a person receives from an
application. This includes, but not limited to, marketing messages, appointment reminders, chat
bots, virtual assistants, notiﬁcations, and one-time passwords (OTPs), or PIN codes.

Wireless carriers treat P2P and A2P differently in terms of the type and volume of trafﬁc allowed.

Standard SMS and MMS
RingCentral MVP enables you to send SMS and MMS messages a few different ways.

Business SMS and MMS
The RingCentral Business SMS and MMS feature allows you to send and receive text messages and
multimedia ﬁles with your business number. This feature is available for customers in the US and Canada
(SMS only in Canada) and automatically activated for RingCentral MVP users.
RingCentral also supports toll-free number SMS activation for US and Canada. Contact Support to process
this request.
You can use your RingCentral phone numbers for sending and receiving text messages via the RingCentral
app.

Group SMS
You can send a text message to several people (up to 10) at once via the RingCentral app. This will create a
text conversation with all parties.
RingCentral app currently supports group text messaging only to numbers from the US, Canada, and Puerto
Rico.

Sending a group SMS
1.

Click on the New actions plus button at the top right.

2.

Select Send new text from the dropdown menu.
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3.

If you have several Direct Numbers or Digital Lines, click inside the Text from ﬁeld and select your
preferred outbound caller ID.

4.

Enter the names (from your contact list) or phone numbers of the people you’d like to text in the To
ﬁeld (you can enter up to 10). Separate the numbers by a comma or semicolon.

5.

Ensure the Create group text box is checked.

6.

Click the Next button to navigate to the text message conversation.

7.

Draft a message in the message ﬁeld at the bottom of the app.

8.

Send the text message by pressing Enter or Return on your keyboard.

Bulk SMS
You can send the same message in bulk (up to 100 recipients) via the RingCentral app. Different from a
group message, sending a text message in bulk means sending the same message to multiple people in
separate messages.

Sending a bulk SMS
1.

Click on the New actions plus button at top right.

2.

Select Send new text from the dropdown menu.

3.

If you have several Direct Numbers or Digital Lines, click inside the Text from ﬁeld and select the
outbound Caller ID from which you’d like the text to come.

4.

Enter a list of the names or phone numbers of the people you’d like to text in the To ﬁeld.

5.

Uncheck the Create group text box, so you can add more than 10 numbers/names (you can enter up
to 100).

6.

Enter your message in the resulting text ﬁeld. Attach ﬁles and insert emojis using the Attach ﬁle and
Emoji buttons (respectively).

7.

Click the Send button to send the text message to all contacts provided.

High Volume SMS
Send targeted or bulk SMS campaigns using our programmatic API or ready-to-use app with a full
communications platform, deep insights, and the ability to ensure regulatory compliance.
With High Volume SMS, customers can send SMS at higher rates, send mass promotions, send automated
messages, appointment reminders, notiﬁcations, and more without having their messages blocked by the
carriers as long as they don’t contain shortened URLs or spam content.
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High Volume SMS features
Whether you’re sending promos for e-commerce, healthcare appointments, reminders in education,
chatbots in hospitality or anything in between, High Volume SMS provides functionality for all industries and
businesses of any size.
●

up to 250,000 text messages per day

●

automated message queuing

●

opt-out/opt-in handling

●

detailed reporting and error codes

API vs High Volume SMS app
The High Volume SMS API is conﬁgured for customers who require more sophisticated functionality and
want to build more customized workﬂows for their organizations. Our developers can review code samples
and start building your custom SMS app. To learn more, visit our API Reference Guide.

Availability and pricing
RingCentral MVP Standard with $50 MRR+ (Monthly Recurring Revenue), Premium, or Ultimate plans can
take advantage of High Volume SMS. Local (10-DLC) and toll-free numbers are supported in the United
States. Only Toll-free numbers are currently supported in Canada. High Volume SMS is priced at $0.007 per
message sent or received with no additional carrier fees, all on your RingCentral bill.

Getting Started
You must ﬁrst enable your RingCentral number to send High Volume SMS. To do so, submit a request via the
enrollment form.
Note: If you use an existing RingCentral number, you can no longer use it for SMS across other products,
including the RingCentral app. Visit the RingCentral Service Desk or contact your RingCentral account
manager if you’d like to add another number to your account.

